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To reduce the risk of fire or 
electric shock, do not 
expose this apparatus to 
rain or moisture.

To avoid electrical shock, 
do not open the cabinet.
Refer servicing to qualified 
personnel only.
Important Safety Instructions
• Read these instructions.
• Keep these instructions.
• Heed all warnings.
• Follow all instructions.
• Do not use this apparatus near water.
• Clean only with dry cloth.
• Do not block any ventilation openings. 

Install in accordance with the 
manufacturer’s instructions.

• Do not install near any heat sources such 
as radiators, heat registers, stoves, or 
other apparatus (including amplifiers) that 
produce heat.

• Do not defeat the safety purpose of the 
polarized or grounding-type plug. A 
polarized plug has two blades with one 
wider than the other. A grounding-type 
plug has two blades and a third grounding 
prong. The wide blade or the third prong 
are provided for your safety. If the 
provided plug does not fit into your outlet, 
consult an electrician for replacement of 
the obsolete outlet.

• Protect the power cord from being walked 
on or pinched particularly at plugs, 
convenience receptacles, and the point 
where they exit from the apparatus.

• Only use attachments/accessories 
specified by the manufacturer.

• Refer all servicing to qualified service 
personnel. Servicing is required when the 
apparatus has been damaged in any way, 
such as power-supply cord or plug is 
damaged, liquid has been spilled or 
objects have fallen into the apparatus, the 
apparatus has been exposed to rain or 

moisture, does not operate normally, or 
has been dropped.

WARNING
Excessive sound pressure from earphones 
and headphones can cause hearing loss.
In order to use this product safely, avoid 
prolonged listening at excessive sound 
pressure levels.

For the customers in the U.S.A.
This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. This 
equipment generates, uses, and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the 
instructions, may cause harmful interference 
to radio communications. However, there is 
no guarantee that interference will not occur 
in a particular installation. If this equipment 
does cause harmful interference to radio or 
television reception, which can be 
determined by turning the equipment off and 
on, the user is encouraged to try to correct 
the interference by one or more of the 
following measures:

- Reorient or relocate the receiving 
antenna.

- Increase the separation between the 
equipment and receiver.

- Connect the equipment into an outlet on a 
circuit different from that to which the 
receiver is connected.

- Consult the dealer or an experienced 
radio/TV technician for help.

You are cautioned that any changes or 
modifications not expressly approved in this 
manual could void your authority to operate 
this equipment.

All interface cables used to connect 
peripherals must be shielded in order to 
comply with the limits for a digital device 
pursuant to Subpart B of Part 15 of FCC 
Rules.

If you have any questions about this product, 
you may call;

WARNING
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Sony Customer Information Service Center 
1-800-222-7669 or http://www.sony.com/

For the customers in Canada
This Class B digital apparatus complies with 
Canadian ICES-003.

For the customers in Europe
This product with the CE marking complies 
with the EMC Directive issued by the 
Commission of the European Community.
Compliance with this directive implies 
conformity to the following European 
standards:
• EN55103-1: Electromagnetic 

Interference(Emission)
• EN55103-2: Electromagnetic 

Susceptibility(Immunity)
This product is intended for use in the 
following Electromagnetic Environments: E1 
(residential), E2 (commercial and light 
industrial), E3 (urban outdoors), E4 
(controlled EMC environment, ex. TV 
studio).

The manufacturer of this product is Sony 
Corporation, 1-7-1 Konan, Minato-ku, 
Tokyo, Japan.
The Authorized Representative for EMC and 
product safety is Sony Deutschland GmbH, 
Hedelfinger Strasse 61, 70327 Stuttgart, 
Germany.

For the State of California, USA only
Perchlorate Material - special handling may 
apply, See

www.dtsc.ca.gov/hazardouswaste/
perchlorate
Perchlorate Material : Lithium battery 
contains perchlorate.

For the customers in Taiwan only

Afin de réduire les risques 
d’incendie ou 
d’électrocution, ne pas 
exposer cet appareil à la 
pluie ou à l’humidité.

Afin d’écarter tout risque 
d’électrocution, garder le 
coffret fermé. Ne confier 
l’entretien de l’appareil 
qu’à un personnel qualifié.
AVERTISSEMENT
Une pression acoustique excessive en 
provenance des écouteurs ou du casque 
peut provoquer une baisse de l’acuité 
auditive.
Pour utiliser ce produit en toute sécurité, 
évitez l’écoute prolongée à des pressions 
sonores excessi

Pour les clients au Canada
Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada.

Pour les clients en Europe
Ce produit portant la marque CE est 
conforme à la Directive sur la compatibilité 
électromagnétique (EMC) émise par la 
Commission de la Communauté 
européenne.

Declaration of Conformity

Trade Name : SONY
Model : PMW-500
Responsible party : Sony Electronics Inc.
Address : 16530 Via Esprillo, 

San Diego, CA 
92127 U.S.A.

Telephone Number : 858-942-2230

This device complies with part 15 of the 
FCC Rules. Operation is subject to the 
following two conditions: (1) this device 
may not cause harmful interference, and 
(2) this device must accept any 
interference received, including 
interference that may cause undesired 
operation.

AVERTISSEMENT
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La conformité à cette directive implique la 
conformité aux normes européennes 
suivantes :
• EN55103-1 : Interférences 

électromagnétiques (émission)
• EN55103-2 : Sensibilité 

électromagnétique (immunité)
Ce produit est prévu pour être utilisé dans 
les environnements électromagnétiques 
suivants : E1 (résidentiel), E2 (commercial et 
industrie légère), E3 (urbain extérieur) et E4 
(environnement EMC contrôlé, ex. studio de 
télévision).

Le fabricant de ce produit est Sony 
Corporation, 1-7-1 Konan, Minato-ku, 
Tokyo, Japon.
Le représentant autorisé pour EMC et la 
sécurité des produits est Sony Deutschland 
GmbH, Hedelfinger Strasse 61, 70327 
Stuttgart, Allemagne.

Um die Gefahr von Bränden 
oder elektrischen Schlägen 
zu verringern, darf dieses 
Gerät nicht Regen oder 
Feuchtigkeit ausgesetzt 
werden.

Um einen elektrischen 
Schlag zu vermeiden, darf 
das Gehäuse nicht geöffnet 
werden. Überlassen Sie 
Wartungsarbeiten stets nur 
qualifiziertem 
Fachpersonal.
WARNUNG
Zu hoher Schalldruck von Ohrhörern und 
Kopfhörern kann Gehörschäden 
verursachen.

Um dieses Produkt sicher zu verwenden, 
vermeiden Sie längeres Hören bei sehr 
hohen Schalldruckpegeln.

Für Kunden in Europa
Dieses Produkt besitzt die CE-
Kennzeichnung und erfüllt die EMV-
Richtlinie der EG-Kommission.
Angewandte Normen:
• EN55103-1: Elektromagnetische 

Verträglichkeit (Störaussendung)
• EN55103-2: Elektromagnetische 

Verträglichkeit (Störfestigkeit)
Für die folgenden elektromagnetischen 
Umgebungen: E1 (Wohnbereich), E2 
(kommerzieller und in beschränktem Maße 
industrieller Bereich), E3 (Stadtbereich im 
Freien) und E4 (kontrollierter EMV-Bereich, 
z.B. Fernsehstudio).

Der Hersteller dieses Produkts ist Sony 
Corporation, 1-7-1 Konan, Minato-ku, 
Tokyo, Japan.
Der autorisierte Repräsentant für EMV und 
Produktsicherheit ist Sony Deutschland 
GmbH, Hedelfinger Strasse 61, 70327 
Stuttgart, Deutschland.

WARNUNG
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After purchasing the PMW-500 Solid-State 
Memory Camcorder, before operating, it is 
necessary to set the area of use.
(Unless this setting is made, the camcorder will 
not operate.)

For details of these settings, see “Setting the Area of 
Use” (page 40).

Note

Before attaching/removing optional components or 
accessories to/from the PMW-500 (referred to as “the 
camcorder”), be sure to turn the power of the camcorder 
off.

Some functions and information are available 
only when this camcorder is in a specific 
operating mode. This manual indicates those 
modes by using the following marks. When these 
marks appear, the associated function or 
information is available only in that mode.

HD mode: When OPERATION >Format >HD/
SD in the setup menu is set to [HD].

UDF mode: When OPERATION >Format >File 
System in the setup menu is set to [UDF].

FAT mode: When OPERATION >Format >File 
System in the setup menu is set to [FAT].

FAT-HD mode: When OPERATION >Format 
>File System in the setup menu is set to [FAT] 
and OPERATION >Format >HD/SD in the setup 
menu is set to [HD].

FAT-SD mode: When OPERATION >Format 
>File System in the setup menu is set to [FAT] 
and OPERATION >Format >HD/SD in the setup 
menu is set to [SD].

Foreword

Before Use

Mode Indications in This 
Manual

HD

UDF

FAT

FAT-HD

FAT-SD
Foreword / Mode Indications in This Manual 11Download from Www.Somanuals.com. All Manuals Search And Download.
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2/3-inch full-HD “PowerHAD FX” CCDs
• IT (Interline Transfer) 2/3-inch progressive 

image sensors with 207 million pixels, for full 
HD resolution (1920 × 1080)

• “PowerHAD FX” CCDs, featuring a signal 
processing ASIC with 14-bit A/D converters
These new image sensor technologies enable 
the capture of very high-quality images, with 
F11 (59.94i) and F12 (50i) sensitivity and an 
SN ratio of 59 dB. 1)

1) With noise suppression on (off value is 54 dB) Noise 
suppression uses proprietary Sony signal processing 
technology to suppress noise in highfrequency 
regions.

SxS memory cards as recording media
Using SxS memory cards, the camcorder offers 
nonlinear capabilities such as instant random 
access and file-based operation.
You can choose FAT or UDF as the file system 
for recording media.

Light weight, low power consumption
Design features custom video signal processing 
ICs, and SxS memory card recording enable 
fanless operation and power consumption of 27 
W or less. The camcorder’s light weight (3.4 kg 
(7 lb 7.9 oz)) and low center of gravity make it 
easy to carry on the shoulder while ensuring 
superior stability.

HD recording using the “MPEG-2 Long 
GOP” codec and SD recording in MPEG 
IMX50/DVCAM format
The camcorder records 1920 × 1080, 1440 × 
1080, and 1280 × 720 HD images using “MPEG-
2 Long GOP” codec compression. 

For recording in FAT mode, it offers a choice of 
bit rates: either 35 Mbps (HQ mode) or 25 Mbps 
(SP mode). 
For recording in UDF mode, it offers a choice of 
bit rates: either 35 Mbps (HQ mode) or 50 Mbps 
(HD422 mode).
By utilizing an efficient compression format, the 
camcorder records high-quality HD images for 
long recording time of approx. 60 minutes at 50 
Mbps (HD422 mode) or approx. 90 minutes at 35 
Mbps (HQ mode) on a single 32-GB SxS memory 
card (when the recording mode is UDF).
It can also record and play two SD formats: 
MPEG IMX 50 Mbps and DVCAM 25 Mbps. 1)

1) CBK-MD01 SD Record and Playback Key required.
For details, contact a Sony service representative

Multi-format support
The camcorder supports interlace format 
recording (1080/59.94i or 1080/50i), progressive 
format recording (1080/29.97P, 1080/23.98P, 
720/59.94P, 720/29.97P, 720/23.98P, or 1080/
25P, 720/50P, 720/25P), thus offering the 
flexibility needed for worldwide HD recording.
It also supports recording and playback of SD 
signals (both NTSC and PAL). The camcorder 
has an optional capability to record and play back 
SD signals in IMX/DVCAM format, and can 
output HD signals down-converted to SD.

A variety of functions for improved 
performance under various shooting 
conditions
• Picture Cache function
• Optical ND filters and electrical CC filters
• Hyper gamma
• Slow shutter function
• Clip Continuous Rec function
• Frame Recording function
• Time lapse function (interval recording)
• Slow & quick motion function
• Freeze mix function
• Live & Play function
• Digital extender function 1)

• Focus magnification function
• Assignable switches

Chapter1 Overview

Features
Features
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• 3.5-inch high-resolution color LCD monitor
• Remote control
1) When the optional CBK-HD02 SDI/Composite Input 

and 50-pin Interface is installed

Recording data to USB flash drives and 
reading data from USB flash drives (UDF 
mode)
You can connect USB flash drives to the external 
device connector to record proxy data or read 
planning metadata. You can also save setup menu 
settings to USB flash drives and load menu 
settings from USB flash drives into the 
camcorder.

Wireless LAN support
You can connect this camcorder to a computer 
over a wireless LAN (Wi-Fi connection) by 
installing the optional CBK-UPG01 Hardware 
Upgrade Key and connecting the optional CBK-
WA01 Wi-Fi Adapter to the external device 
connector.
A Wi-Fi connection allows you to transfer 
planning metadata from a computer to this 
camcorder, and to transfer clips and other files 
from this camcorder to a computer. You can also 
use the Live Logging function to transfer proxy 
AV data to a computer as you shoot, for logging 
of the video currently being shot.

Inherits unique features of XDCAM series
The camcorder inherits the workflow features of 
the XDCAM series, including thumbnail display 
and metadata management, and improves them 
by introducing an improved man-machine 
interface.

Supports two viewfinder types
Depending on the application, you can use either 
the optional HDVF series viewfinder or the CBK-
VF01 color viewfinder.

Camcorder system configuration
When you install the optional CBK-HD02 SDI/
Composite Input and 50-pin Interface, you can 
mount the XDCA-55 HD Camera Adaptor and 
connect the XDCU-50 HD Camera Extension 
Unit to configure a system for shooting and 
recording.

When the CBK-HD02 is installed, you can also 
connect the HDCA-702 MPEG TS Adaptor 
instead of the camera adaptor. This allows you to 
convert this camcorder’s HDSDI output to a 
MPEG HD transport stream.
Features 13Download from Www.Somanuals.com. All Manuals Search And Download.
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 Two CD-ROMs are supplied with the camcorder.

The CD-ROM labeled “Manuals for Solid-State 
Memory Camcorder” contains the PDF files of 
OPERATION MANUAL and SUPPLEMENT 
for the camcorder (English, Japanese, French, 
German, Italian, Spanish and Chinese).

The CD-ROM labeled “Utility Software for 
XDCAM” contains application and device driver 
software required to access to SxS memory cards 
from a computer and to manage material shot 
with the camcorder.
Information about how to install the software is 
provided in PDF format.

Note

You must install the SxS device driver and SxS UDF 
driver software on your computer if it is equipped with 
an ExpressCard slot and you want to use it to access SxS 
memory cards, if you want to connect the camcorder to 
your computer, and if you want to connect an optional 
SBAC-US10 SxS Memory Card USB Reader/Writer to 
the computer.

Preparations
The following program must be installed on your 
computer in order to read the documents 
contained on the CD-ROM.
Adobe Reader Version 6.0 or higher

Memo

If Adobe Reader is not installed, you can download it 
from the following URL: 
http://www.adobe.com/

Adobe and Adobe Reader are trademarks of Adobe 
Systems Incorporated in the United States and/or other 
countries.

To read the documents
Do the following:

1 Insert the CD-ROM in your CD-ROM 
drive.
A cover page appears automatically in your 
browser.
If it does not appear automatically in the 
browser, double-click on the index.htm file 
on the CD-ROM.

2 Select and click on the manual that you 
wish to read.
This opens the PDF file.

Memo

The files may not be displayed properly, depending on 
the version of Adobe Reader. In such a case, install the 
latest version you can download from the URL 
mentioned in “Preparations” above.

Note

If you have lost or damaged the CD-ROM, you can 
purchase a new one to replace it. Contact a Sony service 
representative.

Using the CD-ROM Reading the CD-ROM 
Manuals
Using the CD-ROM / Reading the CD-ROM Manuals
Download from Www.Somanuals.com. All Manuals Search And Download.
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a LIGHT switch
Determines how a video light connected to the 
LIGHT connector (see page 16) is turned on and 
off.
AUTO: When the POWER switch of the video 

light is in the on position, the video light is 
turned on automatically while the camcorder 
is recording.

MANUAL: You can turn the video light on or off 
manually, using its own switch.

Note

When the camcorder is set for recording in Picture Cache 
mode, it is not possible to turn on the light before 
operation to start recording is carried out (or while data 
is being stored in memory).

b POWER switch
Turns the main power supply on and off.

c DC IN (DC power input) connector 
(XLR type, 4-pin, male)

To operate the camcorder from an AC power 
supply, connect an optional DC power cord to this 
terminal and then connect the cord to the DC 
output terminal of the BC-L70, BC-L160, or 
another battery charger.

d DC OUT 12V (DC power output) 
connector (4-pin, female)

Supplies power for an optional WRR-860C/861/
862 UHF Synthesized Diversity Tuner 
(maximum 0.5 A).

Note

Do not connect any equipment other than the UHF 
synthesized diversity tuner.

e Battery attachment shoe
Attach a BP-GL95/GL65/L80S/L60S Battery 
Pack. Alternatively, you can attach an AC-
DN2B/DN10 AC Adaptor to operate the 
camcorder on AC power supply.

For details, see “Preparing a Power Supply” 
(page 35). 

For details, see “Attaching a UHF Portable Tuner 
(for a UHF Wireless Microphone System)” 
(page 45).

Note

For your safety, and to ensure proper operation of the 
camcorder, Sony recommends the use of the following 
battery packs: BP-GL95, BP-GL65, BP-L60S, and 
BP-L80S.

Adaptor connector
Enables connection of an XDCA-55 HD Camera 
Adaptor or an HDCA-702 MPEG TS Adaptor. To 
connect an adaptor, remove the cover from the 
connector and install the optional CBK-HD02 
SDI/COMPOSITE Input and 50 Pin Interface.

Locations and Functions 
of Parts and Controls

Power Supply
Adaptor connector (see page 15)
Locations and Functions of Parts and Controls 15Download from Www.Somanuals.com. All Manuals Search And Download.



16

C
hapter 1  O

verview
a Shoulder strap fitting
Attach the supplied shoulder strap (see page 49).

b Accessory fitting shoe
Attach an optional accessory such as a video light 
(see page 49).

c Viewfinder front-to-back positioning 
lever

To adjust the viewfinder position in the front-to-
back direction, loosen this lever and the LOCK 
knob. After adjustment, retighten this lever and 
the LOCK knob.

d Viewfinder left-to-right positioning ring
Loosen this ring to adjust the left-to-right position 
of the viewfinder (see page 37).

e Viewfinder fitting shoe
Attach the viewfinder.

f VF (viewfinder) connectors (26-pin, 
rectangular and 20-pin, round)

The analog interface connector (20-pin) is for 
connection of an HDVF series viewfinder, and 
the digital interface connector (26-pin) is for 
connection of an HD viewfinder CBK-VF01.
Use a connection cable to connect your 
viewfinder to the corresponding connector.

Note

Do not connect viewfinders to both connectors at the 
same time.

g Lens mount securing rubber
After locking the lens in position using the lens 
locking lever, fit this rubber over the lower of the 
two projections. This fixes the lens mount, 
preventing it from coming loose.

h Viewfinder front-to-back positioning 
knob (LOCK knob)

Loosen this knob to adjust the front-to-back 
position of the viewfinder (see page 37).

i Fitting for optional microphone holder
Fit an optional CAC-12 Microphone Holder (see 
page 44).

j Shoulder pad
Raise the shoulder pad fixing lever to adjust the 
position in the front-to-rear direction. Adjust the 
position for maximum convenience when 
operating the camcorder on your shoulder (see 
page 50).

k LIGHT (video light) connector (2-pin, 
female)

A video light with a maximum power 
consumption of 50 W, such as the Anton Bauer 
Ultralight 2 or equivalent can be connected (see 
page 49).

l Lens cable clamp
Clamp a lens cable.

m MIC IN (microphone input) (+48 V) 
connector (XLR type, 5-pin, female)

Connect a stereo microphone to this connector. 
The power (+48 V) is supplied via this connector.

n LENS connector (12-pin)
Connect a lens cable to this connector.

Note

When connecting or disconnecting the lens cable to this 
connector, power off the camcorder first.

o Tripod mount
When using the camcorder on a tripod, attach the 
tripod adaptor (optional).

Accessory Attachments
Locations and Functions of Parts and Controls
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p Lens mount (special bayonet mount)
Attach the lens.

Consult a Sony service representative for 
information about available lenses.

q Lens locking lever
After inserting the lens in the lens mount, rotate 
the lens mount ring with this lever to lock the lens 
in position.
After locking the lens, be sure to use the lens 
mount securing rubber to prevent the lens from 
becoming detached.

r Lens mount cap
Remove by pushing up the lens locking lever. 
When no lens is mounted, keep this cap fitted for 
protection from dust.

Front

a REC START (recording start) button
Press to start recording. Press it again to stop 
recording. The effect is the same as that of the 
REC button on the lens.

b SHUTTER selector
Set to ON to use the electronic shutter. Push to 
SELECT to switch the shutter speed or shutter 
mode setting. When this switch is operated, the 
new setting appears on the viewfinder screen for 
about three seconds.

For details, see “Setting the Electronic Shutter” 
(page 57).

c FILTER selector
Switches between four ND filters built into this 
camcorder.
When this selector is used, the new setting 
appears on the viewfinder screen for about three 
seconds.

You can change a MAINTENANCE menu 
setting so that different white balance settings can 
be stored for different FILTER selector positions. 
This allows you to automatically obtain optimum 
white balance for the current shooting conditions 
in linkage with the filter selection.

For details, see “Adjusting the White Balance” 
(page 55).

d MENU knob
Changes the item selection or a setting within the 
menu (see page 109).

e AUTO W/B BAL (automatic white/
black balance adjustment) switch

Activates the automatic white/black balance 
adjustment functions.
WHITE: Adjust the white balance automatically. 

If the WHITE BAL switch (see page 19) is 
set to A or B, the white balance setting is 
stored in the corresponding memory. If the 
WHITE BAL switch is set to PRST, the 
automatic white balance adjustment function 
does not operate.

BLACK: Adjust the black set and black balance 
automatically.

You can use the AUTO W/B BAL switch even 
when the ATW (Auto Tracing White Balance) 
function is operating.
If you push the switch to the WHITE side once 
more during the automatic white balance 
adjustment, the adjustment is cancelled and the 

Operating and Connectors Section

FILTER selector 
setting

ND filter

1 CLEAR

2 1/4 ND (attenuates light to 
approximately 1/4)

3 1/16 ND (attenuates light to 
approximately 1/16)

4 1/64 ND (attenuates light to 
approximately 1/64)
Locations and Functions of Parts and Controls 17Download from Www.Somanuals.com. All Manuals Search And Download.



18

C
hapter 1  O

verview
white balance setting returns to the original 
setting.
If you push the switch to the BLACK side once 
more during the automatic black balance 
adjustment, the adjustment is cancelled and the 
black balance setting returns to the original 
setting.

f MIC (microphone) LEVEL control
Adjusts the input level of audio channels 1, 2, 3 
and 4 (see page 60).

Right side (near the front)

a ASSIGN. (assignable) 1/2/3 switches
You can assign the desired functions to these 
switches on OPERATION >Assignable SW in 
the setup menu (see page 155).
Off is assigned to the ASSIGN 1/2/3 switches as 
the factory default setting.
The ASSIGN.1/3 switches are provided with an 
indicator to show whether a function is assigned 
to the switch (ON) or not (OFF).

b COLOR TEMP. (color temperature) 
button

Press to light the button and change the color 
temperature for shooting (factory default setting). 
You can use this as an assignable switch (see 
page 155).

c ALARM (alarm tone volume 
adjustment) knob

Controls the volume of the warning tone that is 
output via the built-in speaker or optional 
earphones. When the knob is turned to the 
minimum position, no sound can be heard.
However, if MAINTENANCE >Audio >Min 
Alarm Volume in the setup menu is set to [Set], 
the alarm tone is audible even when this volume 
control is at the minimum position.

d MONITOR (monitor volume 
adjustment) knob

Controls the volume of the sound other than the 
warning tone that is output via the built-in speaker 
or earphones. When the knob is turned to the 
minimum position, no sound can be heard.

e MONITOR (audio monitor selection) 
switches

By means of combinations of the two switches, 
you can select audio that you want to hear through 
the built-in speaker or earphones.

Position of down-side switch: CH-1/2

Position of down-side switch: CH-3/4

Position of up-side 
switch

Audio output

CH-1/CH-3 Channel 1 audio

MIX Channels 1 and 2 mixed 
audio (stereo) a)

CH-2/CH-4 Channel 2 audio

Position of up-side 
switch

Audio output

CH-1/CH-3 Channel 3 audio

MIX Channels 3 and 4 mixed 
audio (stereo) a)

CH-2/CH-4 Channel 4 audio

ALARM

Minimum Maximum
Locations and Functions of Parts and Controls
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a) By connecting stereo headphones to the EARPHONE 

jack, you can hear the audio in stereo. (Under 
MAINTENANCE >Audio in the setup menu, 
Headphone Out must be set to STEREO.)

f ASSIGN. (assignable) 0 switch
You can assign the desired function to this switch 
on OPERATION >Assignable SW in the setup 
menu (see page 156).
Off is assigned to this switch when the camcorder 
is shipped from the factory.
This is a momentary type switch. Each press of 
the switch turns the function assigned to this 
switch on or off.

g GAIN selector
Switches the gain of the video amplifier to match 
the lighting conditions during shooting. The gains 
corresponding to the L, M, and H settings can be 
selected on OPERATION >Gain Switch in the 
setup menu (see page 119). (The factory settings 
are L=0 dB, M=6 dB, and H=12 dB.)
When this switch is adjusted, the new setting 
appears on the viewfinder screen for about three 
seconds.

h OUTPUT/DCC (output signal/dynamic 
contrast control) switch

Switches the video signal output from the camera 
module, between the following two.
BARS: Output the color bar signal.
CAM: Output the video signal being shot. When 

this is selected, you can switch DCC 1) on and 
off.

1) DCC (Dynamic Contrast Control): Against a very 
bright background with the iris opening adjusted to the 
subject, objects in the background will be lost in the 
glare. The DCC function will suppress the high 
intensity and restore much of the lost detail and is 
particularly effective in the following cases.
• Shooting people in the shade on a sunny day
• Shooting a subject indoors, against a background 

through a window
• Any high contrast scene

i WHITE BAL (white balance memory) 
switch

Controls adjustment of the white balance.
PRST: Adjust the color temperature to the preset 

value (the factory default setting: 3200K). 
Use this setting when you have no time to 
adjust the white balance.

A or B: Recall the white balance adjustment 
settings already stored in A or B. Push the 

AUTO W/B BAL switch (see page 17) on 
the WHITE side, to automatically adjust the 
white balance, and save the adjustment 
settings in memory A or memory B.

B (ATW 1)): When this switch is set to B and 
OPERATION >White Setting >White 
Switch<B> is set to [ATW] in the setup 
menu, ATW is activated.
You can use the AUTO W/B BAL switch 
even when ATW is in use.

When this switch is adjusted, the new setting 
appears on the viewfinder screen for about three 
seconds.
1) ATW (Auto Tracing White Balance): The white 

balance of the picture being shot is adjusted 
automatically for varying lighting conditions.

j MENU ON/OFF switch
To use this switch, open the cover.
This switch is used to display the menu on the 
viewfinder screen or the test signal screen. Each 
time the switch is pushed down, the menu screen 
is turned on and off.
The function of this switch is the same as that of 
the MENU button in the thumbnail screen 
operations section.

Note

This switch has different functions depending on 
whether or not a menu is displayed.

k MENU CANCEL/PRST (preset) /
ESCAPE switch

To use the MENU CANCEL/PRST/ESCAPE 
switch, open the cover.

Note

It is not possible to turn off the menu screen by closing 
the cover.

Use the switch in the following way when the 
menu is not displayed.
CANCEL/PRST: Each time this switch is 

pushed upward, a window to confirm the 
menu settings and status of the camcorder 
appears on the viewfinder screen (see 
page 66). The window consists of five pages, 
which are switched each time the switch is 
pushed upward. Each page is displayed for 
about 10 seconds.

ESCAPE: To clear the page immediately after 
display, push this switch down to the OFF 
position.
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Use the switch in the following way when the 
menu is displayed.
CANCEL/PRST: Pushing this switch up to this 

position after a setting is changed in the setup 
menu displays the message to confirm 
whether the previous settings are cancelled. 
Pushing this switch up to this position again 
cancels the previous settings.
Pushing this switch up to this position before 
a setting is changed in the setup menu or after 
a setting change is cancelled in the setup 
menu displays the message to confirm 
whether the setting is reset to the initial 
value.
Pushing this switch up to this position again 
resets the settings to the initial value.

ESCAPE: Use this switch when the menu page, 
which has a hierarchical structure, is opened. 
Each time the switch is pushed to this 
position, the page returns to one stage higher 
in the hierarchy.

l Cover
Open this cover to use the MENU ON/OFF 
switch or the MENU CANCEL/PRST/ESCAPE 
switch.

Right side (near the rear)

a Built-in speaker
The speaker can be used to monitor E-E 1) sound 
during recording, and playback sound during 
playback. The speaker also sounds alarms to 
reinforce visual warnings (see page 176).
If you connect earphones to the EARPHONE 
jack, the speaker output is suppressed 
automatically.
1) E-E: Abbreviation of “Electric-to-Electric”. In E-E 

mode, video and audio signals input to the camcorder 
are output after passing through internal electric 
circuits only. This can be used to check input signals.

b LCD monitor
Displays remaining battery capacity, remaining 
media capacity, audio levels, time data, and so on 
(see page 26).
Also allows you to check camera and playback 
pictures.
Locations and Functions of Parts and Controls
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You can adjust the position and angle of the LCD 
monitor.

c WARNING indicator
Lights up or flashes when an abnormality occurs 
(see page 176).

d ACCESS lamp
Lights up in blue when data is written to or read 
from the recording media.

e Protection cover of the audio control 
section

Open to access the audio control section (see 
page 22).

f Protection cover of the thumbnail 
screen operations section

Open to access the thumbnail screen operations 
section (see page 22).

g F REV (fast reverse) button and 
indicator

This plays back at high speed in the reverse 
direction. The playback speed changes in the 
order ×4 t ×15 t ×24 with each press of the 
button. The indicator lights during high-speed 
playback in the reverse direction.

h PLAY/PAUSE button and indicator
Press this button to view play back video images 
using the viewfinder screen or the LCD monitor. 
The indicator lights during playback.
Press this button again during playback to pause, 
outputting a still image. At this time the indicator 
flashes at a rate of once per second.
Pressing the F REV or F FWD button during 
playback or pause starts high speed playback in 
the forward or reverse direction.

i F FWD (fast forward) button and 
indicator

This plays back at high speed in the forward 
direction. The playback speed changes in the 
order ×4 t ×15 t ×24 with each press of the 
button. The indicator lights during high-speed 
playback in the forward direction.

j PREV button
This jumps to the first frame of the current clip. 
If you press this together with the F REV button, 
the jump is to the first frame of the first recorded 
clip on the recording media.
If you press this button twice in rapid succession, 
the jump is to the first frame of the last preceding 
clip (or the first frame of the current clip when no 
preceding clips exist).

k STOP button
Press this button to stop playback.

l NEXT button
This jumps to the first frame of the next clip.
If you press this together with the F FWD button, 
the jump is to the first frame of the last recorded 
clip on the recording media.

m DISP SEL (display selection)/EXPAND 
(expand function) button

With each press of this button, the display in the 
LCD monitor changes as follows.

If you press this button when the thumbnail 
screen is displayed, the duration of the selected 
clip is divided into fractions, and the first frame of 
each of the divisions is shown in a further 
thumbnail display (expand function). For an HD 
recorded MP4 clip, its duration is divided into 12. 
If an SD recorded AVI clip comprises multiple 
files, the divisions are displayed for the individual 
files.

Display indication Meaning
Video with 
superimposed 
information (CHAR)

The LCD monitor displays 
the same text information as 
the viewfinder.

Video without 
superimposed 
information (MONI)

The video only appears.

Status display 
(STATUS)

Counter indications, 
warnings, audio levels, and 
similar information appear. 
No video image appears.
Locations and Functions of Parts and Controls 21Download from Www.Somanuals.com. All Manuals Search And Download.



22

C
hapter 1  O

verview
For MP4 clips, each time you press this button the 
division is repeated. Hold down the SHIFT button 
and press this button to step back through the 
division process.

n HOLD (display hold) button
Pressing this button instantly freezes the time data 
displayed in the LCD monitor. (The timecode 
generator continues running.) Pressing this button 
again releases the hold.

For details of the counter display, see page 27.

o RESET/RETURN button
Resets the value shown in the time counter 
display in the LCD monitor. According to the 
settings of the PRESET/REGEN/CLOCK switch 
(see page 23) and the F-RUN/SET/R-RUN 
switch (see page 23), this button resets the 
display as follows.

a) Of the timecode bits for every frame recorded on the 
media, those bits which can be used to record useful 
information for the user such as scene number, 
shooting place, etc.

For details, see “Setting the Time Data” (page 62).

This button returns to the previous screen when 
pressed during thumbnail screen display, expand 
thumbnail screen display, or essence mark 
thumbnail screen display.

p DISPLAY switch
This cycles the data displayed in the time counter 
display in the LCD monitor through the sequence 
COUNTER, TC, and U-BIT (see page 27).
COUNTER: Display the elapsed recording/

playback time (hours, minutes, seconds, 
frames).

TC: Display timecode.
U-BIT: Display user bits data.

q BRIGHT (brightness) button
Switches the brightness of the LCD monitor 
backlight.
Each press of the button selects the next setting in 
the order shown in the following table.
If you press the button with the LCD monitor off, 
the LCD backlight comes on in the H state.

Thumbnail screen operations section and audio 
control section

a THUMBNAIL indicator 
This lights when thumbnail screen is displayed.

b THUMBNAIL button
Press this button to display the thumbnail screen 
(see page 91) and to carry out a thumbnail 
operation.
Press once more to return to the original display.

c SET (set) button and arrow buttons
Use these buttons to make timecode and user bit 
settings, and for thumbnail screen operations (see 
page 98).
When the menu is displayed, press this button to 
select an item or to confirm the setting change.

d MENU button
Each press of this button turns the setup menu 
display on and off.
The function of this button is the same as that of 
the MENU ON/OFF switch.

Settings of switches To reset
DISPLAY switch: COUNTER Counter to 

0:00:00:00

DISPLAY switch: TC
PRESET/REGEN/CLOCK 
switch: PRESET
F-RUN/SET/R-RUN switch: 
SET

Timecode to 
00:00:00:00

DISPLAY switch: U-BIT
PRESET/REGEN/CLOCK 
switch: PRESET
F-RUN/SET/R-RUN switch: 
SET

User bits data a) to 
00 00 00 00

Setting LCD monitor backlight
H High (select this to view the LCD 

monitor outdoors in the daytime)

M Brightness between H and L

L Low (select this to view the LCD monitor 
indoors or outdoors at night)

OFF Off (the display is also off)
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e F-RUN/SET/R-RUN (free run/set/
recording run) switch

Selects the operating mode of the internal 
timecode generator. The operating mode is set as 
explained below, depending on the position of the 
switch.
F-RUN: Timecode keeps advancing, regardless 

of whether the camcorder is recording. Use 
this setting when synchronizing the timecode 
with external timecode.

SET: Sets the timecode or user bits.
R-RUN: Timecode advances only during 

recording. Use this setting to have a 
consecutive timecode on the recording 
media.

For details, see “Setting the Timecode” (page 62) 
and “Setting the User Bits” (page 63).

f LEVEL CH1/CH2/CH3/CH4 (audio 
channel 1/2/3/4 recording level) knobs

Adjust the audio levels to be recorded on channels 
1, 2, 3, and 4 when the AUDIO SELECT CH1/
CH2 and AUDIO SELECT CH 3-4 switches are 
set to MANUAL.

g AUDIO SELECT CH 3-4 (audio 
channel 3/4 adjustment method 
selection) switch

Select the audio level adjustment method for each 
of audio channels 3 and 4.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

h ESSENCE MARK button
By pressing this button when a thumbnail display  
is on the screen, you can view the following 
thumbnail displays of the essence-marked frames 
of the selected clip, depending on the item 
selected in a list displayed on the screen.
All: Thumbnail display of all frames marked with 

essence marks.
Rec Start (in UDF mode): Thumbnail display of 

frames marked with Rec Start marks and of 
the first frames of clips (when the first frames 
are not marked with Rec Start marks).

Shot Mark1: Thumbnail display of the frames 
marked with Shot Mark 1

Shot Mark2: Thumbnail display of the frames 
marked with Shot Mark 2

You can also select Shot Mark 0 and Shot Mark 3 
to Shot Mark 9.

If you have recorded clips by using planning 
metadata that defined names for Shot Mark 0 to 
Shot Mark 9, the defined names are displayed 
instead of the above item names in the list.

i SHIFT button
Use this in combination with other buttons.

j PRESET/REGEN (regeneration)/
CLOCK switch

Selects the type of timecode to record.
PRESET: Record new timecode on the media.
REGEN: Record timecode continuous with the 

existing timecode recorded on the media. 
Regardless of the setting of the F-RUN/SET/
R-RUN switch, the camcorder operates in R-
RUN mode.

CLOCK: Record timecode synchronized to the 
internal clock. Regardless of the setting of 
the F-RUN/SET/R-RUN switch, the 
camcorder operates in F-RUN mode.

k AUDIO SELECT CH1/CH2 (audio 
channel 1/2 adjustment method 
selection) switches

Select the audio level adjustment method for each 
of audio channels 1 and 2.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

l AUDIO IN CH1/CH2/CH3/CH4 (audio 
channel 1/2/3/4 input selection) switches

Select the audio input signals to be recorded on 
audio channels 1, 2, 3 and 4.
FRONT: Audio input signals from the 

microphone connected to the MIC IN 
connector

REAR: Audio input signals from an audio device 
connected to the AUDIO IN CH-1/CH-2 
connectors

WIRELESS: Audio input signals from the UHF 
portable tuner if it is installed
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Left side and upper section

a ASSIGNABLE 4/5 switches
You can assign the desired functions to these 
switches on OPERATION >Assignable SW in 
the setup menu (see page 156).
Off is assigned to these switches when the 
camcorder is shipped from the factory.

b PC connector
Used to put this camcorder into USB connection 
mode and use it as an external storage device for 
a computer. When a computer without 
ExpressCard slot is connected to this connector, 
every memory card inserted in the camcorder is 
recognized as a drive for that computer.

c External device connector
Connect an optional CBK-WA01 Wi-Fi Adapter 
or a USB flash drive.
When a CBK-WA01 is connected: Wireless 

LAN connection is available. 
When a USB flash drive is connected: 

Recording, saving and loading the following 
data are available.
• Recording of proxy data (see page 85)
• Loading of planning metadata (see 

page 87)
• Save and load setting data (see page 160)

Notes

• When you connect a CBK-WA01, install the optional 
CBK-UPG01 Hardware Upgrade Key.

• Use this connector only for connecting a CBK-WA01 
or a USB flash drive. Do not connect and use a USB 
hub or similar products.

For details on how to use the CBK-WA01, refer to the 
Supplement supplied in the CD-ROM (labeled 
“Manuals for Solid-State Memory Camcorder”).

d SxS memory card slots
These two slots (A and B) can receive SxS 
memory cards or other recording media (see 
page 69).

e ACCESS lamps
Indicate the state of slots A and B (see page 69). 
You can check whether the lamps are lit even 
when the slot cover is closed.

f EJECT buttons
To remove the recording media from the slot, 
press the EJECT button to release the lock, then 
press the button once more. This makes the media 
come out of the slot partially (see page 70).

g Slot cover
Slide to the left and right to open and close.
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h SLOT SELECT (SxS memory card 
select) button

When SxS memory cards are loaded in both card 
slots A and B, press this button to select the card 
you want to use (see page 70).

i SDI IN (OPTION) (SDI input 
(optional)) connector (BNC type)

When the optional CBK-HD02 SDI/
COMPOSITE Input and 50 Pin Interface is 
installed, the camcorder can record HDSDI or 
SDSDI signals input to this connector.

j GENLOCK IN (genlock signal input) 
connector (BNC type)

This connector inputs a reference signal when the 
camcorder is to be genlocked or when timecode is 
to be synchronized with external equipment.
Available reference signals vary depending on the 
current system frequency as shown in the 
following table.

(Genlock for the camera module supports 
horizontal sync signals only.) Use 
MAINTENANCE >GENLOCK in the setup 
menu to adjust the genlock H-phase (phase of 
horizontal sync signal).
When the optional CBK-HD02 SDI/
COMPOSITE Input and 50 Pin Interface is 
installed, the camcorder can record analog 
composite video signals input to this connector.

k TC IN (timecode input) connector 
(BNC type)

To apply an external lock to the timecode of the 
camcorder, input the reference timecode.

For details, see “Setting the Timecode” (page 62).

l VIDEO OUT connector (BNC type)
Outputs video signals for monitoring. The output 
signals can be selected either composite video or 
HD-Y depending on the setting of OPERATION 
>Input/Output >Output&i.LINK in the setup 
menu.

m TC OUT (timecode output) connector 
(BNC type)

To lock the timecode of an external VTR to the 
timecode of this camcorder, connect this 
connector to the external VTR’s timecode input 
connector.

Rear
System frequency Available reference signals
1080/59.94i 1080/59.94i, 480/59.94i

1080/29.97P 1080/59.94i, 480/59.94i

1080/23.98P (PsF 
output)

1080/23.98PsF, 480/59.94i

1080/23.98P 
(Pulldown output)

1080/59.94i, 480/59.94i

720/59.94P 1080/59.94i, 720/59.94P, 
480/59.94i

720/29.97P 1080/59.94i, 720/59.94P, 
480/59.94i

720/23.98P 1080/59.94i, 720/59.94P, 
480/59.94i

480/59.94i 1080/59.94i, 480/59.94i

480/29.97P 1080/59.94i, 480/59.94i

1080/50i 1080/50i, 576/50i

1080/25P 1080/50i, 576/50i

720/50P 1080/50i, 720/50P, 576/50i

720/25P 1080/50i, 720/50P, 576/50i

576/50i 1080/50i, 576/50i

576/25P 1080/50i, 576/50i
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a TALLY (back tally) indicators (red)
Light up during recording. They will not light if 
the TALLY switch is set to OFF. These indicators 
also flash to indicate warnings (see page 21). The 
tally indicator on the front of the viewfinder and 
the REC indication on the viewfinder screen light 
or flash in the same manner.

For details, see “Operation Warnings” (page 176).

b TALLY switch
Set to ON to activate the TALLY indicator 
function.

c EARPHONE jack (stereo, minijack)
You can monitor the E-E sound during recording 
and playback sound during playback. When an 
alarm is indicated, you can hear the alarm sound 
through the earphone. Plugging an earphone into 
the jack automatically cuts off the built-in 
speaker.
You can select monaural or stereo on 
MAINTENANCE >Audio in the setup menu.

d AUDIO IN selectors
Select the audio source you connect to the 
AUDIO IN CH1/CH2 connectors.
LINE: When connecting a stereo amplifier or 

other external audio signal source
MIC: When connecting a microphone that does 

not require 48 V power supply
+48V: When connecting a microphone that 

requires 48 V power supply

e HD/SD SDI OUT connector (BNC type)
Outputs an HDSDI or SDSDI signal (with 
embedded audio). The output from this connector 
can be turned on or off by OPERATION >Input/
Output >SDI Output in the setup menu.

f AUDIO IN CH-1/CH-2 (audio channel 
1 and channel 2 input) connectors (XLR 
type, 3-pin, female)

These are audio input connectors for channels 1 
and 2 to which you can connect audio equipment 
or a microphone.

g Bottom cover
This is provided for protecting the cables 
connected to the connectors on the rear panel.

By loosening the screws which retain the cover to 
the bottom of the camcorder, you can adjust the 
position of the cover depending on the size and 
shape of the microphone or audio cable plugs.
After adjusting the position, tighten the screws to 
secure the cover. 

h AUDIO OUT connector (XLR type, 5-
pin, male)

Outputs the audio signals recorded on audio 
channels 1 and 2 or audio channels 3 and 4. The 
audio signals are selected by the MONITOR 
switch.

i REMOTE connector (8-pin)
Connect a remote control unit, which makes it 
possible to control the camcorder remotely.

Note

Before connecting/disconnecting the Remote Control 
Unit to/from the camcorder, be sure to turn off the 
camcorder POWER switch.

j i.LINK (HDV/DV) connector (6-pin, 
IEEE1394 compliant, S400)

When the recording mode is FAT, to input and 
output HDV/DV streams, connect to an HDV/DV 
device.

a Resolution
Indicates the resolution of HD output video.

FAT

LCD Monitor

Indication Resolution (horizontal × vertical)
1080 1080 lines (1920 × 1080)

720 720 lines (1280 × 720)
Locations and Functions of Parts and Controls
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b Recording format
Indicates the current recording format or the 
recording format of clip being currently played.
• UDF mode

HD422 50
HD420 HQ
IMX50
DVCAM

• FAT mode
HQ1920
HQ1440
HQ1280
SP1440
DVCAM

c Recording mode
UDF: UDF mode
FAT: FAT mode

d File format
MXF: When the recording mode is UDF
MP4: When the recording mode is FAT-HD 

mode
DV-AVI: When the recording mode is FAT-SD 

mode

e System frequency
Indicates the system frequency of video being 
currently played or recorded.
59.94i
29.97P
23.98P
50i
25P
59.94P
50P

f Status display
PB: Appears during play.
NDF: Appears when non-drop-frame timecode is 

selected.
EXT-LK: Appears when the internal timecode 

generator is locked to an external signal input 
to the TC IN (timecode input) connector.

HOLD: Appears when the operation mode of the 
internal timecode generator is set to R-RUN 
and stopped.

g Audio format
Indicates the audio recording format or the audio 
format of clip being currently played.

h Audio level indicators
Indicate the audio recording or play levels of 
channels 1 to 4.

i Time counter display
Switches displays of time counter values, 
timecode, and user bits data, depending on the 
position of the DISPLAY switch.
Displays the type of data currently shown in the 
time counter, as follows.
TCG: Recorded timecode 
TCR: Playback timecode 
UBG: Recorded user bits 
UBR: Playback user bits 
CNT: Counter 
CLK: Time display (when the PRESET/REGEN/

CLOCK switch is set to CLOCK)

When the HOLD button is pressed to hold the 
timecode value, the timecode is displayed in the 
format shown below. When the HOLD button is 
pressed again to release the hold, the timecode is 
displayed in the normal format.

j Warning indicator area
Displays warnings when trouble with recording 
or moisture condensation occurs.

For details, see “Operation Warnings” on page 176.

You can also display the name of the next clip to 
be recorded (see page 127).

k Remaining media capacity indicator
Shows bar segments indicating the remaining 
capacity of recording media in the slots.

Indication Status
Recording 
mode

Recording format

16bit FAT Any format

UDF • HD420 HQ
• DVCAM
• IMX (Audio Length is 

set to16 bit)

24bit UDF • HD422 50
• IMX (Audio Length is 

set to24 bit) 

The three dots indicates that timecode is 
displayed in the hold mode.
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l Remaining battery capacity indicator
Shows bar segments indicating the remaining 
battery capacity.

a Plug
Connect to the VF connector (20-pin) on the 
camcorder.

b Stopper
Prevents the viewfinder from coming off the 
camcorder when it is slid from side to side.

c Camera operator tally indicator
Lights up while camcorder is recording. This 
indicator can be covered when not in use.
This indicator also flashes to indicate warnings, in 
the same manner as the tally indicator and the 
recording/red tally indicators in the viewfinder.

d Eyecup

e Indicators and status display

For details, see “Status Display on the Viewfinder 
Screen” on page 30.

f Diopter adjustment ring
Allows for optimal focus adjustment.

g Tally indicator
Lights up while camcorder is recording. Set the 
TALLY switch to OFF when not in use. The 
brightness can also be adjusted with the TALLY 
switch.
This indicator also flashes to indicate warnings, in 
the same manner as the camera operator tally 
indicator and the recording/red tally indicators in 
the viewfinder.

h PEAKING control
Turning this control clockwise adjusts the picture 
sharpness, and makes focusing easier. This 
control has no effect on the output signals of the 
camcorder.

i CONTRAST control
Adjusts the contrast of the screen. This control 
has no effect on the output signals of the 
camcorder.

j BRIGHT control
Adjusts the brightness of the screen. This control 
has no effect on the output signals of the 
camcorder.

k TALLY switch
Controls the tally indicator located on the front of 
the viewfinder.
HIGH: The tally indicator brightness is set to 

high.
OFF: The tally indicator is disabled.
LOW: The tally indicator brightness is set to low.

l ZEBRA (zebra pattern) switch
Controls the zebra pattern display on the 
viewfinder screen as follows.
ON: A zebra pattern appears and stays.
OFF: The zebra pattern disappears.
MOMENT: A zebra pattern appears and stays for 

about five seconds.

m DISPLAY/ASPECT switch
Turns the marker indication on and off, and 
switches between 4:3 and 16:9 aspect ratios for 
viewfinder screen display.
DISPLAY: When the marker indication is 

enabled with the camcorder, the marker 
indication on the viewfinder screen turns on 
and off every time you push the switch up to 
this position.

ASPECT: Each push of the switch down to this 
position toggles the mask display on and off. 

HDVF-20A Viewfinder (Optional)
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(Make mask display settings using 
OPERATION >Marker >Aspect Mask in the 
setup menu (see page 119).)

n Viewfinder cable

o Microphone holder

a Plug
Connect to the VF connector (26-pin) on the 
camcorder.

b Stopper
Prevents the viewfinder from coming off the 
camcorder when it is slid from side to side.

c Eyecup

d Diopter adjustment ring
Allows for optimal focus adjustment.

e Eyepiece
You can raise this up when required by the 
situation.

f Viewfinder barrel
You can raise this up or rotate when required by 
the situation.

g Tally indicator
Lights up when recording is started by a press of 
the REC START button on this camcorder, the 
VTR button on the lens, or the VTR button on the 
remote control unit.
When an abnormality occurs, the tally indicator 
flashes to indicate a warning.

h PEAKING control
Turning this control clockwise adjusts the picture 
sharpness, and makes focusing easier. This 
control has no effect on the output signals of the 
camcorder.

i CONTRAST control
Adjusts the contrast of the screen. This control 
has no effect on the output signals of the 
camcorder.

j BRIGHT control
Adjusts the brightness of the screen. This control 
has no effect on the output signals of the 
camcorder.

k TALLY switch
Controls the tally indicator located on the front of 
the viewfinder.
HIGH: The tally indicator brightness is set to 

high.
OFF: The tally indicator is disabled.
LOW: The tally indicator brightness is set to low.

l ZEBRA (zebra pattern) switch
Controls the zebra pattern display on the 
viewfinder screen as follows.
ON: Display a zebra pattern.
OFF: Do not display a zebra pattern.

m DISPLAY switch
Turns the display of text information on and off.
ON: Display text information.
OFF: Do not display text information.

n MIRROR switch
The image display on the monitor screen becomes 
reversed horizontally or vertically when the 
viewfinder barrel is raised up or rotated. Use this 
switch to control the image display in such 
situation.

CBK-VF01 Viewfinder (Optional)
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L/R: Reverse the image horizontally.
OFF: Do not reverse the image.
B/T: Reverse the image vertically.

o Viewfinder cable

p Microphone holder

Indicators (HDVF-20A)
The following indicators are arranged above and 
below the screen of the HDVF-20A to show the 
current state and adjustments of the camcorder.

a Green tally indicator
Lights when the camcorder is the following 
states.
• Picture Cache mode enabled
• Green tally signal received (when a camera 

adaptor is mounted on the camcorder and a 
camera extension unit is connected)

• Recording with MAINTENANCE >Camera 
Config >HD/SDI Remote I/F in the setup menu 
set to [G-Tally]

Flashes when the camcorder is the following 
states.
• Set to Interval Rec mode or the consecutive 

mode of Frame Rec mode (1 flash per second)
• Recording in Interval Rec mode or recording in 

the consecutive mode of Frame Rec mode (4 
flashes per second)

• Set to the single-shot mode of Frame Rec mode, 
or recording in that mode (2 flashes per second)

b BATT (battery) indicator 
This indicator starts flashing when the battery 
connected to the camcorder is nearly exhausted, 
and stays lit when the battery is completely 
exhausted.
To prevent interruption during operation, replace 
the battery as soon as this indicator starts flashing.

The battery power level at which the indicator starts 
flashing can be set by MAINTENANCE >Battery in 
the setup menu. For details, see page 135.

c Recording/red tally indicators
Light when the camcorder is the following states.
• Recording with the MAINTENANCE >Camera 

Config >HD/SDI Remote I/F menu item set to 
[R-Tally]

• Green tally signal or call signal received (when 
a camera adaptor is mounted on the camcorder 
and a camera extension unit is connected)

These indicators also flash to indicate warnings, 
in the same manner as the tally indicator and the 
camera operator tally indicator.

d Viewfinder screen

See “Viewfinder screen display” (page 30).

e VTR SAVE indicator
Do not function on this camcorder.

f ! (warning) indicator
This indicator lights when any of the following 
conditions occurs with the corresponding item set 
to [On] by OPERATION >“!” LED in the setup 
menu.
• The gain is set to other than 0 dB.
• The SHUTTER selector is set to ON.
• The WHITE BAL switch is set to PRST.
• ATW is enabled.
• The lens extender is used.
• The reference value of auto iris adjustment is 

not the standard value.
• The FILTER selector is set to other than 1.

Viewfinder screen display
The viewfinder screen displays not only the video 
picture but also characters and messages 
indicating the camcorder settings and operating 
status, a center marker, a safety zone marker, etc.
When the menu screen is not displayed and the 
DISPLAY switch is set to ON, the items for 
which an ON setting was made with 

Status Display on the Viewfinder 
Screen
Locations and Functions of Parts and Controls
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OPERATION >Super Impose in the setup menu 
or with related switches are displayed at the top 
and bottom of the screen.
Caution messages are indicated for three seconds 
when you carry out operations to change 
camcorder settings. Adjustment execution 
messages are indicated while adjustments 
proceed. When adjustments are finished, 
messages showing the results of adjustments 
appear for three seconds.
Not only these indications are displayed on the 
viewfinder screen, but a menu setting enables 
them to be output as video signals. 
All items that can be displayed on the viewfinder 
screen are shown below.

Top of viewfinder screen

a Extender settings
Indicates the setting of the digital extender 
function (when optional CBK-HD02 SDI/
COMPOSITE Input and 50 Pin Interface is 
installed) of this camcorder and the setting of the 
lens extender.
EX: The lens extender is on.
08: The lens shrinker is on.
x2D: The digital extender function of this 

camcorder is on.
Ex2D: The lens extender and the digital extender 

function of this camcorder are both on.

Digital extender function can be turned on or off 
by an assignable switch to which Digital Extender 
is assigned.

Note

When slow & Quick motion is selected or the freeze mix 
function is used, the digital extender cannot be turned on. 
When the camcorder is in focus magnification (Focus 
Mag) mode, turning on the digital extender cancels the 
mode.

b Zoom position (when the lens is 
mounted)

Indicates the zoom position of the zoom lens in 
the range from 0 to 99.

c Focus position (when the serial lens is 
mounted)

Indicates the focus position as distance to the 
subject (in units of m).

d Green tally
Lights when the camcorder is the following 
states.
• MAINTENANCE >Camera Config >HD-SDI 

Remote I/F is set to [G-Tally] in the setup menu 
and a recording control signal is output from the 
HD/SD SDI OUT connector.

• When the Picture Cache mode is enabled
• Green tally signal received (when a camera 

adaptor is mounted on the camcorder and a 
camera extension unit is connected)

e Media status
Displays the name of the currently active media 
slot (A or B).

f Special recording mode/operation 
status

Indicates the current special recording mode/
operation status as follows.

Indication Meaning
zREC Recording in progress

STBY When recording is on a break in 
Clip Continuous Rec mode or 
standby in other modes

CONT Standby for next recording in Clip 
Continuous Rec mode

zCACHE Standby in Picture Cache mode

zINT REC Recording in progress in Interval 
Recording mode

zINT STBY Standby for next recording in 
Interval Recording mode

INT STBY Standby in Interval Recording 
mode

zFRM REC Recording in progress in Frame 
Recording mode

zFRM 
STBY

Standby for next recording in 
Frame Recording mode

FRM STBY Standby in Frame Recording mode

zS&Q REC Recording in progress in Slow & 
Quick Motion mode
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 g Wireless receiver reception level
When a wireless receiver is installed in the 
camcorder, “W” appears together with four 
segment reception level indicators for each of the 
channels (1 to 4) that can be used by the receiver. 
The indications are as follows.
In normal situation: The number of white 

segments indicates the strength of the signal 
level.

Muting (for an analog receiver) or error rate 
aggravation (for a digital receiver): The 
number of grey segments indicates the 
strength of the signal level.

Reception level over peak: “P” is displayed 
instead of the indicators. 1)

Tuner battery is low: The channel number and 
indicator of the corresponding channel 
flash. 1)

1) When an optional DWR-S01D is used

h Battery remaining/voltage capacity
The following is displayed depending on the type 
of power source.

i External power input
Appears when power is supplied from an external 
power source connected to the DC IN connector.

j Color temperature
Displays a color temperature calculated from the 
gain of R and B, in the range 1.5 K to 50.0 K (in 
steps of 0.1 K). The +/– signs may be displayed 
depending on the Offset White setting (see 
page 124).
No display: Offset White is OFF

+: The value of Offset White is greater than 
3200K.

–: The value of Offset White is less than 3200K.

k Number of system lines
Indicates the number of system lines (1080/720/
576/480/486 1)) of video currently being recorded 
or played back.
1) In SD mode, when OPERATION >Format >Country 

is set to other than [PAL Area] in the setup menu.
In UDF mode: 486
In FAT mode: 480

In UDF mode, the system frequency is also 
displayed here.

l Video format
Indicates the video format for recording (59.94i/
29.97P/23.98P/50i/25P/59.94P/50P) or the video 
format of clip being currently played back (see 
page 51).
The video aspect ratio (16:9 or 4:3) can also be 
displayed when the recording format is set to 
IMX50 or DVCAM.

m Depth of field indication (when the 
serial lens is mounted and when the 
CBK-VF01 is used)

Error/warning indication
A bar indicates the depth of field. The display unit 
is meters or feet, as selected by OPERATION 
>Display On/Off >Lens Info in the setup menu.
An error or warning message is displayed here 
depending on the situation.

Under this area, you can also display the name of 
the next clip to be recorded (see page 127).

n Special recording mode indication
The following is displayed when the camcorder is 
in a special recording mode.
• Frame Rec (Frame Recording mode)
• Interval Rec (Interval Recording mode)
• S&Q Motion (Slow & Quick Motion mode)

o Special recording mode settings 
indication

Appears when the camcorder is in a special 
recording mode.

S&Q STBY Standby in Slow & Quick Motion 
mode

CALL 
(displayed in 
red)

Being called from a connected 
device

BREVIEW During recording review

Type of power 
source

What is displayed

InfoLithium 
battery

Remaining battery capacity icon 
and remaining recording time

Anton Bauer 
battery

Remaining battery capacity (% 
indication)

Other type than 
above

Input voltage

Indication Meaning
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Bottom of viewfinder screen

a TLCS iris control mode
The following icons are displayed to indicate the 
video level control modes based on the Total 
Level Control System (TLCS).

b Focus adjustment mode (when the auto 
focus lens is mounted)

Indicates the current focus adjustment mode of 
the camcorder.
• AF (Auto Focus mode)
• MF (Manual Focus mode)
• MF* (Manual Focus mode when the MF Assist 

function is on)
• Full MF (Full Manual Focus mode)

c External device control
“REC2” is displayed when MAINTENANCE 
>Camera Config >HD-SDI Remote I/F is set to 
[Chara] in the setup menu and a recording control 
signal is output from the HD/SD SDI OUT 
connector.

d Operation status of connected i.LINK 
device

The operating format (HDV or DV) and operation 
status of that device are indicated as follows.

e Video level indication
An indication is displayed together with an 
appropriate ND filter position number when the 
light level of the subject is too high or too low.

f Timecode 
Caution message

Indicates the elapsed recording/playback time, 
timecode, user bits data or other information 
selected by the DISPLAY switch (see page 22).
Also indicates a caution message when caution is 
required such as when you try to change settings.

g Brightness level (when the CBK-VF01 
is used)

Indicates the average brightness level (%) of the 
detection area.

h External input source
Indicates the type of external input signal (HDV) 
to be recorded.

i Recording of external input
Indicates “EXT” when an external input is 
recorded.

j Electric color temperature filter
Appears when the CC 5600K function is set to on.

k Filter position
Indicates the currently selected ND filter position 
number. (see page 17).
When ELECTRICAL CC is assigned to an 
assignable switch, the electrical filter position (A/
B/C/D) appears to the right of the ND filter 
position (1 to 4), as shown on the previous page.

l White balance memory
Indicates the currently selected white balance 
automatic adjustment memory.
ATW: ATW (Auto Tracing White Balance) mode
W:A: Memory A mode
W:B: Memory B mode
W:P: Preset mode
3200: When the assignable switch to which Color 

Temp SW 3200K has been assigned is on
4300: When the assignable switch to which Color 

Temp SW 4300K has been assigned is on 

Icon TLCS control mode

Backlight mode

Standard mode

Spotlight mode

Indication Meaning

zREC HDV recording in progress

STBY Standby for HDV recording

SSTD

zREC DV recording in progress

STBY Standby for DV recording

Indication Meaning
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5600: When the assignable switch to which Color 
Temp SW 5600K has been assigned is on

6300: When the assignable switch to which Color 
Temp SW 6300K has been assigned is on

m Gain value
Indicates the gain value (in dB) of the video 
amplifier, as set by the GAIN selector.

n Shutter
Indicates the shutter speed or the shutter mode. 

For details, see “Setting the Electronic Shutter” 
(page 57).

o Audio level meters
Indicate the audio levels of channel 1 and 
channel 2.

p Remaining media capacity
The available time for recording with the current 
video format (recording bit rate) is calculated 
according to the remaining space of each media 
and indicated in time units of minutes. A lock 
icon appears if the media is write-protected.

q Histogram (when the CBK-VF01 is 
used)

Shows a pixel distribution of video luminance (in 
HD mode only).

r Iris position (when the lens is mounted)
Indicates the iris position and the setting for iris 
override (reference value for the lens iris) (see 
page 59).
The iris override setting is indicated by four 
segments indicator as follows.

Reference 
value

Indicator

+0.25
x

Lower left segment is lit in grey.

+0.5 x

x

Left two segments are lit in grey.

+0.75 x
xx

Left two segments and lower 
right segment are lit in grey. 

+1 xx
xx

All segments are lit in grey.

–0.25
s

Lower left segment is lit in 
white.

–0.5 s

s

Left two segments are lit in 
white.

–0.75 s
ss

Left two segments and lower 
right segment are lit in white.

–1 ss
ss

All segments are lit in white.

Reference 
value

Indicator
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For safety, use only the Sony battery packs and 
AC adaptors listed below.
• BP-GL95/GL65/L60S/L80S Lithium-ion 

Battery Pack
• AC power using the AC-DN2B/DN10 AC 

Adaptor

CAUTION

Danger of explosion if battery is incorrectly replaced. 
Replace only with the same or equivalent type 
recommended by the manufacturer.
When you dispose of the battery, you must obey the law 
in the relative area or country.

ATTENTION

Il y a danger d’explosion s’il y a remplacement incorrect 
de la batterie. Remplacer uniquement avec une batterie 
du même type ou d’un type équivalent recommandé par 
le constructeur.
Lorsque vous mettez la batterie au rebut, vous devez 
respecter la législation en vigueur dans le pays ou la 
région où vous vous trouvez.

VORSICHT

Explosionsgefahr bei Verwendung falscher Batterien. 
Batterien nur durch den vom Hersteller empfohlenen 
oder einen gleichwertigen Typ ersetzen.
Wenn Sie die Batterie entsorgen, müssen Sie die Gesetze 
der jeweiligen Region und des jeweiligen Landes 
befolgen.

When a BP-GL95/GL65/L60S/L80S Battery 
Pack is used, the camcorder will operate 
continuously for the time shown below.

WARNING

Batteries shall not be exposed to excessive heat such as 
sunshine, fire or the like.

AVERTISSEMENT

N’exposez pas les batteries à une chaleur excessive, au 
soleil ou près d’un feu par exemple.

WARNUNG

Akkus dürfen keinesfalls übermäßiger 
Wärmeeinwirkung ausgesetzt werden, wie z.B. 
Sonneneinstrahlung, Feuer o. ä.

Note

The battery pack operating time depends on the 
frequency of use of the battery pack, and the ambient 
temperature when used.

Before use, charge the battery pack with a charger 
suitable for each battery.

For details on the battery charging procedure, refer 
to the battery charger operation manual.

Note on using the battery pack
A warm battery pack may not be able to be fully 
recharged.

To attach the battery pack

1 Press the battery pack against the back 
of the camcorder, aligning the line on 
the side of the battery pack with the 
matching line on the camcorder.

Chapter2 Preparations

Preparing a Power 
Supply

Using a Battery Pack

Model name Operating time
BP-GL95 Approx. 180 minutes

BP-GL65 Approx. 120 minutes

BP-L60S Approx. 110 minutes

BP-L80S Approx. 145 minutes
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2 Slide the battery pack down until its 
“LOCK” arrow points at the matching 
line on the camcorder.

Note

If the battery pack is not attached correctly, the terminal 
may be damaged.

To detach the battery pack
Holding the release button in, pull the battery 
pack up.

Notes

• During recording and playback (while the ACCESS 
lamp on the right-side panel is lit in blue and the 
ACCESS lamp in the card slot section is lit in orange), 
be careful never to remove the battery pack.

• Make sure to power the camcorder off before replacing 
the battery pack.

Mount an AC-DN2B/DN10 on the camcorder in 
the same way as a battery pack, then connect to 
the AC power supply.
The AC-DN2B/DN10 can supply up to 100 W of 
power.

1BP-GL95/GL65/L60S/L80S
2Align these lines.

1 “LOCK” arrow
2Matching line on the camcorder

Using AC Power

Release button

To an AC outlet
Preparing a Power Supply
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CAUTION

When the viewfinder is attached, do not leave the 
camcorder with the eyepiece facing the sun. Direct 
sunlight can enter through the eyepiece, be focused in the 
viewfinder and cause fire.

Note

The viewfinder is supplied separately.

The following procedure is an example for attaching the 
HDVF-20A.

For procedures for attaching other viewfinders, refer 
to a manual supplied with each viewfinder.

Note

When attaching the viewfinder, make notes of the 
following points.
• Be sure to the power off the camcorder before coupling 

the viewfinder connector to the camcorder’s VF 
connector (20-pin). If you make this connection when 
the camcorder power is on, the viewfinder may not 
function properly.

• Couple the viewfinder connector firmly to the 
camcorder’s VF connector. If the coupling is loose, 
noise may appear on the video or the tally light may not 
operate properly.

For more information about the connection of the 
viewfinder and camcorder, contact a Sony service 
representative.

1 1 Loosen the viewfinder left-to-right 
positioning ring, 2 attach the 
viewfinder to the viewfinder fitting 
shoe, and 3 tighten the viewfinder left-
to-right positioning ring.

2 Couple the viewfinder connector to the 
VF connector (20-pin).

Detaching the viewfinder
You can carry out this by following the attaching 
procedure in reverse order, but there is an 
additional action to take: when detaching the 
viewfinder from the fitting shoe, pull up the 
stopper.

To adjust the viewfinder left-right position, 
loosen the left-right positioning ring, and to adjust 
the front-back position, loosen the front-to-back 
positioning knob.

Attaching the Viewfinder

Attaching the Viewfinder

Adjusting the Viewfinder Position

Stopper

Viewfinder left-to-right positioning ring

VF connector (20-pin)
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By fitting an optional BKW-401 Viewfinder 
Rotation Bracket, you can rotate the viewfinder 
out of the way so that your right leg does not hit 
the viewfinder while you are carrying the 
camcorder.

1 Loosen the front-to-back viewfinder 
positioning levers and the front-to-back 
viewfinder positioning knobs, and then 
pull the viewfinder slide assembly 
forward.

2 Using a 2.5 mm diameter hexagonal 
wrench, detach the viewfinder slide 
assembly.

3 Attach the BKW-401 with the supplied 
bolts.Using the BKW-401 Viewfinder 

Rotation Bracket

Viewfinder front-to-back positioning knob

Viewfinder left-to-right positioning ring

Bolts with 
hexagonal 
hole

Viewfinder slide assembly

Bolts supplied with the BKW-401
Attaching the Viewfinder
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4 Adjust the front-to-back position so 
that the arm of the BKW-401 does not 
touch the handle when it is raised.

Removing the eyepiece gives a clearer view of the 
screen from further away. It is also easy to 
remove dust from the viewfinder screen and 
mirror when the eyepiece is detached.

1 Turn the eyepiece locking ring fully 
counterclockwise, to align the red 
marks on the locking ring and the 
viewfinder barrel.

2 Detach the eyepiece.

To reattaching the eyepiece

1 Align the red marks on the eyepiece 
locking ring and the viewfinder barrel.

2 Align the red mark on the end of the 
eyepiece end with the red marks on the 
eyepiece locking ring and the 
viewfinder barrel. Then insert the 
eyepiece into the viewfinder barrel.

3 Turn the eyepiece locking ring 
clockwise until its “LOCK” arrow 
points at the red mark on the viewfinder 
barrel.

When the eyecup is worn out, replace it with a 
new one.

For details of a replacement eyecup, contact a Sony 
service representative.

To adjust the viewfinder focus
Turn the diopter adjustment ring until the 
viewfinder image is sharpest.

To adjust the viewfinder screen
Adjust the brightness, contrast, and peaking of the 
viewfinder screen with the controls shown below.

Detaching the Eyepiece

Adjust position so that arm 
does not touch handle

1Locking ring
2Locking ring match mark
3Match mark on the viewfinder barrel

Match mark on end of eyepiece

Adjusting the Viewfinder Focus 
and Screen

Diopter adjustment ring
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When using the camcorder for the first 
time
The area of use is not factory preset. Before using 
the camcorder, you need to set this item. (You 
cannot use the camcorder without setting this 
item.)

To set the area of use

1 Set the POWER switch to the ON 
position.
The screen for setting the area of use appears 
in the viewfinder.

1PEAKING control
2CONTRAST control
3BRIGHT control

Setting the Area of Use

MENU knob

POWER switch
Setting the Area of Use
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2 Press the MENU knob.
The settings for selectable areas of use are 
displayed.

3 Turn the MENU knob to select the 
desired area of use.

a) The composite signal output from this camcorder 
is an NTSC signal with a black setup (7.5 IRE). 
The system frequency is 59.94i.

b) The composite signal output from this camcorder 
is an NTSC signal with no black setup. The 
system frequency is 59.94i.

c) The composite signal output from this camcorder 
is a PAL signal. The system frequency is 50i.

4 Set the following items.
• Time Zone
• Date/Time

See “Basic Setup Menu Operations” 
(page 109).

5 Turn the MENU knob to select 
“Finish”, then press the MENU knob.
The camcorder is now ready for use.

You can set or change the date and time of the 
internal clock. The date and time set are reflected 
in the timecode.

For menu operations, see “Basic Setup Menu 
Operations” (page 109).

1 Select MAINTENANCE >Clock Set 
>Date/Time in the setup menu.

2 Press the MENU knob.
The Date/Time setting window appears.

3 Turn the MENU knob to display the 
desired value, and press the knob.
The selection shifts to the next item on the 
right.

4 To continue the remaining settings, 
repeat step 3.

5 Making sure that “SET” is selected, 
press the MENU knob.
The internal clock is set with the date and 
time set in steps 3 and 4.

To cancel the setting
Before executing step 5, push the MENU 
CANCEL/PRST/ESCAPE switch up to the 
CANCEL/PRST side.

Setting Area of use
NTSC Area NTSC area (for areas other 

than Japan) a)

NTSC(J) Area NTSC area (Japan) b)

PAL Area PAL area c)

Setting the Date/Time of 
the Internal Clock
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Note

Always power the camcorder off before mounting or 
removing a lens.

For information about using the lens, refer to the 
operation manual for the lens.

Note

The lens is supplied separately.

1 Push the lens locking lever up and 
remove the lens mount cap from the 
lens mount.

2 Align the center pin on the lens with the 
center slot in the lens mount, and insert 
the lens into the mount.

3 Holding the lens in place, push the lens 
locking lever down to lock the lens.

Caution

If the lens is not firmly locked, it may come off 
while the camcorder is being used. This could cause 
a serious accident. Make sure the lens is firmly 
locked. It is recommended that the lens mount 
securing rubber be put on the lens locking lever as 
illustrated above.

4 Connect the lens cable to the LENS 
connector.

5 Secure the lens cable with the cable 
clamps.

If you have attached an aberration correction 
lens
The aberration correction function is activated 
automatically. Starting the camcorder with an 
aberration correction lens may require more time 
than normally because of data loading at start-up.
Contact a Sony service representative for 
information about aberration correction lenses.

If the lens does not stay in focus properly as you 
zoom from telephoto to wide angle, adjust the 
flange focal length (the distance from the plane of 
the lens mounting flange to the imaging plane). 
Make this adjustment just one time after 
mounting or changing the lens.
When carrying out the adjustment, use a flange 
focal length adjustment chart as the subject.

Notes

• If you use a subject with insufficient contrast, or move 
the camcorder or subject during adjustment, this will 
cause an adjustment error.

• Place the subject (the flange focal length adjustment 
chart) so that it appears at the center of the screen at the 
telephoto end. Arrange so that no nearby object (no 
object closer to the camera than the chart) enters the 
screen at the wide-angle end.

Mounting and Adjusting 
the Lens

Lens mount 
securing rubber

Adjusting the Flange Focal Length

About 3 m (10 ft)
Mounting and Adjusting the Lens
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Carrying out the adjustment

1 Set the iris to manual.

2 Open the iris, position the supplied 
flange focal length adjustment chart 
approximately 3 meters (10 ft) away 
from the camcorder, and arrange the 
lighting to obtain a satisfactory video 
output.

3 Loosen the fixing screws on the F.f or 
F.B ring (flange focal length adjustment 
ring).

4 Use manual or power zoom to set the 
lens to telephoto.

5 Point the camcorder at the chart by 
turning the focus ring and focus on it.

6 Set the zoom ring to wide angle.

7 Turn the F.f or F.B ring until the chart 
is in focus, being careful not to disturb 
the focus ring.

8 Repeat steps 4 to 7 until the chart stays 
in focus all the way from wide angle to 
telephoto.

9 Tighten the F.f or F.B ring fixing 
screws.

You can attach the optional ECM-680S stereo 
microphone to the microphone holder of the 
viewfinder (optional).
The following procedure is an example for 
attaching a microphone holder to the HDVF-20A.

For procedures for attaching a microphone holder  
to other viewfinders, refer to a manual supplied with 
each viewfinder.

1 Loosen the screw and open the 
microphone holder clamp.

2 Place the microphone in the 
microphone holder.

1Wind the microphone spacer around 
the microphone, while peeling off the 
protective sheets on both sides of the 
microphone spacer.

2 Place the microphone in the holder so 
that “UP” is at the top.

3 Close the microphone holder.
4 Tighten the screw.

Preparing the Audio 
Input System

Connecting a Microphone to the 
MIC IN Connector

Microphone holder clamp
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On how to perform this operation, refer to the 
operation manual for the microphone.

3 Plug the microphone cable into the MIC 
IN connector, then set the AUDIO IN 
switch for the channel on which you 
want to record the audio from this 
microphone to FRONT.

4 Secure the microphone cable with the 
cable clamp.

You can connect up to two monaural 
microphones to the AUDIO IN CH-1/CH-2 
connectors, using an optional CAC-12 
Microphone Holder.
The following is the procedure for attaching an 
electret condenser microphone such as the ECM-
674/678.

On how to attach the CAC-12, refer to the operation 
manual for the CAC-12.

1 Attach the electret condenser 
microphone.

1 Loosen the ball joint lock lever.
2Wind the microphone spacer (sheet 

type, supplied with the microphone) 
around the microphone, while peeling 
off the protective sheets on both sides 
of the microphone spacer.

3 Place the microphone in the holder so 
that “UP” is at the top.

4 Close the microphone holder.
5 Tighten the screw.
6 Position so that the microphone does 

not interfere with the viewfinder and 
tighten the ball joint lock lever.

Connecting Microphones to the 
AUDIO IN Connectors

Microphone
Preparing the Audio Input System
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2 Connect the microphone cable to the 
AUDIO IN CH-1 or CH-2 connector. 

3 Set the switches as follows.
• Set the AUDIO IN selectors indicated 

below, depending on the power supply type 
of the microphone.
Internal power supply: MIC
External power supply: +48V

• Set the AUDIO IN CH1/CH2 switch for the 
channel to which the microphone is 
connected to REAR.

4 Switch the input level to match the 
sensitivity of the microphone used.
Switch the input level by changing the setting of 
MAINTENANCE >Audio >Rear MIC CH1/
CH2 Ref in the setup menu (factory default 
setting is –60 dB). For details, see page 137.

Notes

• If the input level on the camcorder is not at an 
appropriate setting for the microphone sensitivity, loud 
sounds may be distorted, and the signal-to-noise ratio 
may be affected.

• In order for the AUDIO IN CH-1 and CH-2 connectors 
on the camcorder to be able to provide a phantom 48 V 
power supply, female XLR connectors (3-pin) are 
fitted. If the microphone cable has a female connector, 
use an adaptor.

• When you detach a CAC-12 Microphone Holder once 
you have attached to the camcorder, be careful not to 
lose the two screws fixing the CAC-12 (in step 1). 
After detaching the CAC-12, be sure to put the two 
screws back into their original places.

To use a Sony UHF wireless microphone system, 
power the camcorder off and then fit one of the 
following UHF portable tuners.
• DWR-S01D Digital Wireless Receiver
• WRR-855S UHF Synthesized Tuner Unit
• WRR-860A/861/862 UHF Synthesized 

Diversity Tuner

For details of these units, refer to the operation 
manuals for them.

Note

The optional WRR Mount Bracket (service part number: 
A-8278-057-B) is required to fit the WRR-862.

For details, contact your vendor or a Sony service 
representative

To fit the DWR-S01D or WRR-855S

1 Remove the four fixing screws holding 
the cover of the portable tuner/receiver 
housing slot located in the rear of the 
camcorder, to remove the cover.

1AUDIO IN selectors
2Monaural microphone
3AUDIO IN CH1/CH2 switches
4To AUDIO IN CH-1 or CH-2 connector

Attaching a UHF Portable Tuner 
(for a UHF Wireless Microphone 
System)
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2 Insert the DWR-S01D or WRR-855S 
into the housing slot, and fasten the four 
fixing screws.

3 Set the AUDIO IN selector for the 
channel to which you want to input 
audio signal to WIRELESS (see 
page 23).

To fit the WRR-862 (when using a BP-
GL65/GL95/L60S/L80S Battery Pack)

1 Attach the WRR tuner fitting (not 
supplied; service part number: A-8278-
057-B) to the back of the camcorder.

1 Use a Phillips type screwdriver to 
tighten the four screws placed in the 
tuner fitting. For three of these screws, 
insert the screwdriver through the 
corresponding hole and tighten the 
screw.

Note

Make sure that all four screws are fully tightened.

2 Loosen the adjustment screws on the 
tuner fitting.

3 Adjust the tuner fitting position for a 
BP-GL65/GL95/L60S/L80S Battery 
Pack to be attached, and tighten the 
adjustment screws to fix its position.

4 Attach the mount plate supplied with 
the WRR-862.

About the WRR tuner fitting (service part 
number: A-8278-057-B), contact a Sony service 
or sales representative. 

2 Attach the battery pack.

On how to attach the battery pack, see “To 
attach the battery pack” on page 35.

3 Mount the tuner on the WRR tuner 
fitting.

4 Connect the tuner power cord to the DC 
OUT connector of the camcorder, and 
the audio output cable to the AUDIO IN 
CH-1 or CH-2 connector. 

5 Set the switches as follows.
• Set the AUDIO IN selector for the channel 

to which the audio output cable is attached 
to MIC.

• Set the AUDIO IN CH1/CH2/CH3/CH4 
switch for the channel to which the audio 
output cable is connected to REAR.
If the XLR connection automatic detection 
function is on, the input signal for audio 
recording is selected automatically, and 
therefore this setting is not required.

DWR-S01D or WRR-855S

BP-GL65/GL95/L60S/L80S

Adjustment 
screws

Mount plate 
(supplied with 
WRR-862)

Phillips type 
screwdriver

WRR-862
Preparing the Audio Input System
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Connect the audio output connector of the audio 
equipment that supplies the line input signal to the 
AUDIO IN CH-1 or CH-2 connector.

Switch settings
Set the AUDIO IN selector for the channel to 
which the audio signal source is connected to 
LINE.

Selecting the audio inputs to be recorded
• With the XLR connection automatic detection 

function being off (the factory default setting): 
A signal must be selected for audio recording by 
setting the AUDIO IN CH1 or CH2 switch to 
REAR depending on which of the AUDIO IN 
CH-1 and CH-2 connectors is used for 
connecting the external audio equipment.

• With the XLR connection automatic detection 
function being on: When a cable is connected to 
the AUDIO IN CH-1 or CH-2 connector, the 
input from that connector is automatically 
selected for audio recording, regardless of the 
setting of the AUDIO IN CH1 or CH2 switch.

The XLR connection automatic detection 
function can be switched on or off by 
MAINTENANCE >Audio >Rear XLR Auto in 
the setup menu.

Connecting Line Input Audio 
Equipment

1AUDIO IN CH1/CH2 switches
2To DC OUT connector
3To AUDIO IN CH-1 or CH-2 connector
4AUDIO IN selectors

1AUDIO IN CH1/CH2 switches
2To AUDIO IN CH-1 or CH-2 connector
3Audio equipment
4AUDIO IN selectors
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1 Attach the optional VCT-14/U14 
Tripod Adaptor to the tripod.

2 Mount the camcorder on the tripod 
adaptor.

To remove the camcorder from the tripod 
adaptor
Hold down the red button and pull the lever in the 
direction of the arrow.

Note

The tripod adaptor pin may remain in the engaged 
position even after the camcorder is removed. If this 
happens, press the red button and move the lever as 
shown above until the pin returns to the stowed position. 
If the pin remains in the engaged position, you will not 
be able to mount the camcorder on the tripod adaptor.

Tripod Mounting

Tripod adaptor

Camera mount

Slide the camcorder forward along the 
groove in the adaptor until it clicks.

Red button

Lever
Tripod Mounting
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With this camcorder, you can use the Anton 
Bauer Ultralight 2 or equivalent video light 
(powered by 12 V with maximum power 
consumption of 50 W).
• If you connect the video light to the LIGHT 

connector on the camcorder and set the LIGHT 
switch to AUTO, you can turn the light on and 
off automatically as you start and stop recording 
on this camcorder.

• The output of the LIGHT connector on the 
camcorder is controlled to 12 V even when the 
camcorder is supplied with over 12 V power 
(through the DC IN connector or battery pack). 
The brightness or color temperature of the light 
will not change according to voltage increase.

Notes

• Do not use a video light with power consumption of 
over 50 W.

• The brightness or color temperature of the light will 
change when the voltage (supplied through the DC IN 
connector or from the battery pack) is under 12 V.

To attach the video light
Fit the video light to the accessory fitting shoe on 
the camcorder grip, and connect the video light 
cable to the LIGHT connector.

Note

The accessory fitting shoe on the camcorder is of the 
1/4-inch tapped hole type. If you want to replace this with 
a slide-type shoe, use the supplied cold shoe kit. On how 
to fit the cold shoe kit, refer to “Using a External Hard 
Disk” in the Supplement supplied in the CD-ROM 
(labeled “Manuals for Solid-State Memory 
Camcorder”).

To attach the shoulder strap

1 Fit one of the clips to a shoulder strap 
fitting.

2 Fit the other clip to the shoulder strap 
fitting on the other side of the grip in the 
same way as in step 1.

Connecting a Video 
Light

Using the Shoulder 
Strap

Clip

Pull up the strap to lock the fitting.
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To remove the shoulder strap

You can slide the shoulder pad back and forth 
within a 40 mm range. This adjustment helps you 
get the best balance for shooting with the 
camcorder on your shoulder.

1 Raise the lever in the center of the 
shoulder pad to unlock the shoulder 
pad.

2 Slide the shoulder pad backward or 
forward until it is in the most 
convenient position.

3 Bring down the lever to lock the 
shoulder pad in the selected position.

Press here and pull in the direction 
shown by the arrow to release.

Adjusting the Shoulder 
Pad Position

Shoulder pad
Adjusting the Shoulder Pad Position
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For menu operations, see “Basic Setup Menu Operations” (page 109).

The following recording formats can be selected for different combinations of video resolution and system 
frequency.

In UDF mode

Chapter3 Adjustments and Settings

Setting the Video Format

UDF

OPERATION >Format menu settings Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec Format System Frequency a)

HD 1080 HD422
50

59.94i HD422 1920/59.94i 1920×1080

50i HD422 1920/50i

29.97P HD422 1920/29.97P

25P HD422 1920/25P

23.98P HD422 1920/23.98P

HD420
HQ

59.94i HQ 1440/59.94i 1440×1080

50i HQ 1440/50i

29.97P HQ 1440/29.97P

25P HQ 1440/25P

23.98P HQ 1440/23.98P

720 HD422
50

59.94P HD422 1280/59.94P 1280×720

50P HD422 1280/50P

29.97P HD422 1280/29.97P

25P HD422 1280/25P

23.98P HD422 1280/23.98P

HD420
HQ

59.94P HQ 1280/59.94P

50P HQ 1280/50P

23.98P b) HQ 1280/23.98P

SD — IMX50 c) 59.94i IMX50/59.94i 720×486 

50i IMX50/50i 720×576 

29.97P d) IMX50/29.97P 720×486 

25P d) IMX50/25P 720×576 

DVCAM c) 59.94i DVCAM/59.94i 720×480

50i DVCAM/50i 720×576

29.97P d) DVCAM/29.97P 720×480

25P d) DVCAM/25P 720×576
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a) 59.94i/29.97P/59.94P/23.98P: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or 

[NTSC(J) Area]

50i/25P/50P: When OPERATION >Format >Country in the setup menu is set to [PAL Area]

b) 59.94i after 2-3 pulldown is recorded

c) When the optional CBK-MD01 is installed

d) Converted to PsF and recorded

In FAT mode

a) 59.94i/29.97P/59.94P/23.98P: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or 

[NTSC(J) Area]

50i/25P/50P: When OPERATION >Format >Country in the setup menu is set to [PAL Area]

b) 59.94i after 2-3 pulldown is recorded

c) When the optional CBK-MD01 is installed

d) Converted to PsF and recorded

FAT

OPERATION >Format menu settings Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec Format System Frequency a)

HD 1080 HQ 1920 59.94i HQ 1920/59.94i 1920×1080

50i HQ 1920/50i

29.97P HQ 1920/29.97P

25P HQ 1920/25P

23.98P HQ 1920/23.98P

HQ 1440 59.94i HQ 1440/59.94i 1440×1080

50i HQ 1440/50i

29.97P HQ 1440/29.97P

25P HQ 1440/25P

23.98P HQ 1440/23.98P

SP 1440 59.94i SP 1440/59.94i

50i SP 1440/50i

23.98P b) SP 1440/23.98P

720 HQ 1280 59.94P HQ 1280/59.94P 1280×720

50P HQ 1280/50P

29.97P HQ 1280/29.97P

25P HQ 1280/25P

23.98P HQ 1280/23.98P

SD — DVCAM c) 59.94i DVCAM/59.94i 720×480

50i DVCAM/50i 720×576

29.97P d) DVCAM/29.97P 720×480

25P d) DVCAM/25P 720×576
Setting the Video Format
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Select the recording mode between UDF and 
FAT.

1 Select OPERATION >Format >File 
System in the setup menu (see 
page 112).

2 Turn the MENU knob to select [UDF] 
or [FAT], and press the knob.
A confirmation message appears.

3 Select [Execute] to execute, or select 
[Cancel] to cancel, and then press the 
MENU knob.

4 Power the camcorder off and on again.

Refer to the above table and change the settings of 
the relevant items.

1 Select OPERATION >Format in the 
setup menu (see page 112).

2 Turn the MENU knob to select the item 
to change, and press the knob.

3 Turn the MENU knob to change the 
setting, and press the knob.
A confirmation message appears.

4 Select [Execute] to execute, or select 
[Cancel] to cancel, and then press the 
MENU knob.

5 When the setting of HD/SD or Country 
was changed, power the camcorder off 
and on again.

Selecting the Recording Mode

Changing the Video Format
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To ensure excellent image quality when using this 
camcorder, conditions may require that both the 
black balance and the white balance be adjusted.
Black balance and white balance adjustment 
values that are automatically set by the camcorder 
and the various settings are stored in the 
camcorder memory and retained even when the 
power is turned off.

Black balance adjustment
The black balance will require adjustment in the 
following cases.
• When the camcorder is used for the first time
• When the camcorder has not been used for a 

long time
• When the camcorder is used under conditions in 

which the surrounding temperature has changed 
greatly

• When the GAIN selector (L/M/H/Turbo) values 
have been changed by using OPERATION 
>Gain Switch in the setup menu.

It is not usually necessary to adjust the black 
balance when using the camcorder after it has 
been off.

White balance adjustment
Always readjust the white balance when the 
lighting conditions change.

In automatic black balance mode, adjustments are 
performed in the following order: black set and 
black balance. Manual black balance adjustment 
can be selected from the setup menu.

Automatic black balance adjustment is disabled 
in the following case.
• During recording
• In a special recording modes (Picture Cache 

Rec, Interval Rec, Frame Rec, Slow & Quick)
• When the shutter mode is SLS

1 Set the OUTPUT/DCC switch to CAM.

2 Push the AUTO W/B BAL switch to 
BLACK and release the switch.
The message “Executing...” appears during 
execution, and changes to “Done” when the 
adjustment finishes. Adjustment values are 
saved to memory automatically.

Notes

• During the black balance adjustment, the iris is 
automatically closed.

• During the black balance adjustment, the gain 
selection circuit is automatically activated so you may 
see flickering on the viewfinder screen, but this is not 
a fault.

• Output from the i.LINK connector stops temporarily if 
you execute black balance adjustment during i.LINK 
output. Output from the connector resumes when black 
balance adjustment finishes.

If automatic black balance adjustment 
cannot be made
If the black balance adjustment cannot be 
completed normally, an error message will appear 
for about three seconds on the viewfinder screen.
Possible messages are listed below.

If any of the above error messages is displayed, 
retry the black balance adjustment. 
If the error message occurs again, an internal 
check is necessary.

For information about this internal check, refer to 
the Maintenance Manual.

Note

If the lens cable is not firmly connected to the LENS 
connector, it may not be possible to adjust the lens iris. If 
this happens, the black balance will be incorrect.

Adjusting the Black 
Balance and the White 
Balance

Adjusting the Black Balance

Error message Meaning
NG: Iris Not 
Closed

The lens iris did not close; 
adjustment was impossible.

NG: Timeout Adjustment could not be 
completed within the standard 
number of attempts.

NG: Out of 
Range

The difference between the 
reference value and the current 
value is so great that it exceeds 
the range. Adjustment was 
impossible.
Adjusting the Black Balance and the White Balance
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1 Set the switches and selectors as shown 
below.
• GAIN switch: L (set to a gain value that is 

as small as possible) 
• OUTPUT/DCC switch: CAM
• WHITE BAL switch: A or B 1)

1) Adjustment values are saved to memory B only 
when OPERATION >White Setting >White 
Switch<B> in the setup menu, is set to 
[Memory]. 

2 Set the FILTER selector to suit the 
lighting conditions as follows.

3 Place a white test card under the same 
lighting conditions as for the subject to 
be shot and zoom up to it. 
Alternatively, any white object such as a 
cloth or a wall can be used.
The absolute minimum white area is as 
follows.

Note

Make sure there are not bright spots in the 
rectangle.

4 Adjust the lens iris.
Manually adjusted lens: set the iris to an 

appropriate setting.
Lens with automatic iris: set the automatic/

manual switch on the lens to automatic.

5 Push the AUTO W/B BAL switch to 
WHITE and then release the switch.
The message “Executing...” appears during 
execution, and changes to “OK: (color 
temperature of subject)” when the 
adjustment finishes.
The adjustment values are saved 
automatically in the memory selected in 
step 1 (A or B).

Note

If the camcorder has a zoom lens with an automatic 
iris, the iris may hunt 1) during the adjustment. To 
prevent this, adjust the iris gain knob (indicated as 
IG, IS, or S) on the lens.

For details, refer to the lens operation manual.

1) Hunting: Repeated brightening and darkening of 
the image, resulting from repeated response to 
automatic iris control.

If the automatic white balance adjustment 
cannot be made
If the white balance adjustment cannot be 
completed normally, an error message will appear 
for about three seconds on the viewfinder screen.
Possible messages are listed below.

If any of the above error messages is displayed, 
retry the white balance adjustment. If the error 
message occurs again, an internal check is 
necessary.

For information about this internal check, refer to 
the Maintenance Manual.

If you have no time to adjust the white 
balance
Set the WHITE BAL switch to PRST.
This makes it possible to automatically set the 
white balance to 5600K (factory default value) by 
pressing the COLOR TEMP. button.
The color temperature to which the white balance 
is set when the COLOR TEMP. button is pressed 
can be selected from among 3200K, 4300K, 
5600K, and 6300K on OPERATION 
>Assignable SW in the setup menu. You can also 
assign color temperatures to the ASSIGN. 1/3 
switches or ASSIGNABLE 4/5 switches.

Adjusting the White Balance

Rectangle centered on the screen. The 
lengths of the sides are 70% of the length 
and width of the screen.

Error message Meaning
NG: Low Light The white video level is too low. 

Either open the lens iris or 
increase the gain.

NG: Timeout Adjustment could not be 
completed within the standard 
number of attempts.

NG: High Light The white video level is too 
high. Either stop down the lens 
iris or change the ND filter.
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To change the color temperature when 
the ND filter is switched
You can assign electrical CC (color correction) 
filters to ND filters (see page 17). This allows you 
to change the color temperature automatically 
when the ND filter is switched.

1 Set MAINTENANCE >White Filter 
>ND Filter C.Temp in the setup menu 
(see page 143) to On.

2 To assign an electrical CC filter to 
FILTER selector position number 1, 
select [ND FLT C.Temp<1>]. To assign 
it to positions 2 to 4, select [ND FLT 
C.Temp<2-4>].

3 Turn the MENU knob to select the 
desired color temperature.
As you turn the MENU knob, the color 
temperature changes as follows: 3200K y 
4300K y 5600K y 6300K.

4 Repeat steps 2 and 3 as required.

To switch between electrical CC filters 
with an assignable switch
You can assign the function that switches 
between electrical CC filters to an assignable 
switch. This allows you to switch between color 
temperatures (3200K/4300K/5600K/6300K) that 
have been assigned to up to four positions (A to 
D) with each press of the assignable switch.
Regardless of assignments to assignable 
switches, you can also switch between the color 
temperatures assigned to each position from a 
RM-B150/B750 Remote Control Unit.

1 Select MAINTENANCE >White Filter 
in the setup menu (see page 143).

2 Select the position to which to assign a 
CC filter by selecting one of [Electrical 
CC<A>] to [Electrical CC <D>], and 
then turn the MENU knob to select the 
desired color temperature.
As you turn the MENU knob, the color 
temperature changes as follows: 3200K y 
4300K y 5600K y 6300K.

To set no color temperature
Select “-----” with Electrical CC<C> or <D> 
selected.
When the assignable switch is pressed, the 
setting for that position is not displayed. For 
example, if “-----” is set for one position, then 
switching between the remaining three 
positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching 
function (ELECTRICAL CC) to an 
assignable switch (see page 158).

White balance memory
Values stored in memory are held until the white 
balance is next adjusted even when the camcorder 
power is turned off.
The camcorder has two white balance memories, 
A and B. You can automatically save adjustment 
values for each ND filter in the memory that 
corresponds to the WHITE BAL switch setting 
(A or B). The camcorder has four built-in ND 
filters, allowing you to save a total of eight 
adjustment values (4 × 2). However, the contents 
of the memories are not linked to ND filter 
settings in the following cases.
• When the number of memories allocated to 

each of A and B is limited to one by setting 
OPERATION >White Setting >Filter White 
Memory in the setup menu to Off.

• When the electrical CC filter switching function 
has been assigned to an assignable switch, or 
when a remote control unit has been connected. 
(In these cases, the contents of white balance 
memory are linked to electrical CC filter 
positions (A to D).)

Also, when OPERATION >White Setting 
>White Switch<B> in the setup menu is set to 
[ATW (Auto Tracing White Balance)], and the 
WHITE BAL switch is set to B, the ATW 
function is activated to automatically adjust the 
white balance of the picture being shot for 
varying lighting conditions.
Adjusting the Black Balance and the White Balance
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The shutter modes that can be used with the 
electronic shutter and the shutter speeds that can 
be selected are listed below.

Standard mode
Select this mode for shooting fast-moving 
subjects with little blurring.
You can set the shutter speed in one of two shutter 
modes: Speed mode, in which the speed is set in 
seconds, and Angle mode, in which the speed is 
set in degrees.

Speed mode

a) This speed cannot be selected when the camcorder is 
in Slow & Quick Motion mode and OPERATION 
>Rec Function >Frame Rate in the setup menu is set 
to a value that is greater than the system frequency.

Angle mode
180°, 90°, 45°, 22.5°, and 11.25°

ECS (Extended Clear Scan) mode
Select this mode for obtaining images with no 
horizontal bands of noise when shooting subjects 
such as monitor screens.
As shown in the following tables, the range of 
shutter speeds that can be set varies depending on 
whether the Slow & Quick Motion (S&Q) 
function is on or off.

System lines: 1080

System lines: 720

SLS (slow speed shutter) mode
Select this mode for shooting subjects in low level 
lighting conditions.

Notes

• SLS mode cannot be used when the video format is SP 
1440/23.98P or when the camcorder is in Slow & 
Quick Motion mode.

• It is not possible to use SLS mode when OPERATION 
>Input/Output >i.Link I/O is set to [Enable] in the 
setup menu.

• It is not possible to output the color bar signal, turn the 
SLS mode on or off, or change the number of 
accumulated frames when the number of accumulated 
frames is set to 16. 

Notes

• When the automatic iris is used, the iris opens wider as 
the shutter speed increases, thus reducing the depth of 
field.

• The selectable shutter speeds vary depending on the 
current system frequency.

Setting the Electronic 
Shutter

Shutter Modes

System 
frequency

Shutter speed (unit: seconds)

59.94i
59.94P
50i
50P

1/60, 
1/100, 

1/120, 1/125, 1/250, 1/500, 
1/1000, 1/2000

29.97P 1/40
a), 1/50

a)
, 
1/60, 1/100, 

1/120, 1/125, 
1/250, 1/500, 1/1000, 1/2000

25P 1/33
 a), 1/50

a), 1/60, 
1/100, 1/120, 

1/125, 
1/250, 1/500, 1/1000, 1/2000

23.98P 1/32
 a), 1/48

a), 1/50
a), 1/60, 1/96, 1/100, 

1/120, 
1/125, 1/250, 1/500, 1/1000, 1/2000

System 
frequency

Shutter speed (unit: Hz)
S&Q: Off S&Q: On

59.94i 60.00 to 3800 —

50i 50.00 to 3500 —

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

System 
frequency 

Shutter speed (unit: Hz)
S&Q: Off S&Q: On

59.94P 60.07 to 4100 32.01 to 4100

50P 50.03 to 3900 32.03 to 3900

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

OPERATION >Format 
>HD System Line setting 
in the setup menu

Number of 
accumulated frames

1080 2, 3, 4, 5, 6, 7, 8, 16

720 2, 4, 6, 8, 16

Selecting the Shutter Mode and 
Shutter Speed
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To switch between Speed mode and 
Angle mode

1 Select OPEARTION >Shutter Select 
>Shutter Select in the setup menu (see 
page 124).

2 Turn the MENU knob to select Second 
or Degree, and then press the knob.

To set the shutter mode and standard-
mode shutter speed
Once the shutter speed is selected, it is retained 
even when the camcorder power is turned off.

1 Push the SHUTTER selector from ON 
to SELECT.
The current shutter setting indication appears 
for about three seconds.

2 Before the shutter setting indication 
disappears, push the SHUTTER 
selector down to SELECT again and 
repeat this until the desired mode or 
speed appears.
When all modes and speeds are displayed, 
the display changes in the following order.

 

Note

Depending on the frame rate setting (see page 83), some 
shutter speeds cannot be selected in Slow & Quick 
Motion mode. These speeds are replaced by the slowest 
selectable shutter speed.

Example: If you perform Slow & Quick Motion 
shooting when setting the frame rate to 60 and the video 
format to HQ1280/29.97P
The shutter speed is indicated as follows.

When Slow & Quick Motion mode is off
1/40t1/50t1/60t1/100t...

When Slow & Quick Motion mode is on
1/60t1/60t1/60t1/100t...

To set the shutter speed in ECS mode

1 Set the shutter mode to ECS (see the 
previous item).

2 Turn the MENU knob to select the 
desired frequency or number of frames.

To set the shutter speed in SLS mode

1 Set OPERATION >Shutter >Slow 
Shutter in the setup menu to [On] (see 
page 124).

2 Select the desired number of 
accumulated frames with 
OPERATION >Shutter >SLS Frames 
in the setup menu.

Speed Mode (with system frequency 59.94i)

ECS Mode
Setting the Electronic Shutter
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The reference value for automatic iris adjustment 
can be changed to aid the shooting of clear 
pictures of back-lit subjects, or to prevent blown-
out highlights. The reference value for the lens 
iris can be set within the following range with 
respect to the standard value.
• 0.25 to 1 (increasing by increments of 0.25): 

About 0.25 to 1 stop further open
• –0.25 to –1 (decreasing by increments of 0.25): 

About 0.25 to 1 stop further close
Also you can set the area where light detection 
occurs.

To change the reference value

1 Set OPERATION >Auto Iris >Iris 
Override in the setup menu to On (see 
page 122).

2 Set the MENU ON/OFF switch to OFF.

3 Turn the MENU knob to change the 
reference value.

Note

Be sure to confirm that the current shutter mode is 
not ECS.

An indicator of the current reference value is 
shown at the iris position indication (see 
page 34) on the viewfinder screen.

To make the iris more open
Turn the MENU knob counterclockwise as 
seen from the front of the camcorder.
Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris
Turn the MENU knob clockwise as seen 
from the front of the camcorder.
Select one of –0.25, –0.5, –0.75, or –1.

The changed reference value is retained until 
the power of the camcorder is turned off.
Even if the reference value is changed, it 
reverts to the standard value every time the 
power is turned on.

To set the automatic iris window

1 Set OPERATION >Auto Iris >Iris 
Window Indication in the setup menu to 
On.
The current automatic iris window appears 
on the viewfinder screen.
If it is not necessary to display the auto iris 
window on the screen, set to Off.

2 Turn the MENU knob to select Iris 
Window, and then press the knob.

3 Turn the MENU knob until the desired 
auto iris window appears, and then 
press the knob.

If you select “Var”, the following items 
become effective and you can set the window 
of the desired size. Set the following items 
with MAINTENANCE >Auto Iris2.

When you exit the menu, the auto iris window 
selected in step 3 appears.
Unless you need to keep this window displayed, 
set OPERATION >Auto Iris >Iris Window 
Indication in the setup menu to Off. 

To counter problems with very bright 
highlights
If the subject is too bright, the iris may close too 
much, leaving the overall image dark, or the 
highlights may be blown out. In such cases, 
setting the highlight clip function on reduces the 
luminance range, avoiding problems from the 
automatic iris correction.
Set OPERATION >Auto Iris >Clip High Light in 
the setup menu to On.

Changing the Reference 
Value for Automatic Iris 
Adjustment

Item Setting
Iris Var Width The width of the window

Iris Var Height The height of the window

Iris Var H Pos The position of the window 
in the horizontal direction

Iris Var V Pos. The position of the window 
in the vertical direction.

The shaded parts indicate the 
area where light detection
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When you set the AUDIO SELECT switch to 
AUTO, the input levels of analog audio signals 
recorded on each channel are adjusted 
automatically. You can also make manual 
adjustments.

Note

Even if you set the AUDIO SELECT switch to AUTO, 
the input levels of digital audio signals are not adjusted 
automatically.

Target audio level for manual audio level 
adjustment
Make adjustment using –20 dB as the target level.
If the audio level meter shows a maximum level 
of 0 dB, then it indicates that the input audio level 
is excessive.

1 To adjust the signal input to the AUDIO 
IN CH-1 or CH-2 connector, set the 
AUDIO IN CH1 or CH2 switch to 
REAR.
To adjust both input signals, set both 
switches to REAR.

2 Set the AUDIO SELECT switch(es) 
corresponding to the channel(s) selected 
in step 1 to MANUAL.

3 With the LEVEL knob(s) for the 
channel(s) selected in step 1, adjust so 
that the audio level meter shows up to 
–20 dB for a normal input volume. 

Correspondence between recording level 
adjustments and audio level controls
On MAINTENANCE >Audio in the setup menu, 
you can select which audio level control controls 
the audio recording level of the input to each of 
the AUDIO IN CH-1/CH-2 connectors. The 
correspondences between the settings of the menu 
items and the controls are as follows.

Rear1/WRR Level: Channel 1 recording level

Rear2/WRR Level: Channel 2 recording level

Note

When you have operation of the LEVEL (CH1/CH2) 
knobs and MIC LEVEL control linked together, if the 
MIC LEVEL control is set to 0, the audio signals on 
channels 1 and 2 cannot be recorded. Check the position 
of the MIC LEVEL control before adjusting the LEVEL 
(CH1/CH2) knobs.

1 Set either or both of the AUDIO IN 
switch(es) to FRONT.

Adjusting the Audio 
Level

Manually Adjusting the Audio 
Levels of the Audio Inputs from 
the AUDIO IN CH-1/CH-2 
Connectors

Target input level

Excessive input level

Setting Knob
Side1 LEVEL (CH1) knob

Front MIC LEVEL control

Front+Side1 LEVEL (CH1) knob and MIC 
LEVEL control (linked 
operation) 

Setting Knob
Side2 LEVEL (CH2) knob

Front MIC LEVEL control

Front+Side2 LEVEL (CH2) knob and MIC 
LEVEL control (linked 
operation)

Manually Adjusting the Audio 
Level of the MIC IN Connector
Adjusting the Audio Level
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2 Set the AUDIO SELECT switch(es) for 
the desired channel(s) selected in step 1 
to MANUAL.

3 Turn the MIC LEVEL control, and 
adjust so that the audio level meter 
shows up to –20 dB for a normal input 
volume.

Correspondence between recording level 
adjustments and audio level controls
On MAINTENANCE >Audio in the setup menu, 
you can select which audio level control controls 
the audio recording level of the front microphone 
input. The correspondences between the settings 
of the menu items and the controls are as follows.

MIC CH1 Level: Channel 1 recording level

MIC CH2 Level: Channel 2 recording level

Note

When you have operation of the MIC LEVEL control 
and LEVEL (CH1/CH2) knobs linked together, if the 
LEVEL (CH1/CH2) knobs are set to 0, the audio signals 
on channels 1 and 2 cannot be recorded. Check the 
position of the LEVEL (CH1/CH2) knobs before 
adjusting the MIC LEVEL control.

Selecting the recorded audio
You can select the audio recorded on audio 
channels 3 and 4 with the AUDIO IN CH3/CH4 
switches.

You can have the selection made automatically, 
as follows.

To automatically select the same audio as on 
channels 1 and 2
Set MAINTENANCE >Audio >Audio CH3/4 
Mode of the setup menu to [Ch1/2].

Adjusting the audio recording levels

To adjust automatically
Set the AUDIO SELECT CH 3-4 switch to 
AUTO.

To adjust manually

1 Set the AUDIO SELECT CH 3-4 switch 
to MANUAL.

2 Select the knobs that adjust the audio 
levels with the Audio CH3 Level and 
Audio CH4 Level items under 
MAINTENANCE >Audio in the setup 
menu.

Audio CH3 Level: Channel 3 recording 
level

Audio CH4 Level: Channel 4 recording 
level

Setting Knob
Side1 LEVEL (CH1) knob

Front MIC LEVEL control

Front+Side1 LEVEL (CH1) knob and MIC 
LEVEL control (linked 
operation)

Setting Knob
Side2 LEVEL (CH2) knob

Front MIC LEVEL control

Front+Side2 LEVEL (CH2) knob and MIC 
LEVEL control (linked 
operation)

Recording Audio on Channels 3 
and 4

CH3 switch Channel 3 recording target
FRONT Front microphone audio

REAR Audio signal input to AUDIO IN 
CH1 connector

WIRELESS Wireless microphone audio

CH4 switch Channel 4 recording target
FRONT Front microphone audio

REAR Audio signal input to AUDIO IN 
CH2 connector

WIRELESS Wireless microphone audio

Setting Knob
Side3 LEVEL (CH3) knob

Front MIC LEVEL control

Front+Side3 LEVEL (CH3) knob and 
MIC LEVEL control (linked 
operation)

Setting Knob
Side4 LEVEL (CH4) knob

Front MIC LEVEL control
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You can now adjust the levels of audio 
channels 3 and 4 with the knobs selected 
here.

Note

When picture cache mode is enabled, it is not possible to 
set time data, even if you set the F-RUN/SET/R-RUN 
switch to SET. If you want to set time data, first exit 
picture cache mode.

The timecode setting range is from 00 : 00 : 00 : 
00 to 23 : 59 : 59 : 29 (hours : minutes : seconds : 
frames).

1 Press the DISP SEL/EXPAND button to 
switch the display in the LCD monitor 
to status display.

2 Set the DISPLAY switch to TC.

3 Set the PRESET/REGEN/CLOCK 
switch to PRESET.

4 Set the F-RUN/SET/R-RUN switch to 
SET.
The first (leftmost) digit of timecode flashes.

5 Use the up and down arrow buttons to 
change values, and use the left and right 
arrow buttons to move the flashing 
digit. Repeat until all digits are set.

To reset the timecode value to 00:00:00:00
Press the RESET/RETURN button.

6 Set the F-RUN/SET/R-RUN switch to 
F-RUN or R-RUN.
F-RUN: Free run. The timecode generator 

keeps running.
R-RUN: Recording run. The timecode 

generator runs only while recording.

To set the drop frame mode/non-drop frame 
mode
You can select the drop frame (DF) mode or non-
drop frame (NDF) mode on MAINTENANCE 
>Timecode in the setup menu.

Front+Side4 LEVEL (CH4) knob and 
MIC LEVEL control (linked 
operation)

Setting Knob

Setting the Time Data

Setting the Timecode
Setting the Time Data
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To make the timecode consecutive
When the F-RUN/SET/R-RUN switch is set to 
R-RUN, recording a number of scenes on the 
media normally produces consecutive timecode. 
However, once you remove the media and record 
on another media, the timecode will no longer be 
consecutive when you use the original media 
again for recording. In this case, to make the 
timecode consecutive, set the PRESET/REGEN/
CLOCK switch to REGEN. 

Saving the real Time in the Timecode
Setting the PRESET/REGEN/CLOCK switch to 
CLOCK saves the real time in the timecode.
When it is necessary to set the actual time, use 
MAINTENANCE >Clock Set >Date/Time in the 
setup menu.

For details, see “Setting the Date/Time of the 
Internal Clock” (page 41).

By setting the user bits (up to 8 hexadecimal 
digits), you can record user information such as 
the date, time, or scene number on the timecode 
track.

1 Press the DISP SEL/EXPAND button to 
switch the display in the LCD monitor 
to status display.

2 Set the DISPLAY switch to U-BIT.

3 Set the F-RUN/SET/R-RUN switch to 
SET.
The first (leftmost) digit flashes.

4 Use the up and down arrow buttons to 
change values, and use the left and right 
arrow buttons to move the flashing 
digit. Repeat until all digits are set.

To reset the user bit data to 00 00 00 00
Press the RESET/RETURN button.

5 Set the F-RUN/SET/R-RUN switch to 
F-RUN or R-RUN, corresponding to the 
desired operating mode for the 
timecode generator.

To store the user bit setting in memory
The user bit setting (apart from the real time) is 
automatically retained in memory even when the 
power is turned off.

You can synchronize the internal timecode 
generator of this camcorder with an external 
generator for the regeneration of an external 
timecode. You can also synchronize the timecode 
generators of other camcorders/VTRs with the 
internal generator of this camcorder.

Connections for timecode 
synchronization
Connect both the reference video signal and the 
external timecode as illustrated below.

Example 1: Synchronizing with an external 
timecode

Setting the User Bits

Synchronizing the Timecode

External timecode

1GENLOCK IN connector
2TC IN connector

Reference video signal
Setting the Time Data 63Download from Www.Somanuals.com. All Manuals Search And Download.



64

C
hapter 3  A

djustm
ents and S

ettings
Example 2: Interconnecting a number of 
camcorders (including one reference 
camcorder) 

To lock the timecode to an external 
source

1 Turn on the POWER switch.

2 Set the PRESET/REGEN/CLOCK 
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to 
F-RUN.

4 Set the DISPLAY switch to TC.

5 Supply a timecode signal and a 
reference video signal complying with 
the SMPTE standard and in proper 
phase relationship, to the TC IN 
connector and to the GENLOCK IN 
connector, respectively.

This operation synchronizes the internal 
timecode generator with the external 
timecode. After about 10 seconds, you can 
disconnect the external timecode without 
losing the synchronization.

Notes

• When you finish the above procedure, the internal 
timecode is immediately synchronized with the 
external timecode and the counter display will show 
the value of the external timecode. However, wait for 
a few seconds until the sync generator stabilizes before 
recording.

• If the frequency of the reference video signal is not the 
same as the system frequency of the camcorder, the 
camcorder cannot be correctly genlocked. In such a 
case, the internal timecode is not correctly 
synchronized with the external timecode.

User bit settings during timecode 
synchronization
When the timecode is synchronized, only the time 
data is synchronized with the external timecode 
value.

To release the timecode synchronization
First disconnect the external timecode, then set 
the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery 
pack to an external power supply during 
timecode synchronization
To maintain a continuous power supply, connect 
the external power supply to the DC IN connector 
before removing the battery pack. You may lose 
timecode synchronization if you remove the 
battery pack first.

Camcorder synchronization during timecode 
synchronization
During timecode synchronization, the camcorder 
is genlocked to the reference video signal input 
from the GENLOCK IN connector.

1VIDEO OUT connector
2TC OUT connector
3TC IN connector
4GENLOCK IN connector

To another camcorder to be synchronized
Setting the Time Data
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While color bars are output, shot data can be 
displayed.

You can select which shot data is superimposed 
on the color bars with OPEARTION >Shot 
Display in the setup menu.

Shot Date
To superimpose the shot date, turn the MENU 
knob to set Shot Date to [On] and press the knob.

Shot Time
To superimpose the shot time, turn the MENU 
knob to set Shot Time to [On] and press the knob.

Shot Model Name
To superimpose the model name, turn the MENU 
knob to set Shot Model Name to [On] and press 
the knob.

Shot Serial Number
To superimpose the serial number, turn the 
MENU knob to set Shot Serial Number to [On] 
and press the knob.

Shot ID Select
To superimpose a shot ID created arbitrarily, turn 
the MENU knob to set Shot ID Select to one of 
[ID-1] to [ID-4] and press the knob.
To create a shot ID, see the next sexton “Creating 
a Shot ID”.

Up to four shot IDs of up to 16 characters can be 
created.

To create a shot ID

1 With OPEARTION >Shot ID in the 
setup menu, turn the MENU knob to 
select a shot ID to create (ID-1 to ID-4) 
and press the knob.

The shot ID setting screen appears.

2 Follow the procedure in “To enter text ” 
(page 110) to create a shot ID.

Setting Shot Data

Creating a Shot ID

Example display of shot data
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The status screens allow you to check camcorder 
settings and various types of status information.
There are five status screens, listed below.

To display status screens
With no menu is displayed, press the MENU 
CANCEL/PRST/ESCAPE switch up to the 
CANCEL/PRST side. Each push selects the next 
status screen, in the order given in the table 
above. 

CAMERA status screen
This screen displays settings and status 
information related to shooting.

White Bal: White balance status 
Gain: GAIN switch status 
Zoom Speed: Zoom speed set with the lens 

ZOOM button
Zebra: Zebra status 
Skin Detail: Skin details status 

AUDIO status screen
This screen displays settings and status 
information related to audio input and output.

CH-1/CH-2/CH-3/CH-4: Audio level meters 
and input sources 

Wind Filter: Wind filter settings

VIDEO status screen
This screen displays settings and status 
information related to recording and playback.

Video Format: Video format
Rec Mode: Recording bit rate (HD mode only) 
Output&i.LINK: Output&i.LINK setting and 

i.LINK usage status
SDI Output: HD/SD SDI OUT connector output 

setting 
Down Converter: SD output down converter 

setting (HD mode only)

ASSIGN SWITCH status screen
This screen displays the names of the functions 
assigned to assignable switches

Checking Camcorder 
Settings and Status 
Information (Status 
Screens)

Status screen Information displayed
CAMERA status Settings and status information 

related to shooting

AUDIO status Settings and status information 
related to audio input and 
output

VIDEO status Settings and status information 
related to recording and 
playback 

ASSIGN 
SWITCH status

Names of functions assigned 
to assignable switches

BATTERY/
MEDIA status

Status of the battery mounted 
on the camcorder and the 
media status
Checking Camcorder Settings and Status Information (Status Screens)
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BATTERY/MEDIA status screen
This screen displays the status of the battery 
mounted on the camcorder and the media status.

Battery: The remaining battery capacity 
Charge Count: The number of times the battery 

has been charged 
HDD A/HDD B: Remaining battery capacity of 

PHU-120R (in FAT mode)
Media A/Media B: 

• Remaining capacity of media
• Recordable time
• Approximate writable lifetime (Life)

“Life 100%” is shown for unused media.
Checking Camcorder Settings and Status Information (Status Screens) 67Download from Www.Somanuals.com. All Manuals Search And Download.
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This camcorder records video and audio on SxS 
memory cards (not supplied) loaded into one or 
both of its memory card slots.

The PHU-120R Professional Harddisk Unit or 
MEAD-MS01/SD01 Media Adaptor can also be 
used for recording (when the recording mode is 
FAT). For details, refer to the Supplement 
supplied in the CD-ROM (labeled “Manuals for 
Solid-State Memory Camcorder”).

SxS memory cards that can be used with 
this camcorder
Use the following Sony SxS memory cards (SxS 
PRO or SxS-1) with this camcorder.

SxS PRO
• SBP-16 (16 GB)
• SBP-32 (32 GB)

SxS-1
• SBS-32G1A (32 GB)
• SBS-64G1A (64 GB)

Proper operation cannot be guaranteed when 
memory cards other than SxS PRO and SxS-1 are 
used.

The memory cards listed above comply with the 
ExpressCard memory card standard.
• SxS, SxS PRO and SxS-1 are trademarks of 

Sony Corporation.
• The ExpressCard label and logo are property of 

the Personal Computer Memory Card 
International Association (PCMCIA) and are 
licensed to Sony Corporation. Other trademarks 
and trade names are the property of their 
respective owners.

Notes on the use of SxS memory cards
• Recorded data may be lost or corrupted in the 

following cases.
- When the camcorder is subjected to shock or 

vibrations during reading, writing, or 
formatting of an SxS memory card, and when 
the camcorder is powered off or an SxS 
memory card is removed during reading, 
writing, or formatting

- When the camcorder is used in an 
environment subject to static electricity or 
electric noise

• Do not use or store SxS memory cards in 
locations that are:
- Outside the specified environmental ranges
- Very hot, such in as vehicles parked in the sun 

during summer, or exposed to direct sunlight, 
or near heaters

- Subject to high humidity and corrosion
• When inserting a memory card, insert with the 

label side facing the correct direction.
• Carry and store SxS memory cards in their 

cases, and lock the cases securely.

• To use SxS-1 memory card “SBS-32G1” in 
UDF mode, the software may need to be 
updated. For details, access the Sony website 
closest to your area. (Refer to the top page of the 
CD-ROM Manual on the supplied CD-ROM.)

• Guard against accidents and inadvertent data 
loss by backing up the data stored on SxS 
memory cards. Sony cannot be responsible for 
any consequences of damage to or loss of data 
stored on SxS memory cards.

• Do not attach anything other than the supplied 
labels in the designated label space. When 
attaching a label, make sure it does not protrude 
beyond the label space.

Chapter4 Shooting

Handling SxS Memory 
Cards

About SxS Memory Cards
Handling SxS Memory Cards
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• Use this camcorder to format SxS memory 
cards that will be used with this camcorder. 
When memory cards are formatted on another 
unit, the format is regarded as an invalid format, 
making it necessary to format the memory cards 
again. 
However, note that the format and delete 
functions of this camcorder do not completely 
remove data from memory cards. Before 
discarding or disposing of a memory card, erase 
it using commercial data erasure software, or 
physically destroy it. Sony cannot be 
responsible for any failure to erase data 
completely.

• Clip operations may not be possible when the 
remaining capacity of the media is low. In this 
case, use a computer to delete unneeded files 
and try again.

• Open the memory card case completely before 
storing a card in the case or removing a card 
from the case.

Preventing accidental erasure
You can prevent accidental recording, editing, 
and deletion of data on an SxS memory card by 
setting the write protect switch to the WP side.

Note

Do not touch the write protect switch while an SxS 
memory card is loaded in a card slot. Eject the card 
before setting the write protect switch.

To load SxS memory cards

1 Slide the cover to the left to open.

2 Insert an SxS memory card into a card 
slot.

The ACCESS lamp lights in orange, and then 
lights in green to indicate that the memory 
card is usable.

3 Close the cover.

ACCESS lamp status indications
Card slots A and B each have an ACCESS lamp 
to indicate the slot status.

SxS PRO   8
GB

Label space

Write protect switch

Loading and Ejecting SxS Memory 
Cards

Lamp Slot status
Lights in orange Accessing the SxS memory card 

(lights during data reading and 
writing)

Lights in green Standby (the loaded SxS 
memory card is ready for 
recording or playback)

Not lit • No SxS memory card is 
loaded.

• An unusable card is loaded.
• An SxS memory card is 

loaded, but the other slot is 
selected. 

Insert with the label 
side facing right.
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To eject SxS memory cards

1 Open the cover, and then press the 
EJECT button to release the lock and 
pull the button out.

2 Press the EJECT button again to eject 
the card.

Note

Data integrity cannot be guaranteed if you power the 
camcorder off or remove a memory card while the card 
is being accessed. Doing so may corrupt all data recorded 
on the card. Always make sure that the ACCESS lamp is 
lit green or not lit before you power the camcorder off or 
remove a memory card.

When SxS memory cards are loaded in both slot 
A and slot B, you can press the SLOT SELECT 
button to select the SxS memory card to use.

The camcorder switches automatically to the 
other card if the selected card becomes full during 
recording.

Note

The SLOT SELECT button is disabled during playback. 
Even when pressed, it does not change the selected slot. 
Button operations are enabled when a thumbnail screen 
(see page 91) is displayed.

When you load an unformatted memory card, 
load a memory card that has been formatted to 
other specifications, or load a memory card that 
has been formatted in UDF mode into the 
camcorder set to FAT mode, a message to 
confirm if formatting is to be executed appears in 
the viewfinder (see page 71). In this case, format 
the memory card in the following way.
SxS memory cards are formatted in FAT mode as 
factory default.

Note

SxS memory cards must be formatted on an 
XDCAM EX device or on this camcorder. Cards 
in other formats cannot be used.

To format (initialize) a memory card
If the message for formatting is displayed, turn 
the MENU knob to select “Execute”, and then 
press the knob.
Execution of the format starts.

During execution of the format, a progress 
indication appears (%), and the ACCESS lamp 
lights in orange.
When formatting is completed, the completion 
message is displayed for three seconds.

Recording and playback during format execution
Even during execution of a format, recording and 
playback are possible using an SxS memory card 
loaded into the other card slot.

If the format operation fails
A format operation may fail because the SxS 
memory card is write protected, or because it is 
not the type of card specified for use with this 
camcorder.

Selecting the SxS Memory Card to 
Use

Press the button once 
to release the lock.

Formatting (Initializing) SxS 
Memory Cards
Handling SxS Memory Cards
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In this case, an error message appears. Following 
the instructions in the error message and 
exchange the card for an SxS memory card that 
can be used with this camcorder.

To format by menu operation
When no formatting message is displayed, you 
can execute formatting by menu operation.

1 Select OPERATION >Format Media in 
the setup menu (see page 113).

2 Select [Media(A)] (slot A) or [Media(B)] 
(slot B).

3 Turn the MENU knob to select 
[Execute], and then press the knob.
The confirmation message for formatting is 
displayed on the viewfinder screen.

4 Turn the MENU knob to select 
“Execute”, and press the knob.
Execution of the format starts.

During execution of the format, a progress 
indication appears (%), and the ACCESS lamp 
lights in orange.
When formatting is completed, the completion 
message is displayed for three seconds.

Notes

• All data is erased when you format a memory card, 
including setup files and all of the recorded video data.

• Use the format function of this camcorder to format 
SxS memory cards for use on this camcorder. The 
formats of cards formatted on other devices are not 
recognized as valid formats, making it necessary to 
format them again on this camcorder.

An error message or a message to confirm if 
formatting is to be executed appears.

Cases in which an error message appears
The message “Cannot Use Media(A)/
Unsupported File System” appears in the 
viewfinder in the following cases.

• An SxS memory card which was used for 
recording in UDF mode is loaded into the 
camcorder set to FAT mode. 

• An SxS memory card which was used for 
recording in FAT mode is loaded into the 
camcorder set to UDF mode. 

• An SxS memory card which was formatted in 
FAT mode is loaded into the camcorder set to 
UDF mode. 

Cases in which a message to confirm if 
formatting is to be executed appears
When an SxS memory card which was formatted 
in UDF mode is loaded into the camcorder set to 
FAT mode. a message to confirm if formatting is 
to be executed in FAT mode appears in the 
viewfinder (see page 70).

You can check the remaining capacity of the SxS 
memory cards loaded in the two slots by checking 
the recording media remaining capacity display 
in the viewfinder.

The camcorder calculates the remaining 
recording time for the media in each slot on the 
basis of the current video format (recording bit 
rate), and displays it in units of minutes.
You can also check the remaining time in the 
BATTERY/MEDIA status screen (see page 67).

Note

The  mark appears when a memory card is write 
protected.

When to exchange SxS memory cards
• The warning message “Media Near Full” 

appears, the WARNING indicator and the REC 
indication on the viewfinder screen flash, and 
the buzzer sounds when the total remaining 
recording time of the two memory cards falls to 
five minutes during recording.
Exchange one of the cards for media with 
available recording capacity.

If You Load a Memory Card 
Formatted in the Different 
Recording Mode from the Mode 
Selected on the Camcorder

Checking the Remaining 
Recording Time
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• If you continue recording, the message “Media 
Full” appears and recording stops when the total 
remaining recording time falls to 0.

Note

About up to 600 clips can be recorded on one SxS 
memory card.
The display of remaining recording time changes to “0” 
and the message “Media Full” appears when the clip 
limit is reached.

If for any reason an error should occur in a 
memory card, the card must be restored before 
use.
When you load an SxS memory card that needs to 
be restored, a message appears in the viewfinder 
to ask whether you want to restore it.

To restore a card
Turn the MENU knob to select [Execute], and 
then press the knob.
The restoration starts.
During the restoration, a execution message 
appears, the progress is displayed (%), and the 
ACCESS lamp lights in orange.
When the restoration finishes, a completion 
message is displayed for three seconds.

If restoration fails
• Write protected SxS memory cards and cards on 

which memory errors have occurred cannot be 
restored. A warning message appears for such 
cards. Follow the instructions in the message 
and unprotect the card or replace it with another 
card.

• SxS memory cards on which memory errors 
have occurred may become usable if they are 
reformatted.

• In some cases, some clips can be restored while 
others cannot. The restored clips can be played 
normally.

• If the message “Could not Restore Some Clips” 
keeps appearing after repeated attempts at 
restoration, it may be possible to restore the SxS 
memory card with the following procedure.

1 Use the camcorder’s copy function (see 
page 102) or the supplied application 
software (see page 170) to copy the 
required clips to another SxS memory card.

2 Format the unusable SxS memory card on 
the camcorder.

3 Copy the required clips back to the newly 
formatted SxS memory card.

Recording and playback during restoration
Even while restoration is in progress, you can 
record and play an SxS memory card in the other 
card slot.

Note

For restoration of media recorded with this camcorder, 
be sure to use this camcorder. Media recorded with a 
device other than this camcorder or with another 
camcorder of different version (even of the same model) 
may not be restored using this camcorder.

Restoring SxS Memory Cards
Handling SxS Memory Cards
Download from Www.Somanuals.com. All Manuals Search And Download.



C
hapter 4  S

hooting
In UDF mode, you can connect a USB flash drive 
connected to the external device to record, save 
and load the following data.
• Record proxy data (see page 85)
• Load planning metadata (see page 87)
• Save and load setting data (see page 160)

The following Sony USB flash drives are 
recommended for use with this camcorder.

Pocket Bit L Series
• USM16GL
• USM8GL
• USM4GL

Pocket Bit Hi-Speed LX Series
• USM32GLX
• USM16GLX
• USM8GLX
• USM4GLX (available in Japan only)

Notes

• Use USB flash drives with capacity from 4 GB to 32 
GB.

• USB flash drives other than the recommended flash 
drives listed above may not be recognized when 
connected to the USB connector.

USB flash drives must be formatted with the 
FAT32 file system. 

Note

Before using a drive, format it on this camcorder or a PC. 
If a drive formatted on a PC cannot be used, format it on 
the camcorder.

1 Connect a USB flash drive to the 
external device connector. 
When the drive is unformatted or has been 
formatted to other specifications, a message 
to confirm if formatting is to be executed 
appears on the viewfinder screen. 

2 Turn the MENU knob to select 
“Execute” and press the knob.
When formatting is completed, the message 
“Format USB Memory Done” is displayed.
The \MSSONY\PRO\XDCAM\MEMDISC 
folder and the \General\Sony\Planning folder 
are automatically created in the drive. 

If the format operation fails
A format operation may fail because the USB 
flash drive is write protected, or because it is not 
the type of drive specified for use with this 
camcorder.
In this case, an error message appears. Following 
the instructions in the error message and 
exchange the drive for one that can be used with 
this camcorder.

To format by menu operation
When no formatting message is displayed, you 
can execute formatting by menu operation.

1 Connect a USB flash drive to the 
external device connector. 

2 Select OPERATION >USB > Format 
USB Memory in the setup menu.

3 Turn the MENU knob to select 
[Execute], and then press the knob.
The confirmation message for formatting is 
displayed on the viewfinder screen. 

4 Turn the MENU knob to select 
“Execute” and press the knob.
A progress indication appears (%), and 
execution of the format starts.
When formatting is completed, the message 
“Format USB Memory Done” is displayed.
The \MSSONY\PRO\XDCAM\MEMDISC 
folder and the \General\Sony\Planning folder 
are automatically created in the drive.

Notes

• All data is erased when you format a USB flash drive, 
including setup files and all of the recorded video data.

• Use the format function of this camcorder to format 
USB flash drives for use on this camcorder. The 
formats of drives formatted on other devices are not 
recognized as valid formats, making it necessary to 
format them again on this camcorder.

Handling USB Flash 
Drives

UDF

Formatting (Initializing) USB 
Flash Drives
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When you load a USB flash drive that can be 
mounted normally because the file system is 
destroyed, a message appears on the viewfinder 
screen to ask whether you want to restore it.
Pressing the MENU knob after turning the 
MENU knob to select “Execute” starts execution 
of the format and a progress indication appears 
(%).
When formatting is completed, the message 
“Format USB Memory Done” is displayed.

This section explains the basic shooting and 
recording procedures.
Before starting to shoot, inspect the camera 
system to verify that it is operating properly.

1 Attach a fully charged battery pack (see 
page 35).

2 Select the recording mode (see page 53).

3 Load one or two SxS memory cards (see 
page 69).
If you load two cards, the camcorder 
switches automatically to the second card 
when the first card becomes full.

4 Set the camcorder’s POWER switch 
(see page 15) to ON.

5 Make the following settings.
Marker display: On (see page 118)
Iris: Auto (see page 59)
Zoom: Auto
Camera output: Select the picture currently 

being shot (camera picture), and turn the 
DCC function on (see page 19).

Timecode advance mode: F-RUN (Free 
Run) or R-RUN (Rec Run) (see page 62)

Audio input channel selection: Auto (see 
page 26)

6 Push the AUTO W/B BAL switch to the 
BLACK side to adjust the black balance 
(see page 54).

7 Select a filter according to the lighting 
conditions, and adjust the white balance 
(see page 55).

8 Point the camcorder at the subject, and 
adjust the focus and zoom.

9 If you are using the electronic shutter, 
select an appropriate shutter mode and 
speed (see page 57).

Restoring USB Flash Drives Basic Operations
Basic Operations
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10 Do one of the following to start 
recording.
- Press the REC START button (see 

page 17).
- Press the VTR button on the lens.
- Turn on the assignable switch to which the 

Rec function has been assigned (see 
page 156).

During recording, the TALLY indicators, the 
tally indicator on the front panel of the 
viewfinder, and the REC indication on the 
viewfinder screen light. Adjust the zoom and 
focus as required.

Notes

• Never remove the battery pack while the 
camcorder is recording (while the ACCESS lamp 
on the right-side panel is lit in blue and the 
ACCESS lamp in the card slot section is lit in 
orange). Doing so risks the loss of several 
seconds of data before the recording was 
interrupted, because internal processing will not 
end normally.

• The playback control buttons (EJECT, F REV, F 
FWD, NEXT, PREV, PLAY/PAUSE, STOP) do 
not function during recording.

11 To stop recording, perform one of the 
operations listed in step 10.
The TALLY indicators, the tally indicator on 
the front panel of the viewfinder, and the 
REC indication on the viewfinder screen go 
out, and camcorder enters recording standby 
(STBY) mode.
A clip is created from the video and audio 
data and the metadata recorded between steps 
10 and 11.

Note

When the recording mode is UDF, if you stop 
recording within two seconds of starting, recording 
continues and this results in a two-second clip.

To check the recording (recording review)
With the camcorder in recording standby 
(STBY) mode, turn on the assignable switch 
to which the Rec Review function or the 
Freeze Mix function has been assigned (see 
page 155).
The camcorder plays the entire last clip, or 
the last few seconds of that clip (three 
seconds or 10 seconds), and then returns to 
standby mode.

You can use MAINTENANCE >Camera 
Config >Rec Review in the setup menu (see 
page 142) to change the playback time.
When the Rec Review function is assigned to 
the RET button on the lens, you can also 
conduct a review by using the RET button.

12 Repeat steps 10 and 11 to continue 
recording.
With each repetition, another clip is created 
on the memory card.

Notes

• You cannot resume recording for about one second 
after stopping recording.

• The maximum number of clips that can be recorded on 
one memory card is 600. Even if the memory card has 
enough free capacity to record more clips, when 600 
clips have been recorded, no further recording is 
possible.

Clip file sizes
Clip file sizes vary according to file formats. 

If you continue recording for an extended period, 
recorded materials may be segmented into 
multiple files, depending on the file size (the 
maximum number of partitions is 99). 
The camcorder regards continuous recording as 
one clip even if it has been segmented into 
multiple files.

Clip names
Eight-character clips names (consisting of a four-
character prefix and a four-digit number) are 
generated automatically for clips recorded by this 
camcorder.
Example: ABCD0001
You can also use OPERATION >Clip >Title 
Prefix (see page 126) in the setup menu to set the 
clip name prefix to a user-specified string of 
characters (four to 46 characters in length). (A 

File 
format

File size Clip size

MP4 Less than 4 GB Less than half an 
hour

AVI Less than 2 GB Less than 9 minutes 
and 30 seconds

MXF Less than 43 GB Less than 6 hours

Clip 1 Clip 2 Clip 3
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user-specified prefix cannot be changed after 
recording.)
The four-digit number at the end of clip names is 
generated automatically, counting up in order as 
clips are recorded.

When the camcorder is in standby (STBY) mode, 
you can play all or part of the most recently 
recorded clip (see page 75).

1 Insert the SxS memory card to play (see 
page 69).

2 Press the PREV button (see page 21) or 
the F REV button (see page 21) to cue 
up the clip to play.

3 Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator lights, and the 
playback picture appears in the viewfinder.

To pause the playback
Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator flashes during 
pause.
Press the button again to return to playback mode.

To play at high speed
Press the F FWD button (see page 21) or the 
F REV button (see page 21).
To return to normal playback, press the PLAY/
PAUSE button.

To switch between memory cards
When two memory cards are loaded, press the 
SLOT SELECT button (see page 25) to select the 
active slot.
It is not possible to switch between memory cards 
during playback.

To end playback
Press the STOP button: Playback stops, and the 

camcorder enters E-E mode.
Press the THUMBNAIL button: Playback 

stops, and a thumbnail screen (see page 91) 
appears in the viewfinder.

Playback also stops and the timecode screen 
appears in the viewfinder when you start 
recording during playback, and when you eject an 
SxS memory card.

To display the camera picture during play 
(Live & Play function)
Live & Play is a function that allows you to 
display the camera picture (live video) on the 
viewfinder screen during play. 
This allows you to frame the next scene or adjust 
the focus and exposure while checking the 
camera picture (live video) on the viewfinder 
screen. To frame the next scene, you can use this 
function together with the Freeze Mix function 
(see page 84).
The Live & Play function is enabled when the 
camcorder is set up as follows.

To use the Live & Play function, set 
OPERATION >Output >Live&Play in the setup 
menu to [On].

Notes

• The Live & Play function cannot be turned on and off 
during playback or during thumbnail display.

• The Live & Play function cannot be used in Frame 
Rec, Interval Rec, and Slow & Quick Motion modes, 
and when the Slow Shutter function is enabled. 

• To use the Live & Play function together with the 
Freeze Mix function, start by operating while viewing 
the LCD monitor (with the DISP SEL/EXPAND 
button pressed to set the display mode other than 
STATUS). When the operation finishes and the Freeze 
Mix function is activated, the same picture appears on 
the viewfinder screen.

• The play picture cannot be switched to the camera 
picture when playing a clip that was recorded with a 
number of system lines or a system frequency that 
differs from the current settings of this camcorder.

• The output from the HD/SD SDI OUT connector and 
the VIDEO OUT connector may freeze momentarily 
when the output is switched between the play picture 
and the camera picture.

Playing Recorded Clips

HD/SD Number of system 
lines

System frequency

HD 1080 1920/59.94i

1920/50i

1440/59.94i

1440/50i

720 1280/59.94P

1280/50P

SD – 59.94i

50i

59.94i

50i
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You can use the assignable switches to delete the 
last recorded clips (Last Clip DEL function).

You can also use the THUMBNAIL menu to delete all 
recorded clips (All Clips DEL function) or to delete 
selected clips. For details, see “Deleting Clips” 
(page 103).

1 Turn on the assignable switch to which 
the Last Clip DEL function has been 
assigned (see page 156).
A confirmation message appears.

2 Turn the MENU knob to select 
[Execute], and then press the knob. 

On this camcorder, two types of shot marks are 
available in HD mode. You can record them at 
user-specified positions to make it easier for 
editors to cue up those positions. 
The maximum numbers of shot marks per clip 
vary according to file formats.

Note

Shot marks cannot be recorded in SD mode.

You can also use the THUMBNAIL menu to add and 
delete shot marks in clips. For details, see “Adding 
and Deleting Shot Marks” (page 106).

To record shot marks
Do one of the following.
• Turn on an assignable switch to which Shot 

Mark 1 or Shot Mark 2 has been assigned (see 
page 155). 

• If Lens RET has been assigned to the RET 
button on the lens, operate as follows.
To record shot mark 1: Press the RET button 

once.
To record shot mark 2: Press the RET button 

twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1” or 
“Shot Mark 2” indication appears in the 
viewfinder for about three seconds near the 
timecode indication.

Deleting Recorded Clips Advanced Operations

Recording Shot Marks

UDF / FAT-HD

File format Maximum number
MP4 127

MXF 999
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To make it easier for editors to select good clips, 
you can set OK marks in clips recorded in HD 
mode.

Note

OK marks cannot be set or deleted during recording or 
playback.

To add/delete OK marks
You can use the THUMBNAIL menu to add and 
delete OK marks in previously recorded clips. For 
details, see “Adding and Deleting OK, NG or KP 
Marks” (page 101).

The camcorder is equipped with enough internal 
memory to pre-store up to 15 seconds of video 
and audio data in a picture cache. This allows you 
to begin recording a specified number of seconds 
in advance of the time when you press a recording 
start button.

Selecting picture cache mode and setting 
the picture cache time
Before recording in picture cache mode, you must 
select picture cache mode and set the picture 
cache time (the number of seconds of video and 
audio data stored to memory) in the 
OPERATION menu.
The picture cache time determines how far in 
advance you can start recording, counting back in 
seconds from the operation that starts recording. 
Note that it may not be possible to start this far in 
advance in the special cases explained in the 
following notes.

Notes

• Storage of picture data to memory begins when you 
select picture cache mode. Therefore, if you start 
recording immediately after selecting picture cache 
mode, the picture data from before the selection is not 
recorded.

• No data is recorded to picture cache memory during 
playback or recording review and display of 

thumbnails. It is not possible to record picture data 
from the time you were conducting playback or a 
recording review.

To select picture cache mode and set the picture 
cache time

Notes

• Picture cache recording is not possible in Frame Rec, 
Interval Rec, Slow & Quick Motion, and Clip 
Continuous Rec mode. The camcorder exits Frame 
Rec, Interval Rec, Slow & Quick Motion or Clip 
Continuous Rec mode, whenever you select picture 
cache mode. The camcorder exits picture cache mode 
automatically whenever you select Frame Rec, 
Interval Rec, Slow & Quick Motion, or Clip 
Continuous Rec mode.

• The data stored in picture cache memory is cleared 
when you change the system settings, for example by 
selecting a different video format. Picture data from 
before the change is not recorded even if you start 
recording immediately after the change. The 
camcorder exits picture cache mode automatically.

• It is not possible to set the picture cache time during 
recording.

1 In the setup menu, select OPERATION 
>Rec Function >Picture Cache Rec.

For menu operations, see “Basic Setup Menu 
Operations” (page 109).

2 Turn the MENU knob to select [On], 
and then press the knob. 

3 Select [P. Cache Rec Time], turn the 
MENU knob to select the desired 
picture cache time, and then press the 
knob. 
You can select from 0-2sec, 2-4sec, 4-6sec, 
6-8sec, 8-10sec, 10-12sec, 12-14sec, and 
13-15sec.

Once made, picture cache mode settings remain 
in effect until changed.
Instead of carrying out steps 1 and 2, you can also 
select picture cache mode by using an assignable 
switch to which the Picture Cache function has 
been assigned (see page 155).

Camcorder data handling while recording in 
picture cache mode
Recording procedures in picture cache mode are 
basically the same as normal recording 
procedures. However, note the following 
differences with respect to how the camcorder 
handles video, time, and output data.

Setting OK Marks

UDF / FAT-HD

Starting to Record from Pre-
stored Video (Picture Cache 
Function)
Advanced Operations
Download from Www.Somanuals.com. All Manuals Search And Download.



C
hapter 4  S

hooting
• If you start recording while the media is being 
accessed, the start point of the video that is 
actually recorded may be later than the 
currently specified picture cache time. Because 
the delay increases as the number of recorded 
clips increases, you should avoid rapid start-
and-stop recording operations in picture cache 
mode.

• Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the 
internal timecode generator is always F-RUN.

• In picture cache mode, you cannot set time data 
by setting the F-RUN/SET/R-RUN switch to 
SET.
To set time data, exit picture cache mode.

• If the remaining free capacity of the media in 
the currently selected slot is less than the picture 
cache time, and the media in the other slot has 
enough remaining capacity, then data is 
recorded to the media in the other slot.
However, no data is recorded when there is no 
media in the other slot, and when the media in 
the other slot does not have enough remaining 
capacity. (A message appears in the viewfinder 
to inform you that there is not enough remaining 
capacity.)

• Shot marks are not recorded if they are set 
before the recording start operation.

• When you select a video format that supports 
i.LINK HDV output and play a clip that was 
recorded in picture cache mode, two or more 
frames with the same picture and timecode may 
follow on each other.

• i.LINK output is possible during picture cache 
recording. However, the picture cache time is 
limited.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 
audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC cable was disconnected, or the 
power was turned off on the AC adaptor side, 
then the video and audio data stored in memory 
is lost. The data stored in memory is not 
recorded. Be careful to avoid this when 
exchanging the battery.

The camcorder’s Interval Rec function allows 
you to capture time-lapse video to the 
camcorder’s internal memory. This function is an 
effective way to shoot slow-moving subjects.
When you start recording, the camcorder 
automatically records a specified number of 
frames at a specified interval time.

A pre-lighting function is available when Interval 
Rec is enabled. This function automatically turns 
on a video light before recording starts, which 
allows you to record pictures under stable light 
and color temperature conditions.

Interval Rec settings and shooting

Notes

• The Interval Rec function cannot be used at the same 
time as the picture cache, Frame Rec, Slow & Quick 
Motion, or Clip Continuous Rec function. When you 
select Interval Rec mode, the picture cache, Frame 
Rec, Slow & Quick Motion, and Clip Continuous Rec 
functions are disabled. When you select picture cache, 
Frame Rec, Slow & Quick Motion, or Clip Continuous 
Rec mode, the Interval Rec function is disabled.

• The data stored in picture cache memory is cleared 
when you change the system settings, for example by 
selecting a different video format. Picture data from 
before the change is not recorded even if you start 
recording immediately after the change. The 
camcorder exits picture cache mode automatically.

• Interval Rec settings cannot be changed during 
recording.

• Interval Rec is disabled when the following formats 
are selected.
- In FAT mode, SP 1440/59.94i or SP 1440/50i, when 

the output setting is HD and OPERATION >Input/

Recording Time-lapse Video 
(Interval Rec Function)

Interval time

Number of frames in one take
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Output >i.LINK I/O in the setup menu is set to 
[Enable]

- In FAT mode, SP 1440/23.98P (pull-down 
recording)

- In UDF mode, HD420 HQ 1280×720/23.98P (pull-
down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P, 
when the output setting is SD and OPERATION 
>Input/Output >i.LINK I/O in the setup menu is set 
to [Enable]

To make Interval Rec settings

1 Select OPERATION >Rec Function 
>Interval Rec in the setup menu.

For menu operations, see “Basic Setup Menu 
Operations” (page 109).

2 Turn the MENU knob to select [On], 
and then press the knob. 
The camcorder enters Interval Rec mode, the 
“Interval” indication on the viewfinder 
screen flashes.
(The green tally indicator in the HDVF series 
viewfinder also flashes.)

3 Select [Number of Frames], turn the 
MENU knob to select the number of 
frames to record in one take, and then 
press the knob. 
You can select from 1, 3, 6, 9 (or from 2, 6, 
12 when the video format setting is 720/
59.94P or 720/50P).

4 Select [Interval Time], turn the MENU 
knob to select the desired interval, and 
then press the knob. 
You can select 1 to 10/15/20/30/40/50 sec, 
1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 
hour.

5 As required, select [Pre-Lighting], turn 
the MENU knob to select the length of 
lighting time before recording starts, 
and then press the knob. 
You can select 1 to 10/15/20/30/40/50 sec, 
1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 
hour.

Notes

• If you want to turn the video light on before the start of 
recording, set the camcorder’s LIGHT switch to 
[AUTO]. The video light’s switch must also be turned 
on. When this is done, the video light turns on and off 

automatically. However, the video light remains lit 
when the time that it is off is five seconds or less.

• If you set the LIGHT switch to [MANUAL] and turn 
the video light’s switch on, the video light is always lit. 
(It does not go on and off automatically.)

The camcorder exits Interval Rec mode when it is 
powered off, but the number of frames, interval 
time, and pre-lighting settings are maintained. 
You do not need to set them again the next time 
you shoot in Interval Rec mode.

To shoot in Interval Rec mode
Make the settings and preparations described in 
“Basic Operations” (page 74), secure the 
camcorder so that it does not move, and begin 
shooting.

When recording starts, the “Interval” indication 
in the viewfinder changes from flashing to lit, and 
“INT REC” and “INT STBY” appear 
alternatively at the position of the REC 
indication. The TALLY indicators and the tally 
indicator on the front panel of the viewfinder light 
as they do during normal recording. (The green 
tally indicator in the viewfinder flashes at high 
frequencies.)
If you are using the pre-lighting function, the 
video light comes on before recording starts.

To stop shooting
Stop the recording.

When shooting ends, the video data stored in 
memory up to that point is written to the media.

To exit Interval Rec mode
Do one of the following.
• Set the POWER switch to OFF.
• With the camcorder in recording standby mode, 

set OPERATION >Rec Function >Interval Rec 
in the setup menu to “Off”.

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.
• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 
internal timecode generator is always F-RUN.

• Audio cannot be recorded.
• Recording review is not possible.
• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 
number of frames, creates a clip, and switches 
Advanced Operations
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to the other media. (when the recording mode is 
UDF)

• Genlock is not possible.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 
audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC power cord was disconnected, 
or the power was turned off on the AC adaptor 
side, then the video and audio data shot up to 
that point may be lost (maximum 10 seconds). 
Be careful to avoid this when exchanging the 
battery.

The Frame Rec function is useful for shooting 
stop motion animations, such as animations with 
puppets or clay figures.
Each time that you press the recording start 
button, the camcorder shoots a specified number 
of frames and then stops.

Frame Rec settings and shooting

Notes

• The Frame Rec function cannot be used at the same 
time as the picture cache, Interval Rec, Slow & Quick 
Motion, or Clip Continuous Rec function. When you 
select Frame Rec mode, the picture cache, Interval 
Rec, Slow & Quick Motion, and Clip Continuous Rec 
functions are disabled. When you select picture cache, 
Interval Rec, Slow & Quick Motion, or Clip 
Continuous Rec mode, the Frame Rec function is 
disabled.

• The data stored in memory is cleared when you change 
the system settings, for example by selecting a 
different video format. Picture data from before the 
change is not recorded even if you start recording 
immediately after the change. The camcorder exits 
Frame Rec mode automatically.

• Frame Rec settings cannot be changed during 
recording.

• Frame Rec is disabled when the following formats are 
selected.
- In FAT mode, SP 1440/59.94i or SP 1440/50i, when 

the output setting is HD and OPERATION >Input/

Output >i.LINK I/O in the setup menu is set to 
Enable

- In FAT mode, SP 1440/23.98P (pull-down 
recording)

- In UDF mode, HD420 HQ 1280×720/23.98P (pull-
down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P, 
when the output setting is SD and OPERATION 
>Input/Output >i.LINK I/O in the setup menu is set 
to Enable

To make Frame Rec settings

1 Select OPERATION >Rec Function 
>Frame Rec in the setup menu.

For menu operations, see “Basic Setup Menu 
Operations” (page 109).

2 Turn the MENU knob to select [On], 
and then press the knob. 
The camcorder enters Frame Rec mode, the 
“Frame Rec” indication on the viewfinder 
screen flashes.
(The green tally indicator in the HDVF series 
viewfinder also flashes.)

3 Select [Number of Frames], turn the 
MENU knob to select the number of 
frames to record in one take, and then 
press the knob. 
You can select from 1, 3, 6, 9 (or from 2, 6, 
12 when the video format setting is 720/
59.94P or 720/50P).

The camcorder exits Frame Rec mode when it is 
powered off, but the setting for the number of 
frames setting is maintained. You do not need to 
set it again the next time you shoot in Frame Rec 
mode.

To shoot in Frame Rec mode
Make the settings and preparations described in 
“Basic Operations” (page 74), secure the 
camcorder so that it does not move, and begin 
shooting.

When recording starts, the “Frame Rec” 
indication in the viewfinder changes from 
flashing to lit, and “FRM REC” and “FRM 
STBY” appear alternatively at the position of the 
REC indication. The TALLY indicators and the 
tally indicator on the front panel of the viewfinder 
light as they do during normal recording.

Shooting Stop Motion Animations 
(Frame Rec Function)
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To stop shooting
Stop the recording.

When shooting ends, the video data stored in 
memory up to that point is written to the media.

To exit Interval Rec mode
Do one of the following.
• Set the POWER switch to OFF
• With the camcorder in recording standby mode, 

set OPERATION >Rec Function >Interval Rec 
in the setup menu to “Off”.

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.
• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 
internal timecode generator is always R-RUN.

• Audio cannot be recorded.
• Recording review is not possible.
• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 
number of frames, creates a clip, and switches 
to the other media.

• Genlock is not possible.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 
audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC power cord was disconnected, 
or the power was turned off on the AC adaptor 
side, then the video and audio data shot up to 
that point may be lost (maximum 10 seconds). 
Be careful to avoid this when exchanging the 
battery.

When the camcorder is in HD mode and the video 
format (see page 51) is set to one of the formats 
listed below, you can specify a recording frame 
rate that is different from the playback frame rate.

By shooting with a frame rate that differs from the 
playback frame rate, you can obtain slow and 
quick motion effects that are smoother than low-
speed or high-speed playback of content recorded 
at the normal frame rate.

Example
When the video format is HQ 1280/23.98P, you 
can obtain quick-motion effects by setting the 
frame rate to 1 to 23, and obtain slow-motion 
effects by setting the frame rate to 25 to 60.

Slow & Quick Motion settings and 
shooting

Notes

• The Slow & Quick Motion function cannot be used at 
the same time as the picture cache, Interval Rec, Frame 
Rec, or Clip Continuous Rec function. When you 
select Slow & Quick Motion mode, the picture cache, 
Interval Rec, Frame Rec, and Clip Continuous Rec 
functions are disabled. When you select picture cache, 
Frame Rec, Interval Rec, or Clip Continuous Rec 
mode, the Slow & Quick Motion function is disabled.

• Slow & Quick Motion is disabled when the slow 
shutter function (viewfinder display “SLS”) function is 
enabled. The slow shutter function is disabled when 
the Slow & Quick Motion function is enabled.

• Slow & Quick Motion is disabled when OPERATION 
>Input/Output >i.LINK I/O in the setup menu is set to 
[Enable]. When Slow & Quick Motion is enabled, 
i.LINK I/O is fixed as [Disable].

Shooting with Slow & Quick 
Motion

OPERATION >Format menu 
settings

Video format

Country File 
System

HD System 
Line

NTSC 
Area or 
NTSC(J) 
Area

UDF 1080 HD422 50/29.97P
HD422 50/23.98P

720 HD422 50/59.94P
HD422 50/29.97P
HD422 50/23.98P

FAT 1080 HQ 1920/29.97P
HQ 1920/23.98P

720 HQ 1280/59.94P
HQ 1280/29.97P
HQ 1280/23.98P

PAL 
Area

UDF 1080 HD422 50/25P

720 HD422 50/25P
HD422 50/50P

FAT 1080 HQ 1920/25P

720 HQ 1280/50P
HQ 1280/25P
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• Slow & Quick Motion settings cannot be changed 

during recording.

To make Slow & Quick Motion settings

1 Select OPERATION >Rec Function > 
Slow & Quick in the setup menu.

For menu operations, see “Basic Setup Menu 
Operations” (page 109).

2 Turn the MENU knob to select [On], 
and then press the knob. 
The camcorder enters Slow & Quick Motion 
mode, and the “S&Q STBY” indication in 
the viewfinder lights.

3 Select [Frame Rate], turn the MENU 
knob to select the recording frame rate, 
and then press the knob. 
The setting range for the frame rate is as 
follows.

When you finish making these settings, the 
system frequency and the frame rate appear at the 
top of the viewfinder screen. You can change the 
frame rate while viewing the display in the 
viewfinder by turning the MENU knob.
The Slow & Quick Motion mode setting and the 
frame rate are retained even after the camcorder is 
powered off.

To shoot in Slow & Quick Motion mode
Shoot as described in “Basic Operations” 
(page 74).

When recording starts, the “S&Q STBY” 
indication in the viewfinder changes to the 
“zS&Q REC” indication. The TALLY 
indicators and the tally indicator on the front 
panel of the viewfinder light as they do during 
normal recording.

To stop shooting
Stop the recording.

Note

It takes longer than normal for recording to stop when 
Frame Rate is set to a low value (for a slow frame rate).

To exit Slow & Quick Motion mode
With the camcorder in recording standby mode, 
set OPERATION >Rec Function > Slow & Quick 
in the setup menu to [Off].

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.
• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 
internal timecode generator is always R-RUN.

• Audio cannot be recorded when the recording 
and playback frame rates differ.

• Recording review is not possible.
• If you change the recording frame rate to a value 

faster than the current shutter speed, the shutter 
speed is changed to the slowest value for which 
shooting is possible.
Example: If the frame rate is 32 and the shutter 
speed is 1/40, and you change the frame rate to 
55, then the shutter speed is changed to 1/60.
If is not possible to select a shutter speed that is 
slower than the recording frame rate.

• Genlock is not possible.

Normally, a clip is created as an independent file 
each time that you start and stop recording. But 
this function allows you to start and stop 
recording while continuously recording to the 
same clip, for as long as the function remains 
enabled. This is convenient when you do not want 
to generate a large number of short clips, and 
when you want to record without worrying about 
exceeding the clip limit. It is still easy to find 
recording start points, because a Rec Start essence 
mark is recorded at the recording start point each 
time you start recording.

System 
lines

Frame rate

1080 When OPERATION >Format 
>Country in the setup menu is set to 
[PAL Area] in UDF mode: 

1 to 25
In FAT mode or when OPERATION 
>Format >Country in the setup menu 
is set to other than [PAL Area] in 
UDF mode: 

1 to 30

720 When OPERATION >Format 
>Country in the setup menu is set to 
[PAL Area] in UDF mode: 

1 to 50
In FAT mode or when OPERATION 
>Format >Country in the setup menu 
is set to other than [PAL Area] in 
UDF mode: 

1 to 60

Recording with the Clip 
Continuous Rec Function
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Clip Continuous Rec settings and 
shooting

Notes

• The Clip Continuous Rec function cannot be used at 
the same time as the Picture Cache, Interval Rec, 
Frame Rec, or Slow & Quick Motion function. When 
you select Clip Continuous Rec mode, the Picture 
Cache, Interval Rec, Frame Rec, and Slow & Quick 
Motion functions are disabled. When you select 
picture cache, Frame Rec, Interval Rec, or Slow & 
Quick Motion mode, the Clip Continuous Rec function 
is disabled.

• The Clip Continuous Rec function is disabled when the 
recording mode is FAT.

To make Clip Continuous Rec settings

1 Select OPERATION >Rec Function 
>Clip Continuous Rec in the setup 
menu.

See “Basic Setup Menu Operations” (page 109) 
for more information about menu operations.

2 Turn the MENU knob to select [On], 
and then press the knob.
“CONT” appears in the viewfinder, and the 
function is enabled.

You can assign the Clip Continuous Rec on/off 
function to one of the ASSIGN 1/2/3 switches, 
ASSIGNABLE 4/5 switches, and the COLOR 
TEMP button.

For details, see “Assigning Functions to Assignable 
Switches” (page 155).

To shoot in Clip Continuous Rec mode
Shoot as described in “Basic Operations” 
(page 74).
When recording starts, the “Cont” indication in 
the viewfinder changes to “zREC” indication. 
The TALLY indicators and the tally indicator on 
the front panel of the viewfinder light as they do 
during normal recording.

Note

During recording or in recording standby mode (when 
“Cont” indication is lit), if you remove the media, the 
battery, or the power source, the media needs to be 
restored. It is not possible to restore media on a device 
other than this camcorder.
Exit Clip Continuous Rec mode (see page 84) and then 
remove the media.
When “Cont” indication is flashing (at 1 flash/s), you can 
remove the media.

To stop shooting
Stop the recording.

Note

Stop the recording after the recording continues for two 
or more seconds.

To exit Clip Continuous Rec mode
With the camcorder in recording standby mode, 
set OPERATION >Rec Function >Clip 
Continuous Rec in the setup menu to [Off].

Limitations during recording
A single continuous clip cannot be created if you 
perform one of the following operations while the 
camcorder is in recording or recording standby 
mode (A new clip will be created when you next 
start recording.)
• Operate on a clip (lock, delete, or rename a clip)
• Change the recording format
• Turn off the POWER switch
• Playback
• Switched to thumbnail mode

The freeze mix function allows you to 
temporarily overlap a still image (freeze picture) 
from a clip shot in HD mode onto the current 
camera picture. This makes it easier to frame the 
shot.

Note

The freeze mix function is not available in the following 
cases.
• When the recording format is SP 1080/23.98P (FAT 

mode) or HQ 1280/23.98P (UDF mode)
• When the video formats of the recorded picture and the 

camera picture differ
• When you are shooting in Slow & Quick Motion mode 

or slow shutter mode
• When there is i.LINK input

To display a freeze mix picture

1 Play a clip or conduct a recording 
review of a clip with the same format as 
the camera picture.

2 Display the picture that you want to use 
as the frame, and then turn on the 
assignable switch to which the Freeze 
Mix function has been assigned.

Framing Shots with the Freeze 
Mix Function
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The recording review picture is frozen and 
overlaps the camera picture.

Note

The following functions are disabled at the freeze mix 
times.
• Menu operations
• During Focus Mag display
• Marker display
• Zebra display
• Peaking display
• Skin tone details display

To cancel the freeze mix display
Do one of the following.
• Press an assignable switch again to which the 

Freeze Mix function has been assigned.
The freeze mix display is canceled and the 
display returns to the normal camera picture.

• Start recording (see page 75).
Normal recording starts.

Proxy data is made up of low-resolution video 
data (MPEG-4) and audio data (A-Low) (video: 
1.5 Mbps; audio: 64 Kbps per channel). This 
lightweight proxy data can be used in the same 
way as the original data, but it can be transferred 
more quickly, for more efficient viewing and 
editing. 
In UDF mode, proxy data is generated and 
recorded automatically when you record video 
and audio with a USB flash drive connected to the 
external device connector. By loading the proxy 
data from the USB flash drive into a computer, 
you can quickly check the recorded content or 
perform rapid offline editing.

Note

Do not power this unit off or do not remove the USB 
flash drive while the USB flash drive is being accessed. 
Doing so may cause the loss of all data recorded on the 
USB flash drive. 

You can record proxy data to a USB flash drive 
while recording clips to an SxS memory card. 

1 Set MAINTENANCE >USB >Memory 
Rec in the setup menu to [Enable].

2 Connect a USB flash drive formatted 
with the FAT32 file system to the 
external device connector (see page 73).

3 Start recording.
At the same time that the original data is 
recorded to an SxS memory card, proxy data 
is saved to the automatically generated 
\MSSONY\PRO\XDCAM\MEMDISC\
<Proav-ID> folder (Proav-ID is an ID 
specified in the DISCMETA.XML file on the 
SxS memory card). 
Proxy data: Saved in <Proav-ID>\Sub\ 

Recording Proxy Data

UDF

Recording Proxy Data While 
Recording Clips
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Metadata: Saved in <Proav-ID>\Clip\ 

To stop recording of proxy data
To stop recording of proxy data only, without 
stopping recording of original data, set 
MAINTENANCE >USB >Memory Rec in the 
setup menu to [Disable]. 

If recording fails
The message “USB Memory Error” appears. If 
recording fails because the USB flash drive is 
full, the message “USB Memory Full” appears.
Proxy data is saved in this unit’s internal memory. 
If recording fails because of a USB flash drive 
defect or for some other reason, you can exchange 
the USB flash drive or reconnect it, and rerecord 
the proxy data saved in internal memory. 

You can record proxy data for clips on SxS 
memory cards to USB flash drives.

To record proxy data for all clips

1 Set MAINTENANCE >USB >Memory 
Rec in the setup menu to [Enable].

2 Connect a USB flash drive formatted 
with the FAT32 file system to the 
external device connector (see page 73).

3 Insert an SxS memory card with 
recorded clips. 

4 Select MAINTENANCE >USB > Copy 
All Clips in the setup menu, and press 
the MENU knob.

5 Turn the MENU knob to select 
[Execute], and then press the knob.
Recording of the proxy data starts.
The message “Copy All Clips Done” appears 
when recording finishes.

To cue up a clip and record its proxy data

1 Set MAINTENANCE >USB >Memory 
Rec in the setup menu to [Enable].

2 Connect a USB flash drive formatted 
with the FAT32 file system to the 
external device connector (see page 73).

3 Insert an SxS memory card with 
recorded clips.

4 Cue up the clip for which you want to 
record proxy data. 

5 Select MAINTENANCE >USB > Copy 
Current Clip in the setup menu, and 
press the MENU knob.

6 Turn the MENU knob to select 
[Execute], and then press the knob.
Recording of the proxy data starts.
The message “Copy Current Clip Done” 
appears when recording finishes.

You can delete all proxy data in the 
\MSSONY\PRO\XDCAM\MEMDISC folder by 
deleting the folder.

1 Set MAINTENANCE >USB >Memory 
Rec in the setup menu to [Enable].

2 Connect a USB flash drive containing 
proxy data to the external device 
connector.

3 Select MAINTENANCE >USB > Del 
All Memory Clips in the setup menu, 
and press the MENU knob.

4 Turn the MENU knob to select 
[Execute], and then press the knob.
Deletion of the folder starts.
The message “Delete All Clips Done” 
appears when the deletion finishes.

Recording Proxy Data for Existing 
Clips

Deleting All Proxy Data from a 
USB Flash Drive
Recording Proxy Data
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Planning metadata is information about shooting 
and recording plans, recorded in an XML file.

Example of a planning metadata file

You can shoot using clip names and shot mark 
names defined in advance in a planning metadata 
file. 
This unit can display clip names and shot mark 
names defined in the following languages.
• English
• Chinese
• German
• French 1)

• Italian
• Spanish
• Dutch 1)

• Portuguese 
• Swedish
• Norwegian
• Danish
• Finnish 1)

1) Some characters are displayed as different but similar 
characters.

Note

If you define clip name and shot mark names in 
languages other than the above, they may not be 
displayed on the viewfinder screen or the LCD monitor 
screen (with the display mode set to STATUS).
In the LCD monitor (with the display mode set to 
STATUS), only alphanumeric characters and symbols 
can be displayed.

To record planning metadata together with 
recording clips, you need to load a planning 
metadata file into the camcorder’s memory before 
starting to shoot.
There are two ways to load files.
• Load a file that has been written to the following 

directories on an SxS memory card or a USB 
flash drive.

• When a Wi-Fi connection is made between the 
camcorder and a computer, operate the Web 
menu built in the camcorder from the computer 
to transfer a file.

For details on how to use the Web menu to load 
a planning metadata file, refer to the 
Supplement supplied in the CD-ROM (labeled 
“Manuals for Solid-State Memory 
Camcorder”).

To load a planning metadata file by menu 
operation
Do the following procedures with OPERAION 
>Planning Metadata in the setup menu.

To load a file in an SxS memory card

1 Insert an SxS memory card into the 
memory card slot A or B, and set Load/
Slot(A) or Load/Slot(B) to [Execute].
A file list appears.

Note

The file list displays up to 64 files.
Even if the total number of planning metadata files 
is 64 or less, all of the planning metadata files may 
not appear if the directory where they are located on 
the SxS memory card (General/Sony/Planning) 
contains 512 or more files.

Planning Metadata 
Operations 

Loading a Planning Metadata File 
into Camcorder’s Internal Memory

Recording 
mode

Media Directory to which 
files are written

FAT SxS memory 
card

BPAV/General/Sony/
Planning

SDHC PRIVATE/SONY/
BPAV/General/Sony/
Planning

UDF SxS memory 
card

General/Sony/Planning

USB flash 
drive 
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2 Turn the MENU knob to select a file to 
load and press the knob.

To load a file in a USB flash drive (in UDF mode)

1 Connect a USB flash drive formatted 
with the FAT32 file system to the 
external device connector (see page 73).
A file list appears.

Note

The file list displays up to 64 files.
Even if the total number of planning metadata files 
is 64 or less, all of the planning metadata files may 
not appear if the directory where they are located on 
the USB flash driver (General/Sony/Planning) 
contains 512 or more files.

2 Turn the MENU knob to select a file to 
load and press the knob.

To display detailed information in 
planning metadata
After loading planning metadata into this unit, 
you can check the detailed information that it 
contains, such as file names, date and time of 
creation, and titles.

1 Under OPERATION >Plan.Metadata 
>Properties in the setup menu, select 
[Execute].

2 Turn the MENU knob to select 
[Execute], and then press the knob.
The PLANNING METADATA 
PROPERTIES list appears. 
The list contains the following information.

a) Material group: A group of clips recorded with 
the same planning metadata. 

You can turn the MENU knob to scroll the 
list.
After turning the MENU knob to select an 
item, you can press the SET button to display 
the selected item only.

To clear the planning metadata loaded

1 Under OPERATION >Plan.Metadata 
>Clear in the setup menu, select 
[Execute].

2 Turn the MENU knob to select 
[Execute], and then press the knob.
Deletion of the file starts.
The message “Clear Planning Metadata File 
OK” appears when the deletion finishes.

The following two types of clip name strings can 
be written in a planning metadata file.
• The ASCII format name that appears in the 

viewfinder 
• The UTF-8 format name that is actually 

registered as the clip name

You can select which type of clip name is 
displayed with OPERAION >Planning Metadata 
>Clip Name Disp in the setup menu.

Item Information
File Name File name

Assign ID Assign ID

Created Date and time of creation

Modified Date and time of most recent 
modification

Modified by Name of person who 
modified the file

Title Title1 specified in file (ASCII 
format clip name) 

Title2 Title2 specified in file (UTF-8 
format clip name) 

Material Gp Number of clips in material 
group a) 

Shot Mark0 to 
Shot Mark9

Names defined in file for Shot 
Mark 0 to Shot Mark 9

Defining Clip Names in Planning 
Metadata
Planning Metadata Operations
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When a clip name is set with planning metadata, 
the name is displayed under the depth of field 
indication on the viewfinder screen.

Note

When you define both of ASCII format name and UTF-
8 format name with planning metadata, the UTF-8 
format string is used as the clip name string. If you define 
either of ASCII format name and UTF-8 format name 
with planning metadata, the defined format name is 
displayed though it is not selected by menu setting.

Clip name string example
Use a text editor to modify the two fields in the 
<Title> tag that contain the clip name strings.
The shaded fields in the example are clip name 
strings. “Typhoon” is described in ASCII format 
(up to 44 characters). “Typhoon_Strikes_Tokyo” 
is described in UTF-8 format (up to 44 bytes).
“sp” indicates a space and 3 indicates a carriage 
return.

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2011-08-20T17:00:00+09:00"sp
lastUpdate="
2011-09-28T10:30:00+09:00"sp
version="1.00">3

<PropertiessppropertyId="
assignment"spupdate="
2011-09-28T10:30:00+09:00"sp
modifiedBy="Chris">3

<TitlespusAscii=" "sp
xml:lang="en"> 
</Title>3

</Properties>3

</PlanningMetadata>3

Notes

• When you create a file, enter each statement as a single 
line with a CRLF only after the last character in the 
statement line, and do not enter spaces except where 
specified.

• Up to 44 bytes (or characters) string is available for the 
clip name.
If the UTF-8 format string exceeds 44 bytes, 44 bytes 
string is used as the clip name.
If only ASCII format name is specified, 44 characters 
string is used as the clip name.
When neither an ASCII format name string nor UTF-8 

format name string can be used, the standard format 
clip name is used.

You can use the Sony Planning Metadata Add-in 
application software supplied with the CBK-WA01 
Wi-Fi Adapter to define clip names. For details, refer 
to the Operating Instructions supplied with the CBK-
WA01.

To set clip names

1 Load a planning metadata file that 
contains clip names into this 
camcorder.

2 Set OPERATION >Clip >Auto Naming 
in the setup menu to [Plan].
Each time that you record a clip, the unit 
automatically generates a name consisting of 
the clip name defined in the planning 
metadata file, with the addition of an 
underbar (_) and a five-digit serial number 
(00001 to 99999).
Examples: 

Typhoon_Strikes_Tokyo_00001, 
Typhoon_Strikes_Tokyo_00002, ...

Note

When you load another planning metadata file, the serial 
number returns to 00001 with the next recording 
operation.

To select the clip name display format
When names are defined in both ASCII format 
and UTF-8 format, you can use OPERATION 
>Clip >Clip Name Disp in the setup menu to 
select which of the names to display on the LCD 
monitor and on the viewfinder screen.
To display ASCII format names: Select 

Title1(ASCII). 
The clip name becomes 
“Typhoon_Strikes_Tokyo_SerialNumber”, 
but “Typhoon_SerialNumber” is displayed 
on the screens.

To display UTF-8 format names: Select 
Title2(UTF-8).
The clip name becomes 
“Typhoon_Strikes_Tokyo_SerialNumber”, 
and the same name is displayed on the 
screens.

Typhoon
Typhoon_Strikes_Tokyo
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When you use planning metadata to set shot 
marks, you can define names for Shot Mark 0 to 
Shot Mark 9. When you record shot marks, you 
can add the shot mark name strings defined in the 
planning metadata.

Note

Shot Mark 1 and Shot Mark 2 can be recorded on the 
camcorder. Shot Mark 3 to Shot Mark 9 and Shot Mark 
0 can be recorded by operation from a computer which is 
connected with the camcorder via Wi-Fi.

Shot mark name string example
Use a text editor to modify the fields in the < Meta 
name> tag.
The shaded fields in the example are essence 
mark name strings. Names can be either in ASCII 
format (up to 32 characters) or UTF-8 format (up 
to 16 characters). 
“sp” indicates a space and 3 indicates a carriage 
return.

Note

If a name string contains even one non-ASCII character, 
the maximum length of that string is 16 characters.

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">3

<PropertiessppropertyId=
"assignment"spclass="original"sp
update="2011-04-15T15:00:00Z"sp
modifiedBy="Chris">3

<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 15/04/2011</
Title>3

<Metaspname="_ShotMark1"sp
content=" "/>3

<Metaspname="_ShotMark2"sp
content=" "/>3

<Metaspname="_ShotMark3"sp
content=" "/>3

<Metaspname="_ShotMark4"sp
content=" "/>3

<Metaspname="_ShotMark5"sp
content=" "/>3

<Metaspname="_ShotMark6"sp
content=" "/>3

<Metaspname="_ShotMark7"sp
content=" "/>3

<Metaspname="_ShotMark8"sp
content=" "/>3

<Metaspname="_ShotMark9"sp
content=" "/>3

<Metaspname="_ShotMark0"sp
content=" "/>3

</Properties>3

</PlanningMetadata>3

Note

When you create a definition file, enter each statement as 
a single line with a CRLF only after the last character in 
the statement line, and do not enter spaces except where 
specified, except within essence mark name strings.

You can use the Sony Planning Metadata Add-in 
application software supplied with the CBK-WA01 
Wi-Fi Adapter to Essence mark names. For details, 
refer to the Operating Instructions supplied with the 
CBK-WA01.

Defining Shot Mark Names in 
Planning Metadata

Goal

Shoot

Corner Kick

Free Kick

Goal Kick

Foul

PK

1st Half

2nd Half

Kick Off
Planning Metadata Operations
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A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail 
screens display lists of the clips stored on SxS memory cards in the form of index pictures. (A message 
appears if you insert a memory card that contains no clips.)
You can select any clip (see page 94) in a thumbnail screen and start playback of that clip (see page 94).

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An 
OK, NG or KP mark also appears when a clip has been marked with an OK, NG or KP mark.)

Note

Normal thumbnail screens display SD clips only or HD clips only, even if the SxS memory card contains clips in both 
formats. You can select the format to display by selecting a mode with OPERATION >Format >HD/SD (see page 112) 
in the setup menu.
If you want to display all recorded clips, regardless of the HD/SD mode, switch to the all clips thumbnail screen. 
However, it is not possible to start playback from the all clips thumbnail screen (see page 99).

Chapter5 Clip Operations

Clip Playback

Thumbnail Screen
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UDF mode/FAT-HD mode thumbnail screen

a Index picture
When a clip is recorded, its first frame is set 
automatically as the index picture. You can 
change to index picture to any frame (see 
page 106).

b Lock mark
Indicates the selected clip is marked with an OK 
mark or protected.

c Date and start time of recording

d Clip name

e Independent AV file icon
This appears only when a clip is an independent 
AV file. SxS memory cards may contain 
independent files that have been added directly 
from a computer. Because independent files lack 
the associated management files, some operations 
and information displays may not be available.

f Video format of recording

g Special recording information
This displays the mode of clips that have been 
recorded in a special mode (Slow & Quick 
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates 
are displayed to the right as [Recording frame 
rate/Playback frame rate] fps.

h OK/NG/KP mark
When the recording mode is UDF, an OK, NG, or 
KP mark appears if the clip has been marked with 
an OK, NG or KP mark (see page 101). 
When the recording mode is FAT, an OK mark 
appears only if the clip has been marked with an 
OK mark (see page 101).

i File format
Indicates the file format of the selected clip (MXF 
or MP4).
(This item is not indicated when the recording 
mode is UDF-HD mode.) 

UDF / FAT-HD

Clip number/Number of clips

Cursor (yellow)
The icon of the currently selected SxS memory card is highlighted.
(If the card is write protected, a lock appears on the left.)
Clip Playback
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j Clip duration

k Timecode
This is the timecode of the index picture.

FAT-SD mode thumbnail screen

a Take mark
Indicates that the file size is larger than 2 GB, and 
that the clip has been split before being saved.
You can check the segment files on the expand 
thumbnail screen (see page 104).

b Index picture
When a clip is recorded, its first frame is set 
automatically as the index picture.

c Date and start time of recording

d Clip name/Number of components
The number after the clip name (delimited by /) is 
the number of components. This appears only for 
clips larger than 2 GB in size, which have been 
split into smaller files for storage.

e Video format of recording

f File format
Indicates the file format of the selected clip 
(AVI).

g Clip duration

h Timecode
This is the timecode of the index picture.

To switch between SxS memory cards
When two SxS memory cards are loaded, you can 
switch between them by pressing the SLOT 
SELECT button.

Note

While an expand thumbnail screen (see page 104) or an 
essence mark thumbnail screen (see page 105) is 
displayed, SxS memory cards cannot be switched.

FAT-SD

Clip number/Number of components

Cursor (yellow)
The icon of the currently selected SxS memory card is highlighted.
(If the card is write protected, a lock appears on the left.)
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To hide the thumbnail screen
Press the THUMBNAIL button.

To select clip thumbnails
Do one of the following to move the yellow 
cursor to the clip that you want to select.
• Press an arrow button (J, j, K, k).
• Turn the MENU knob.
• Press the PREV or NEXT button.

To select the first thumbnail
With the F REV button held down, press the 
PREV button.

To select the last thumbnail
With the F FWD button held down, press the 
NEXT button.

To play clips sequentially starting from a 
selected clip

1 Select the thumbnail of the clip that you 
want to play first.

2 Press the PLAY/PAUSE button.
Play begins from the top of the selected clip.

Play continues through all clips after the selected 
clip.
When the last clip has been played to the end, the 
camcorder enters pause (still image) mode at the 
last frame of the last clip.
Press the THUMBNAIL button to return to the 
thumbnail screen.

Notes

• There may be momentary picture breakup or still 
image display at the transition from one clip to another. 
During this time, the play controls and the 
THUMBNAIL button cannot be operated.

• When you select a clip in the thumbnail screen and 
begin playback, there may be momentary picture 
breakup at the top of the clip. To view the top of the 
clip without breakup, put the camcorder into playback 
mode, pause, use the PREV button to return to the top 
of the clip, and start play again.

• On SxS memory cards that contain both HD-mode and 
SD-mode clips, you cannot play all clips in sequence. 
For example, while an HD mode thumbnail screen is 
displayed, only HD mode clips are played in sequence.

To pause play
Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator flashes while play 
is paused.
Press the button again to return to play mode.

To play at high speed
Press the F FWD button (see page 21) or the 
F REV button (see page 21).
To return to normal playback, press the PLAY/
PAUSE button.

To stop play
Press the STOP button: Play stops and the 

camcorder enters E-E mode.
Press the THUMBNAIL button: Play stops and 

the thumbnail screen (see page 91) appears 
in the viewfinder.

Play also stops if you eject the memory card. In 
this case, the camera picture appears in the 
viewfinder.

To cue up clips

To return to the top of the current clip
Press the PREV button.
• During playback or F FWD, this jumps to the 

top of the current clip and starts play.
• During F REV or pause, this jumps to the top of 

the current clip and displays a still image.
• Each subsequent press of the button moves to 

the previous clip.

To play from the top of the first clip
Simultaneously press the PREV and F REV 
buttons. This jumps to the top of the first clip on 
the SxS memory card.

To jump to the top of the next clip
Press the NEXT button.
• During playback or F FWD, this jumps to the 

top of the next clip and starts play.
• During F REV or pause, this jumps to the top of 

the next clip and displays a still image.
• Each subsequent press of the button moves to 

the next clip.

To play from the top of the last clip
Simultaneously press the NEXT and F FWD 
buttons. This jumps to the top of the last clip on 
the SxS memory card.

Playing Clips
Clip Playback
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To add a shot mark during play

You can add shot marks to clips during play by 
using the same method used during recording (see 
page 77).

Notes

• Shot marks cannot be recorded when the SxS memory 
card is write protected.

• Shot marks cannot be added at the first frame of each 
clip or last frame of the last clip.

You can switch a thumbnail screen to the 
following thumbnail search screens, which allow 
you quickly find the clips you want.
• Expand thumbnail screen
• Essence mark thumbnail screen (in HD mode 

only)

Like the normal thumbnail screen and the OK clip 
thumbnail screen, these screens allow you to 
select clip thumbnails (see page 94) and to start 
clip playback (see page 94).

To search for scenes in clips with the 
expand thumbnail screen
The expand thumbnail screen is convenient when 
you want to find and cue up a specific scene in a 
long clip.
To display the expand thumbnail screen, select a 
clip in the thumbnail screen and press the DISP 
SEL/EXPAND button (see page 21) or select 
THUMBNAIL >Thumbnail View >Forward 
Expansion in the setup menu. The selected clip is 
displayed as follows.
HD mode: The clip is divided into 12 equally-

sized blocks, and a thumbnail of the first 
frame in each block is displayed.

SD mode: Only in the case of clips that have been 
split into partial files because the file size was 
larger than 2 GB, a thumbnail of the first 
frame of each partial file is displayed.

This helps you to quickly cue up to a desired 
scene in a clip of long duration.

See “Displaying the Expand Thumbnail Screen” 
(page 104) for more information about the expand 
thumbnail screen.

To search for essence marks in clips with 
the essence mark thumbnail screen

When a clip contains one or more essence marks, 
you can easily find them with the essence mark 
thumbnail screen. The essence mark thumbnail 
screen displays a thumbnail of each essence mark 
frame in the clip.
To display the essence mark thumbnail screen, 
press the ESSENCE MARK button (see page 23) 
or select THUMBNAIL >Thumbnail View > 
Essence Mark Thumbnail in the setup menu.

See “Displaying the Essence Mark Thumbnail 
Screen” (page 105) for more information about the 
essence mark thumbnail screen.

HD

Using Thumbnails to Search 
Inside Clips

UDF / FAT-HD
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You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and 
to change clip metadata.

Thumbnail Operations

THUMBNAIL Menu Configuration

Menu items Sub-items Description

Clip Properties — Displays detailed properties (see page 100).

Set Index Picture — Changes index pictures in the expand thumbnail screen or 
the essence mark thumbnail screen (see page 106).

Thumbnail View Forward Expansion • Displays the expand thumbnail screen (see page 104).
• In the expand thumbnail screen, increases the number of 

divisions (see page 105).

Back Expansion In the expand thumbnail screen, decreases the number of 
divisions.

Essence Mark Thumbnail Displays the essence mark thumbnail screen (see 
page 105).

Clip Thumbnail Displays the normal thumbnail screen.

All Clip Thumbnail Displays the all clips thumbnail screen (see page 99).

Set Shot Mark Add Shot Mark1 In the expand thumbnail screen or the essence mark 
thumbnail screen, adds a Shot Mark1 mark (see page 106).

Delete Shot Mark1 In the expand thumbnail screen or the essence mark 
thumbnail screen, deletes a Shot Mark1 mark (see 
page 106).

Add Shot Mark2 In the expand thumbnail screen or the essence mark 
thumbnail screen, adds a Shot Mark2 mark (see page 106).

Delete Shot Mark2 In the expand thumbnail screen or the essence mark 
thumbnail screen, deletes a Shot Mark2 mark (see 
page 106).

Set Clip Flag OK Adds an OK mark.

NG Adds an NG mark.

KP(Keep) Adds a KP mark.

None Deletes an OK, an NG or a KP mark. 

Add OK Mark — Adds an OK mark and protects a clip (see page 101).

Delete OK Mark — Deletes an OK mark and unprotects a clip (see page 101).

Lock Clip — Protects a clip.

Unlock Clip — Cancels protection of a clip. 

UDF / FAT-HD

UDF / FAT-HD

UDF / FAT-HD

UDF

FAT-HD

FAT-HD

UDF

UDF
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Copy Clip — Copies a clip (see page 102).

Delete Clip — Deletes a clip (see page 103).

Divide Clip — Divides a clip (see page 106).

Filter Clips — Displays the OK clip thumbnail screen (see page 98).

Filter Clips OK Displays the OK clip thumbnail screen.

NG Displays the NG clip thumbnail screen.

KP(Keep) Displays the KP clip thumbnail screen.

None Displays the None clip (clip which have been marked with 
an OK, NG, or KP mark) thumbnail screen. 

Lock All Clips — Protects all clips displayed.

Unlock All Clips — Cancels protection of all clips displayed.

Copy All All Clips Batch copies groups of clips/files (see page 103).

General Files

All Clips & General Files

Delete All Clips Execute/Cancel Deletes all unprotected clips (see page 103).

Menu items Sub-items Description

FAT-HD

FAT-HD

UDF

UDF

UDF
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See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

To display the THUMBNAIL menu

1 Press the THUMBNAIL button to 
display the thumbnail screen.

2 Set the MENU ON/OFF switch to ON, 
or press the MENU button.

3 Turn the MENU knob to select “TH”, 
and then press the knob. Or press the J 
or j button to select “TH”, and then 
press the SET button.
The THUMBNAIL menu appears.

in FAT mode

in UDF mode

To hide the THUMBNAIL menu, press the 
MENU button again.

To select menu items and sub-items
Do one of the following.
• Turn the MENU knob to select an item or sub-

item, and then press the knob.
• Press the arrow buttons (J, j, K, k) to 

select an item or sub-item, and then press the 
SET button.

According to the selected item or sub-item, a 
selection list or a clip properties screen appears 
(see page 100).
To return to the previous state, push the MENU 
CANCEL/PRST/ESCAPE switch down to the 
ESCAPE side.

Notes

• When an SxS memory card is write protected, it is not 
possible to copy, delete, or divide clips, to change 
index pictures, or to add and delete OK/NG/KP marks 
and shot marks.

• Some items cannot be selected, depending on the state 
of the camcorder when the menu was displayed.

To hide the clip properties screen
Do one of the following.
Press the RESET/RETURN button: This 

returns to the THUMBNAIL menu.
Press the THUMBNAIL button: The 

camcorder enters E-E mode, and the camera 
picture appears.

Press the PLAY/PAUSE button: Playback from 
the selected clip starts.

To display OK/NG/KP/None clip 
thumbnails 
When the recording mode is UDF, from among 
all clips stored on the currently selected SxS 
memory card, only clips which have been marked 
with a OK, NG or KP mark can be displayed, or 
only clips with no marks (None clips) can be 
displayed.
When the recording mode is FAT, from among all 
clips stored on the currently selected SxS memory 
card, only clips which have been marked with an 
OK mark can be displayed.
When the normal thumbnail screen is displayed, 
you can select THUMBNAIL >Filter Clips to 
switch to the screen.
In FAT-HD mode: Switched to the OK clip 

thumbnail screen.
In UDF mode: By selecting one of OK, NG, KP 

(Keep) and None in the setting area, you can 
display the thumbnail screen containing only 
clips which have been marked with the 
selected mark or only clips which have been 
marked with no marks (None clips).

Basic THUMBNAIL Menu 
Operations

FAT

UDF

Changing the Thumbnail Screen 
Type
Thumbnail Operations
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See “Adding and Deleting OK, NG or KP Marks” 
(page 101) for information about how to add OK 
marks.

To display the all clips thumbnail screen
The all clips thumbnail screen displays 
thumbnails of all of the clips on the selected 
memory card, including both HD-mode and 
SD-mode clips. This is useful when you want to 
check whether the memory card contains clips in 
another mode.
You can switch to the all clips thumbnail screen 
by selecting THUMBNAIL >All Clip Thumbnail 
in the setup menu in the normal thumbnails 
screen.

Pressing the RESET/RETURN button returns 
you to the normal thumbnails screen, where you 
can perform playback and other clip operations.

Note

You cannot start playback from the all clips thumbnail 
screen.
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The clip properties screen appears when you select Clip Properties in the THUMBNAIL menu.

a Image of the current clip

b Image of the previous clip
Press the PREV button to display the properties of 
the previous clip.

c Image of the next clip
Press the NEXT button to display the properties 
of the next clip.

d Clip name
In SD mode, only for clips that have been divided 
because the file size was greater than 2 GB, the 
number of component clips appears after the clip 
name.
When clip names are 12 characters or longer, only 
the first five characters and the last five characters 
are displayed. If you want to check the 
abbreviated characters, press the MENU knob to 
switch to long display mode. In long display 
mode, up to 53 characters are displayed in clip 
names.

Displaying Clip Properties

UDF / FAT-HD

FAT-SD
Thumbnail Operations
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Press the MENU knob again to exit long display 
mode. Pressing the PREV or NEXT button to 
display the previous or next clip also exists long 
display mode.

e Lock mark
This appears when the clip is marked with an OK 
mark or protected.

f OK/NG/KP mark
This appears only when an OK/NG/KP mark has 
been added.

g Date and start time of recording

h File format
The file format of the clip (MXF, MP4 or AVI) 
appears.

i Special recording information 
This displays the mode of clips that have been 
recorded in a special mode (Slow & Quick 
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates 
are displayed to the right as [Recording frame 
rate/Playback frame rate].

j Timecode of the displayed image

k Timecode of the recording start point

l Timecode of the recording end point

m Duration

n Recorded audio channels

o Video format of recording

You can add OK, NG or KP marks to clips. This 
makes it possible to display thumbnails of only 
the clips that you need by pressing the 
THUMBNAIL button.
When the recording mode is FAT, clips with OK 
marks cannot be deleted or divided (protected). If 
you want to delete or divide such a clip, delete the 
OK mark.

To add an OK mark

1 In the thumbnail screen, select 
THUMBNAIL >Add OK Mark.
The screen changes to the clip properties 
screen, and a confirmation message appears 
beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
An OK mark is added to the selected clip.

You can use an assignable switch to which Clip 
Flag OK is assigned to add OK marks.

To add an OK, NG or KP mark

1 In the thumbnail screen, select 
THUMBNAIL >Set Clip Flag.

2 Select one of OK, NG or KP in the 
setting area.

3 Select [Execute], and press the MENU 
knob.
The mark selected in step 2 is added to the 
selected clip.

You can use assignable switches to which Clip 
Flag OK, Clip Flag NG and Clip Flag Keep are 
assigned to add OK, NG and KP marks.

To delete an OK mark

A Delete OK Mark item appears in the 
THUMBNAIL menu when you have selected a 
clip that has an OK mark.

1 In the thumbnail screen, select 
THUMBNAIL >Delete OK Mark.
The screen changes to the clip properties 
screen, and a confirmation message appears 
beneath the index picture.

Adding and Deleting OK, NG or 
KP Marks

UDF / FAT-HD

FAT-HD

UDF

FAT-HD
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2 Select [Execute], and press the MENU 
knob.
The OK mark is deleted from the selected 
clip.

To delete an OK, NG or KP mark

1 In the thumbnail screen, select the 
thumbnail of the clip from which you 
want to delete an OK, NG or KP mark, 
and select THUMBNAIL >Set Clip Flag 
>None.
The screen changes to the clip properties 
screen, and a confirmation message appears 
beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
The mark selected in step 2 is added to the 
selected clip.

When the recording mode is UDF, you can 
protect a selected clip or all clips. Protected clips 
cannot be deleted or divided.

To protect a clip

1 In the thumbnail screen, select the 
thumbnail of the clip which you want to 
protect, and select THUMBNAIL 
>Lock Clip.
The screen changes to the clip properties 
screen, and a confirmation message appears 
beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
The selected clip is protected.

To protect all clips

1 In the thumbnail screen, select 
THUMBNAIL >Lock All Clips.

A confirmation message appears beneath the 
index picture.

2 Select [Execute], and press the MENU 
knob.
All clips are protected.

To cancel protection of a clip 

1 In the thumbnail screen, select the 
thumbnail of the clip which you want to 
unprotect, and select THUMBNAIL 
>Unlock Clip.
The screen changes to the clip properties 
screen, and a confirmation message appears 
beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
The selected clip is unprotected.

To cancel protection of all clips 

1 In the thumbnail screen, select 
THUMBNAIL >Unlock All Clip.
A confirmation message appears beneath the 
index picture.

2 Select [Execute], and press the MENU 
knob.
All clips are unprotected.

You can copy clips to other SxS memory cards.
Clips are copied to destination SxS memory cards 
using the same names as the original clips.

Notes

• If a clip with the same name already exists at the copy 
destination SxS memory card, a one-digit number in 
parentheses is added to the original name.
The number in parentheses is the smallest number that 
does not exist at the copy destination.

Examples:
ABCD0002tABCD0002(1)
ABCD0002(1)tABCD0002(2)
ABCD0005(3)tABCD0005(4)

• If the parenthetical numbers (1) to (9) already exist at 
the copy destination, it is not possible to copy any more 
clips under that name. (A tenth clip cannot be copied.)

UDF

Protecting Clips

UDF

Copying Clips
Thumbnail Operations
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• A message appears if there is not enough free capacity 
at the copy destination SxS memory card. Exchange 
the card for one with more free capacity.

• When multiple clips are recorded in a source SxS 
memory card, it may not be possible to copy all clips 
to the end. Depending on memory characteristics and 
usage of the memory cards, this can occur even when 
the source and destination memory cards have the 
same capacity.

1 In the thumbnail screen, select the 
thumbnail of the clip to copy, and then 
select THUMBNAIL >Copy Clip.
The screen changes to the properties screen 
of that clip, and a confirmation message 
appears beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
The copy starts.

During the copy, an execution message and 
progress bar are displayed.
When the copy finishes, the display returns to the 
thumbnail screen.

To cancel a copy operation
Press the RESET/RETURN button.
The copy is cancelled, and the display returns to 
the thumbnail screen.

To batch copy groups of clips/files
You can batch copy groups of clips from one SxS 
memory card to another SxS memory card.
When both HD-mode and SD-mode clips exist on 
the source SxS memory card, only clips in the 
currently selected mode are copied. This is a 
convenient way to extract clips in one of the 
modes.
You can also copy of the files in the General 
directory, either together with or separately from 
clips.

1 In the thumbnail screen, select the 
thumbnails of the clips to copy and then 
select THUMBNAIL >Copy All >All 
Clips.
The confirmation message “Copy All Clip?” 
appears.

2 Select [Execute], and press the MENU 
knob.
The copy starts.

During the copy, the progress of the copy is 
displayed.
If you executed the copy in HD mode, only 
HD-mode clips are copied.
If you executed the copy in SD mode, only 
SD-mode clips are copied.

To cancel the copy operation
Press the RESET/RETURN button.

When the copy finishes
A completion message appears, and the 
THUMBNAIL menu screen appears again.

To copy all files in the General directory
To copy all files only, without copying clips, 
select THUMBNAIL >Copy All >General Files 
in step 1.
To copy all files together with all clips, select 
THUMBNAIL >Copy All >All Clips & General 
Files in step 1.

You can delete clips from SxS memory cards.

Note

HD clips with OK marks cannot be deleted.
If you want to delete such clips, first delete the OK marks 
(see page 101).

1 In the thumbnail screen, select the 
thumbnail of the clip to delete, and then 
select THUMBNAIL >Delete Clip.
The screen changes to the properties screen 
of that clip, and a confirmation message 
appears beneath the index picture.

2 Select [Execute], and press the MENU 
knob.
The clip is deleted.

In the thumbnail screen, the clips that followed 
the deleted clip move up one position.

To batch delete groups of clips
You can batch delete groups of clips from an SxS 
memory card.

Notes

• When both HD-mode and SD-mode clips exist on the 
SxS memory card, only clips in the currently selected 
mode are deleted.

Deleting Clips
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• In HD mode, clips with OK marks are not deleted, 
even when a deletion is executed for a group of clips 
that includes them.

1 In the thumbnail screen, select the 
thumbnails of the clips to delete and 
then select THUMBNAIL >Delete All 
Clips.
The confirmation message “Delete All 
Clips?” appears.

2 Select [Execute], and press the MENU 
knob.
The deletion starts.
During the deletion, the progress of the 
deletion is displayed.
If you executed the deletion in HD mode, 
only HD-mode clips are deleted.
If you executed the deletion in SD mode, 
only SD-mode clips are deleted.

To cancel the deletion
Press the RESET/RETURN button.

When the deletion finishes
A completion message appears, and the 
THUMBNAIL menu screen appears again.

The expand thumbnail screen allows you to 
search inside clips by using thumbnails (see 
page 95), to change index pictures (see 
page 106), and to add and delete shot marks (see 
page 106).

To display the screen
In the thumbnail screen, select a thumbnail and 
press the DISP SEL/EXPAND button (see 
page 21) or select THUMBNAIL >Thumbnail 
View >Forward Expansion.
An expand thumbnail screen for the selected clip 
appears.

Expand thumbnail screen in UDF/FAT-HD 
mode

In UDF mode or FAT-HD mode, the selected clip 
is divided into 12 equally-sized blocks, and a 

thumbnail of the first frame in each block is 
displayed.

Clip properties are shown at the bottom of the 
screen.
Except for the items listed below, the information 
displayed here is the same as the information 
displayed in the normal thumbnail screen.

a Frame information
This displays frame information using icons. 

The same icons are also displayed beneath the 
thumbnails. However, when several icons could 
be displayed for the same frame, one icon is 
selected for display, in the order of priority Index 
picture > Shot Mark1 > Shot Mark2.

b Timecode
This displays the timecode of the selected frame 
in the expand thumbnail screen.

Expand thumbnail screen in FAT-SD 
mode

In FAT-SD mode, only in the case of clips that 
have been split into partial files because the file 
size was larger than 2 GB, a thumbnail of the first 
frame of each partial file is displayed.

Displaying the Expand Thumbnail 
Screen

UDF / FAT-HD

Index picture

Frame with Shot Mark1

Frame with Shot Mark2

FAT-SD

S1 S2

S2 S1

Number of the selected frame

S1
S2
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Clip properties are displayed at the bottom of the 
screen.
Except for the items listed below, the information 
displayed here is the same as the information 
displayed in the normal thumbnail screen.

a Timecode
This is the timecode of the selected partial file.

b Duration
This is the duration of the selected partial file.

To increase the number of divisions
When you press the DISP SEL/EXPAND button, 
or select THUMBNAIL >Thumbnail View 
>Forward Expansion, the divided clip or file is 
further divided into 12 equally-sized blocks (a 
clip or file that has been divided into 12 is further 
divided into 12, for 12 × 12 = 144 divisions). You 
can repeat the same operation to increase the 
number of division.

To return to the previous division level
Press the DISP SEL/EXPAND button with the 
SHIFT button held down, or select 
THUMBNAIL >Thumbnail View >Back 
Expansion. The expand thumbnail screen returns 
to the previous division level.

In the essence mark thumbnail screen (shown 
only in HD mode), you can search for shot marks 
in clips (see page 95), change index pictures (see 
page 106), and add and delete shot marks (see 
page 106). 

1 In the thumbnail screen, select the 
thumbnail of a clip, and press the 
ESSENCE MARK button (see page 23) 
or select THUMBNAIL >Thumbnail 
View >Essence Mark Thumbnail.
The essence mark thumbnail screen appears, 
and a selection list is displayed.

2 Select the type of the essence mark 
thumbnail screen
All: Display all frames marked with essence 

marks.
Rec Start: Display frames marked with Rec 

Start marks and of the first frames of 
clips when the first frames are not 
marked with Rec Start marks (In UDF 
mode only).

Shot Mark1: Display only frames marked 
with Shot Mark1 marks.

Shot Mark2: Display only frames marked 
with Shot Mark2 marks.

You can also select Shot Mark 0 and Shot 
Mark 3 to Shot Mark 9.
If you have recorded clips by using planning 
metadata that defined names for Shot Mark 0 
to Shot Mark 9, the defined names are 
displayed instead of the above item names in 
the list.

Example shot mark thumbnail screen 
(with Shot Mark1 selected)

The properties of the clip appear at the bottom of 
the screen.
Except for the following item, the information 
displayed here is the same as the information 
displayed in the expand thumbnail screen.

Displaying the Essence Mark 
Thumbnail Screen

UDF / FAT-HD

Number of the selected frame

S1 S S2 S1

S1 S1
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a Timecode
This is the timecode of the selected frame in the 
shot mark thumbnail screen.

In the essence mark thumbnail screen (see 
page 105) or the expand thumbnail screen (see 
page 104), you can add thumbnails to any frame 
of clips recorded in HD mode, and delete 
recorded shot marks.

To add shot marks

1 Select the frame where you want to add 
a shot mark, and then select 
THUMBNAIL > Set Shot Mark > Add 
Shot Mark1 (or Add Shot Mark2).
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select [Execute], and press the MENU 
knob.

To delete shot marks

1 Select the frame where you want to 
delete a shot mark, and then select 
THUMBNAIL > Set Shot Mark > 
Delete Shot Mark1 (or Delete Shot 
Mark2).
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select [Execute], and press the MENU 
knob.

In the essence mark thumbnail screen (see 
page 105) or the expand thumbnail screen (see 
page 104), you can set the selected frame of the 
clip recorded in UDF/FAT-HD mode as the index 
picture.

1 Select the thumbnail of the frame that 
you want to use as the index picture, 
and then select THUMBNAIL >Set 
Index Picture. 
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select [Execute], and press the MENU 
knob.

Note

Even if you set the index picture to a frame that is not the 
first frame of a clip, playback of that clip from a 
thumbnail screen always begins at the first frame. 

In the expand thumbnail screen (see page 104) 
and the essence mark thumbnail screen (see 
page 105), clips recorded in FAT-HD mode can 
be divided into two clips at the selected frame.

1 Select the thumbnail of the frame where 
you want to divide the clip, and then 
select THUMBNAIL >Divide Clip.
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select [Execute], and press the MENU 
knob.
The clip is divided at the selected frame, and 
two clips with different names are created. 

The first four characters of the clip name are 
taken from the name of the original clips, and the 
last four characters are new serial numbers.

Example: When the name of a newly recorded 
clip would be EFGH0100, and a clip named 
ABCD0002 is divided, the names of the two 
newly created clips are ABCD0100 and 
ABCD0101. 

Note

When there is not enough remaining capacity on the SxS 
memory cards to store the divided clips, a message 
appears to inform you that there is not enough capacity.

Adding and Deleting Shot Marks

UDF / FAT-HD

Changing Clip Index Pictures

UDF / FAT-HD

Dividing Clips

FAT-HD
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On this camcorder, settings for shooting and 
playback are made in the setup menu, which 
appears in the viewfinder.
The setup menu can also be displayed on an 
external video monitor (see page 167).

The setup menu consists of the following menus.

Us: USER menu
Menu items added in any order from other menus 
(see page 111)

Op: OPERATION menu
Settings related to shooting, except settings 
related to picture quality (see page 112)

Pa: PAINT menu
Settings related to picture quality (see page 129)

Th: THUMBNAIL menu
Settings related to clip thumbnails (see page 96)

Note

The THUMBNAIL menu is used only when a thumbnail 
screen (see page 91) is displayed. It is disabled when no 
thumbnail screen is displayed.

Ma: MAINTENANCE menu
Settings related to audio and timecode (see 
page 135)

Fi: FILE menu
Settings related to file operations (see page 150)

See “THUMBNAIL Menu Configuration” (page 96) 
for the organization of the THUMBNAIL menu.

USER menu (see page 111)

OPERATION Menu (see page 112)

Chapter6 Menu and Detailed Settings

Setup Menu 
Organization and Levels

Setup Menu Organization

Setup Menu Levels

USER

Format Media

Rec Function

Input/Output

Clip

Assignable SW

Camera Config

OPERATION

Format

Format Media

Input/Output

Super Impose

LCD

Rec Function

Assignable SW

VF Setting

Marker

Gain Switch

TLCS

Zebra

Display On/Off

“!” LED

Auto Iris

Shot ID

Shot Display

White Setting

Offset White

Shutter 

Time Zone

Clip

Plan.Metadata

USB
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PAINT Menu (see page 129) 

MAINTENANCE Menu (see page 135) 

FILE Menu (see page 150) 
PAINT

Switch Status

White

Black

Flare

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Detail(SD Mode)

Aperture

Skin Detail

Matrix

Multi Matrix

V Modulation

Low Key Saturation

Noise Suppress

MAINTENANCE

White Shading

Black Shading

Battery

Audio

WRR Setting

Timecode

Essence Mark

Camera Config

Preset White

White Filter

DCC Adjust

Auto Iris2

Genlock

ND Comp

Lens

Auto Shading

APR

Trigger Mode

Network Setting

Wi-Fi Setting

Clock set

Language

Hours Meter

Version

FILE

User

All

Scene

Reference

Lens
Setup Menu Organization and Levels
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To display the setup menu
Set the MENU ON/OFF switch to ON, or press 
the MENU button.
The camcorder enters menu mode and the menu 
list appears on the screen.
A cursor appears over the first two characters of the 
most recently used menu, and the corresponding 
menu item selection area appears to the right.

Example: When the cursor is positioned at the 
OPERATION menu

Note

The setup menu cannot be used when the camcorder is in 
focus magnification mode. Exit focus magnification 
mode by pressing the assignable switch to which the 
Focus Mag function has been assigned.

To make menu settings

1 Turn the MENU knob, or press the J or 
j button, to move the cursor to the item 
that you want to set.
A list of selectable menu items appears in the 
menu item selection area to the right of the 
icon.

2 Press the MENU knob or the SET 
button.
The cursor moves to the menu item selection 
area.
You can also move the cursor to the menu 
item selection area by pressing the k 
button.

• The menu item selection area displays a 
maximum of seven lines. You can scroll 
through menus with more than seven lines 
by moving the cursor up and down.
Triangles appear at the upper right and 
lower right of the menu item selection area 
to indicate that a menu is scrollable.

3 Turn the MENU knob, or press the J or 
j button, to move the cursor to the item 
that you want to set, and then confirm 
by pressing the MENU knob or the SET 
button.
The sub-items area appears to the right of the 
menu item selection area, and the cursor 
moves to the first sub-item.

Basic Setup Menu 
Operations

Menu item selection area

Menu list

Appears when more menu items 
are available below the last line. 
(v appears when more menu items 
are available above the first line.)

Menu item selection area
• B appears to the right when more detailed 

sub-items are available.
• Settings appear to the right when a menu 

item has no sub-items.
• You can select  to return to the 

previous level. 

Sub-items area
• Displays sub-items and their current 

settings
• To return to the previous level, select  

press the K button, or push the MENU 
CANCEL/PRST/ESCAPE switch down to 
the ESCAPE side.
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4 Turn the MENU knob, or press the J or 
j button, to move the cursor to the sub-
item that you want to set, and then 
confirm the selection by pressing the 
MENU knob or the SET button.
The settings of the selected sub-item appear, 
and the cursor moves to the currently 
selected value.

• The settings area displays a maximum of 
seven lines. You can scroll through menus 
with more than seven sub-items by moving 
the cursor up and down. Triangles appear at 
the upper right and lower right of the 
settings area to indicate that a sub-item 
menu is scrollable.

• For sub-items with a large settings range 
(for example, –99 to +99), the settings area 
is not displayed. Instead, the sub-item name 
is highlighted to indicate that the sub-item 
can be set.

5 Turn the MENU knob, or press the J or 
j button, to select the value to set, and 
then confirm by pressing the MENU 
knob or the SET button.
The setting is changed, and the display is 
updated to show the new setting.
If you select [Execute] for an executable 
item, the corresponding function is executed.

Items that require confirmation before execution
In step 3, the menu disappears and a confirmation 
message appears if you select an item that 
requires confirmation before execution. Follow 
the instructions in the message to execute or 
cancel the operation.

To enter text 
Some items, such as time data or file names, must 
be set by entering text. When you select one of 
these items, the text entry area is highlighted, with 
“SET” displayed to the right.

1 Turn the MENU knob, or press the J or 
j button, to select a character, and then 
confirm by pressing the MENU knob or 
the SET button.
The cursor moves to the next position.
To return to the previous position, push the 
MENU CANCEL/PRST/ESCAPE switch 
down to the ESCAPE side.

2 Select characters for all positions up to 
the last.
The cursor moves to “SET”.

3 Press the MENU knob or the SET 
button.
This confirms the setting.

To cancel the setting change
Push the MENU CANCEL/PRST/ESCAPE 
switch down to the ESCAPE side.

To reset a setting to the initial value

1 Before a setting is changed or after a 
setting change is cancelled, push the 
MENU CANCEL/PRST/ESCAPE 
switch up to the CANCEL/PRST side.

2 When the message to confirm whether 
the current setting is reset to the initial 
value, push the MENU CANCEL/
PRST/ESCAPE switch up to the 
CANCEL/PRST side again.
The current setting is reset to the initial value.

To exit the menu
Set the MENU ON/OFF switch to OFF or press 
the MENU button.
The normal camera picture reappears.

Settings area
Basic Setup Menu Operations
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The USER menu consists of the following items when it is in the factory default state.
• Format Media (see page 113)
• Input/Output (see page 114)
• Rec Function (see page 116)
• Assignable Sw1) (see page 117)
• Clip (see page 125)
• Camera Config2) (see page 142)

1) Excluding sub-item <0>
2) Contains only User Menu Only as sub-item

You can change the configuration of the USER menu by adding desired menu items and arranging them 
in a desired order. 
For details, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 
Camcorder”).

Menu List

USER Menu (Factory Default Configuration)
Menu List 111Download from Www.Somanuals.com. All Manuals Search And Download.
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Settings in bold are the factory default values.

OPERATION Menu

OPERATION
Menu items Sub-item Settings Description
Format
Specifies the 
camcorder’s 
recording mode, 
operating mode and 
recording format.

File System UDF/FAT Switches between UDF and FAT as the 
recording mode (execute by selecting 
Execute). 

HD/SD HD/SD Switches between HD or SD as the 
operating mode (execute by selecting 
Execute).

Note

When the optional CBK-MD01 is not 
installed, [SD] cannot be selected. (SD 
recording is not allowed.)

HD System Line 1080/720 When the operating mode is HD, sets 
the number of system lines to 1080 or 
720 (execute by selecting Execute).

System Frequency The available settings 
vary depending on the 
settings in HD/SD, HD 
System Line, and 
Country.

Selects the system frequency (execute 
by selecting Execute).

59.94i/29.97P/23.98P When the HD/SD setting is [HD], the 
HD System Line setting is [1080], and 
the Country setting is other than [PAL 
Area].

50i/25P • When the HD/SD setting is [HD], the 
HD System Line setting is [1080], and 
the Country setting is [PAL Area].

• When the HD/SD setting is [SD], and 
the Country setting is [PAL Area].

59.94P/29.97P/23.98P When the HD/SD setting is [HD], the 
HD System Line setting is [720], and 
the Country setting is other than [PAL 
Area].

50P/25P When the HD/SD setting is [HD], the 
HD System Line setting is [720], and 
the Country setting is [PAL Area].

59.94i/29.97P When the HD/SD setting is [SD], and 
the Country setting is other than [PAL 
Area].
Menu List
Download from Www.Somanuals.com. All Manuals Search And Download.



C
hapter 6  M

enu and D
etailed S

ettings
Format
Specifies the 
camcorder’s 
operating mode and 
recording format.

Rec Format The available settings 
vary depending on the 
settings in UDF/FAT, HD/
SD, HD System Line, and 
System Frequency.

Selects the recording format (execute by 
selecting Execute).

HD422 50/HD420 HQ • When the UDF/FAT setting is [UDF], 
the HD/SD setting is [HD], the HD 
System Line setting is [1080].

• When the UDF/FAT setting is [UDF], 
the HD/SD setting is [HD], the HD 
System Line setting is [720], and the 
System Frequency setting is 
[23.98P].(When the System 
Frequency setting is [25P], [29.97P], 
or [50P], this setting is fixed to 
[HD422 50].)

HQ 1920/HQ 1440 When the UDF/FAT setting is FAT, the 
HD/SD setting is [HD], the HD System 
Line setting is [1080], and the System 
Frequency setting is [29.97P] or [25P].

HQ 1920/HQ 1440/
SP 1440

When the UDF/FAT setting is FAT, the 
HD/SD setting is [HD], the HD System 
Line setting is [1080], and the System 
Frequency setting is other than [29.97P] 
and [25P].

HQ 1280 When the UDF/FAT setting is FAT, the 
HD/SD setting is [HD], and the HD 
System Line setting is [720].

IMX50/DVCAM When the UDF/FAT setting is [UDF] 
and the HD/SD setting is [SD].

DVCAM When the UDF/FAT setting is [FAT] and 
the HD/SD setting is [HD].

Aspect Ratio (SD) 16:9/4:3 Selects the aspect ratio when SD mode 
is selected (execute by selecting 
Execute).

Audio 
Length(IMX)

24bit/16bit Selects the audio bit rate for recording 
in IMX format.

Country NTSC Area/NTSC(J) 
Area/PAL Area

Selects the area of use (execute by 
selecting Execute).

Format Media
Executes a media 
format.

Media(A) Execute/Cancel Initializes the SxS memory card in slot 
A (execute by selecting Execute).

Media(B) Execute/Cancel Initializes the SxS memory card in slot 
B (execute by selecting Execute).

OPERATION
Menu items Sub-item Settings Description
Menu List 113Download from Www.Somanuals.com. All Manuals Search And Download.



114

C
hapter 6  M

enu and D
etailed S

ettings
Input/Output
Makes settings 
related to I/O signals.

In FAT mode
Output& i.LINK

HD&HDV/SD&HDV/
SD&DV

Selects the signals output from the 
video connectors and the i.LINK (HDV/
DV) connector.
When the HD/SD setting is SD, 
“SD&DV” or “SD” is selected.

In UDF mode
Output

HD/SD

23.98P Output PsF/Pull Down When the video format is HQ 1920/
23.98P or HQ 1440/23.98P, selects 
whether to use progressive output (PsF) 
or pulldown output (Pull Down).

Source Select a) Camera/i.LINK
/External

Selects whether to use the camera 
picture (Camera), the i.LINK input (in 
FAT mode only) or the SDI/composite 
input (External) as the video input 
source.

Notes

• When Rec Source is assigned to the 
ASSIGN. 2 switch, this setting is 
disabled. 

• Changing the setting of File System 
>UDF/FAT resets this item to 
[Camera] (factory default setting).

Ext Video Source a) HD SDI/SD SDI/
Composite

Selects the external input signal.
HD-SDI: HDSDI signals (in HD mode 

only)
SD-SDI: SDSDI signals
Composite: Composite signals

i.LINK I/O Enable/Disable Selects whether to enable or disable 
input and output of signals via the 
i.LINK (HDV/DV) connector.
When Enable is selected, you can 
execute auto black balance adjustment 
during i.LINK output.

SDI Output On/Off Turns on or off the output of signals 
from the HD/SD SDI OUT connector.

SDI Out Super On/Off Turns on or off the superimposition of 
text information on the output of the 
HD/SD SDI OUT connector

Video Out Super On/Off Turns on or off the superimposition of 
text information on the output of the 
VIDEO OUT connector.

Live & Play On/Off Turns Live & Play function on or off.

OPERATION
Menu items Sub-item Settings Description
Menu List
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Input/Output
Makes settings 
related to I/O signals.

Down Converter Crop/Letter/Squeeze Selects the signal conversion mode for 
output of SD signals.
Crop: Crop the edges of the 16:9 

picture and output as a 4:3 picture.
Letter: Mask the top and bottom of the 

4:3 picture and display in the center 
of the screen as a 16:9 picture.

Squeeze: Squeeze the 16:9 picture 
horizontally and output as a 4:3 
picture.

Wide ID Through/Auto Selects whether to add a wide ID signal 
to the SD output signal.
Through: Output without adding a 

wide ID signal.
Auto: Add and output a wide ID signal 

when the Down Converter setting is 
Squeeze.

Wide 
Mode(EXT) a)

Auto/16:9 When the input signal is SD, select the 
method that determines whether the 
signal is treated as a wide signal.
Auto: When wide a ID signal is 

detected in the input signal, treat 
the signal as a wide signal and set 
the up-converter operating mode to 
squeeze mode. When a wide ID 
signal is not detected, set the 
upconverter operating mode to 
edge crop mode and do not record a 
wide ID signal.

16:9: Always treat the signal as a wide 
signal and set the upconverter 
operating mode to squeeze mode.

Setup 
Remove(EXT) a)

7.5%/0.0% When the Country setting is other than 
[PAL Area], selects whether to remove 
the setup level of analog input video 
signals. 
7.5%: Remove the setup.
0.0%: Do not remove the setup.

Super Impose
Makes settings 
related to 
superimposed text 
and markers.

Super(VF Display) On/Off When the setting of Input/Output >SDI 
Out Super or Video Out Super is On, 
superimpose text information on the 
output from the HD/SD SDI OUT 
connector, and VIDEO OUT connector, 
as specified (On or Off) for each item.

Super(Menu) On/Off
Super(Timecode) On/Off

Super(Marker) On/Off When the setting of Input/Output 
>Video Out Super is On, specifies 
whether to superimpose markers on the 
output from the VIDEO OUT 
connector.

LCD LCD Color –99 to ±0 to +99 Adjusts the LCD color.
LCD 
Marker&Zebra

On/Off Turns the marker and zebra display in 
the LCD monitor on or off.

OPERATION
Menu items Sub-item Settings Description
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Rec Function
Makes settings 
related to special 
recording modes.

Note

When Picture Cache 
is assigned to an 
assignable switch, 
this item is disabled 
(displayed in grey).

Slow & Quick On/Off Turns the Slow & Quick Motion 
function on or off. (When this is set to 
On, the Picture Cache Rec, Interval Rec, 
and Frame Rec sub-items are set to Off.)

Frame Rate The available settings 
vary depending on the 
Format >HD System Line 
setting.

When the Slow & Quick setting is On, 
sets the frame rate for Slow & Quick 
Motion shooting.

When Format >Country is 
set to other than [PAL 
Area] in UDF mode or in 
FAT mode: 1 to 30
When Format >Country is 
set to [PAL Area] in UDF 
mode: 1 to 25

When the HD System Line setting is 
1080.

When Format >Country is 
set to other than [PAL 
Area] in UDF mode or in 
FAT mode: 1 to 30 to 60
When Format >Country is 
set to [PAL Area] in UDF 
mode: 1 to 25 to 50

When the HD System Line setting is 
720.

Clip Continuous 
Rec

On/Off Turns the Clip Continuous Rec function 
on or off. (When this is set to On, the 
Slow & Quick, Picture Cache Rec, 
Interval Rec, and Frame Rec sub-items 
are set to Off.)

Picture Cache Rec On/Off Turns the picture cache function on or 
off. (When this is set to On, the Slow & 
Quick, Interval Rec, Frame Rec sub-
items are set to Off.) 

P. Cache Rec Time 0-2sec/2-4sec/4-6sec/
6-8sec/8-10sec/10-12sec/
12-14sec/13-15sec

When the Picture Cache Rec setting is 
On, set the picture cache time.

Interval Rec On/Off Turns the Interval Rec function on or 
off. (When this is set to On, the Slow & 
Quick, Picture Cache Rec, and Frame 
Rec sub-items are set to Off.)

Frame Rec On/Off Turns the Frame Rec function on or off. 
(When this is set to On, the Slow & 
Quick, Picture Cache Rec, and Interval 
Rec sub-items are set to Off.)

Number of Frames The available settings 
vary depending on the 
settings in Format >HD 
System Line and Format 
>System Frequency.

When Interval Rec or Frame Rec is set 
to On, specifies the number of frames to 
shoot in one Interval Rec or Frame Rec 
take.

2frame/6frame/12frame When the HD System Line setting is 
720, and the System Frequency setting 
is 59.94P or 50P.

1frame/3frame/6frame/
9frame

When the HD System Line setting is 
other than 720, or the System Frequency 
setting is other than 59.94P or 50P.

OPERATION
Menu items Sub-item Settings Description
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Rec Function
Makes settings 
related to special 
recording modes.

Interval Time 1/2/3/4/5/6/7/8/9/10/15/
20/30/40/50 (sec)
1/2/3/4/5/6/7/8/9/10/15/
20/30/40/50 (min) 1/2/3/
4/6/12/24 (hour)

When the Interval Rec setting is On, 
sets the interval for Interval Rec 
shooting.

Pre-Lighting Off/2sec/5sec/10sec If you want the video light to be turned 
on before Interval Rec shooting, select a 
number of seconds before the start of 
shooting. If you do not want it to be 
turned on, select Off.

Live Logging d) Live/View In UDF mode: Selects the Live 
Logging operation mode.

In FAT mode: Fixed to [Live] (live 
mode).

Note

When one of Frame Rec, Interval Rec, 
and Clip Continuous Rec modes is 
selected, [View] cannot be selected.

For details on Live Logging functions, 
refer to the Supplement supplied in the 
CD-ROM (labeled “Manuals for Solid-
State Memory Camcorder”).

Assignable SW
Assigns functions to 
assignable switches.

See “Assigning 
Functions to 
Assignable Switches” 
(page 155) for more 
information about 
assigning functions.

<0> See page 155. Assigns function to ASSIGN. 0 switch.
<1> Assigns function to ASSIGN. 1 switch.
<2> Assigns function to ASSIGN. 2 switch.
<3> Assigns function to ASSIGN. 3 switch.
<4> Assigns function to ASSIGNABLE 4 

switch.
<5> Assigns function to ASSIGNABLE 5 

switch.
RET Assigns function to RET button on the 

lens.
C. Temp Assigns function to COLOR TEMP. 

button.
Zoom Speed 0 to 20 to 99 When Zoom has been assigned to the 

ASSIGNABLE 4 or 5 switch, specifies 
the zoom speed.

OPERATION
Menu items Sub-item Settings Description
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VF Setting
Makes settings 
related to the 
viewfinder screen.

Color b) –99 to ±0 to +99 Adjusts the density of the colors 
displayed in the viewfinder screen.

Mode b) Color/B&W Selects the display mode of the 
viewfinder.
Color: Color
B&W: Monochrome

Peaking Type b) Normal/Color/Both Selects the peaking type.
Normal: Normal peaking
Color: Color peaking
Both: Both

Peaking 
Frequency b)

Normal/High Selects Normal or High as the peaking 
frequency.

Peaking Color b) White/Red/Yellow/Blue When the Peaking Type setting is Color, 
selects the peaking color from among 
White, Red, Yellow, and Blue.

VF Detail Level c) –99 to ±0 to +99 Adjusts the detail level (set on the 
camcorder) of the viewfinder

Color Peaking 
Level b)

Low/Mid/High When the Peaking Type setting is Both, 
selects the color peaking level from 
among Low, Mid, and High.

Marker
Makes settings 
related to marker 
display in the 
viewfinder screen.

Setting On/Off Turns all markers on or off.

Note

When Marker is assigned to the ASSIGN. 
2 switch, this setting is disabled. 

Center Marker 1/2/3/4/Off When the center marker is displayed, 
selects the type. Select Off if you do not 
want to display the marker.

Note

When three of Safety Zone, User Box, 
Guide Frame, and 100% Marker are set to 
[On], this setting cannot be turned on.

Center H Position –40 to 0 to 40 Specifies the horizontal position of the 
center marker.

Center V Position –40 to 0 to 40 Specifies the vertical position of the 
center marker.

Safety Zone On/Off Turns the safety zone display on or off.

Note

When three of Center Marker, User Box, 
Guide Frame, and 100% Marker are set to 
[On], this setting cannot be turned on.

Safety Area 80%/90%/92.5%/95% Selects the safety zone range.
Aspect Marker Line/Mask/Off When an aspect marker is to be 

displayed, selects the display method. 
Select Off if you do not want to display 
the marker.
Line: Show as white lines.
Mask: Display by lowering the video 

signal level of areas outside the 
marker range.

Aspect Select 15:9/14:9/13:9/4:3/
1.66:1/1.85:1/2.35:1/2.4:1

Selects the aspect ratio of the marker.

OPERATION
Menu items Sub-item Settings Description
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Marker
Makes settings 
related to marker 
display in the 
viewfinder screen.

100% Marker On/Off Turns the 100% safety zone display on 
or off.

Note

When three of Center Marker, Safety Zone, 
User Box, and Guide Frame are set to [On], 
this setting cannot be turned on. 

Aspect Mask 0% to 30% to 90% (10% 
step) 

When the Aspect Marker setting is 
Mask, specifies the video signal level of 
areas outside the marker range as a 
percentage value relative to the video 
signal level of areas inside the marker 
range.

User Box On/Off Turns the box cursor display on or off.

Note

When three of Center Marker, Safety Zone, 
Guide Frame, and 100% Marker are set to 
[On], this setting cannot be turned on.

User Box Width 40 to 500 to 999 Specifies the box cursor width (distance 
from the center to the left and right 
edges).

User Box Height 70 to 500 to 999 Specifies the box cursor height 
(distance from the center to the top and 
bottom edges).

User Box H 
Position

–479 to 0 to 479 Specifies the horizontal position of the 
box cursor center.

User Box V 
Position

–464 to 0 to 464 Specifies the vertical position of the box 
cursor center.

Guide Frame On/Off Turns display of the guide frame on or 
off.

Note

When three of Center Marker, Safety Zone, 
User Box, and 100% Marker are set to 
[On], this setting cannot be turned on.

Gain Switch
Makes settings 
related to the GAIN 
switch.

Gain Low –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies the gain value for the 
L position of the GAIN switch.

Gain Mid –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies the gain value for the 
M position of the GAIN switch.

Gain High –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies the gain value for the 
H position of the GAIN switch.

Gain Turbo –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies the gain value for the Turbo 
Gain function, which can be assigned to 
an assignable switch.

Shockless Gain On/Off Turns shockless gain (a function that 
switches smoothly when the gain is 
switched) on or off.

OPERATION
Menu items Sub-item Settings Description
Menu List 119Download from Www.Somanuals.com. All Manuals Search And Download.



120

C
hapter 6  M

enu and D
etailed S

ettings
TLCS
Makes settings 
related to total level 
control.

Mode Backlight/Standard/
Spotlight

Selects the auto iris mode used when the 
TLCS system is activated.
Backlight: Backlight mode (lessens the 

blackout of the main subject that 
occurs under backlit conditions)

Standard: Standard mode
Spotlight: Spotlight mode (lessens the 

whiteout of the main subject that 
occurs under a spotlight) 

Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video) used 
when the TLCS system is activated. 
(Larger values specify quicker reaction 
times.)

AGC On/Off Turns the AGC (auto gain control) 
function on or off.

AGC Limit 3dB/6dB/9dB/12dB/
18dB

Specifies the maximum gain used when 
AGC is on.

AGC Point F5.6/F4/F2.8 Specifies the F value where control by 
auto iris switches to control by AGC, 
used when AGC is on.

Auto Shutter On/Off Turns the auto shutter function on or off.
Auto Shutter Limit 1/100 / 1/150 / 1/200 / 

1/250
Selects the maximum shutter speed used 
when auto shutter is on.

Auto Shutter Point F5.6/F8/F11/F16 Specifies the F value where control by 
auto iris switches to control by auto 
shutter, used when auto shutter is on.

Zebra
Makes settings 
related to zebra 
displays.

Zebra Select 1/2/BOTH Selects the zebra pattern type (Zebra1, 
Zebra2, Both).

Zebra1 Level 50% to 70% to 107% Specifies the Zebra1 display level.
Zebra1 Aperture 
Level

1 to 10% to 20% Specifies the Zebra1 aperture level.

Zebra2 Level 52% to 100% to 109% Specifies the Zebra2 display level.
Display On/Off
Selects the items to 
display in the 
viewfinder screen.

Video Level 
Warnings

On/Off Turns the warnings that appear when the 
video level is too bright or too dark on 
or off.

Brightness Display On/Off Turns the numerical indication of the 
video brightness on or off.

Histogram Display
(In HD mode only)

On/Off Turns the histogram display of video 
signal levels on or off.

Lens Info Meter/Feet/Off Selects whether or not to display the 
depth of field indication and the unit for 
display of the depth of field. 
Meter: Displayed in meters 
Feet: Displayed in feet
Off: Do not display

Focus Position On/Off Turns the indication of the lens focus 
position on or off.

Zoom Position On/Off Turns the indication of the lens zoom 
position on or off.

Audio Level Meter On/Off Turns the display of the audio level 
meters on or off.
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Display On/Off
Selects the items to 
display in the 
viewfinder screen.

Timecode On/Off Turns the display of time data 
(timecode, user bits, counter, duration) 
on or off.

Battery Remain On/Off Turns the indications of the remaining 
battery time and input voltage on or off.

Media Remain On/Off Turns the indication of the remaining 
media capacity on or off.

TLCS Mode On/Off Turns the indication of the TLCS 
operating mode on or off.

Focus Mode On/Off Turns the indication of the focus 
operating mode on or off.

White Balance 
Mode

On/Off Turns the indication of the white 
balance mode on or off.

Filter Position On/Off Turns the indication of the ND filter 
setting on or off.

Iris Position On/Off Turns the indication of the iris position 
on or off.

Gain Setting On/Off Turns the indication of the gain setting 
on or off.

Shutter Setting On/Off Turns the indications of the shutter 
mode and shutter speed on or off.

Color Temp On/Off Turns the indication of the color 
temperature on or off.

Video Format On/Off Turns the indication of the video format 
on or off.

System Line On/Off Turns the indication of the system lines 
on or off.

Rec Mode On/Off Turns the indication of special recording 
modes (S&Q, Interval, Frame Rec, 
Picture Cache Rec) on or off.

Extender On/Off Turns the lens extender indication on or 
off.

WRR RF Level On/Off Turns the indication of the digital 
wireless receiver reception level on or 
off.

Clip Number(PB) On/Off Turns the indication of clip information 
on or off.
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“!” LED c) Gain<!> On/Off Turns on or off the function to light the ! 
indicator when the gain is set to other 
than 0 dB.

Shutter <!> On/Off Turns on or off the function to light the ! 
indicator when the SHUTTER selector 
is set to ON.

White Preset <!> On/Off Turns on or off the function to light the ! 
indicator when the WHITE BAL switch 
is set to PRST.

ATW Run <!> On/Off Turns on or off the function to light the ! 
indicator when White Setting >White 
Switch<B> is set to [ATW].

Extender <!> On/Off Turns on or off the function to light the ! 
indicator when the lens extender is used.

Iris Override <!> On/Off Turns on or off the function to light the ! 
indicator when the reference value of 
auto iris adjustment is not the standard 
value.

Auto Iris
Makes settings 
related to auto iris.

Iris Override On/Off Turns iris override (a setting that opens 
or closes the iris more than normal) on 
or off.

Iris Speed –99 to ±0 to +99 Specifies the iris control speed (speed of 
reaction to changes in the video). 
(Larger values specify quicker reaction 
times.)

Clip High light On/Off Turns on or off the function that 
disregards highlights and forces a flatter 
reaction to high luminance.

Iris Window 1/2/3/4/5/6/Var Selects the auto iris detection window 
type.
Var: Variable

Iris Window 
Indication

On/Off Turns the indication of the auto iris 
detection window frame on or off.

Shot ID
Creates the shot IDs 
superimposed on 
the color bars.

ID-1 Creates ID-1 strings (up to 16 
characters) superimposed.

ID-2 Creates ID-2 strings (up to 16 
characters) superimposed.

ID-3 Creates ID-3 strings (up to 16 
characters) superimposed.

ID-4 Creates ID-4 strings (up to 16 
characters) superimposed.

Shot Display
Selects which shot 
data is 
superimposed on 
the color bars and 
recorded.

Shot Date On/Off Selects whether to superimpose the shot 
date (On) or not (Off).

Shot Time On/Off Selects whether to superimpose the shot 
time (On) or not (Off).

Shot Model Name On/Off Selects whether to superimpose the 
model name (On) or not (Off).

Shot Serial 
Number

On/Off Selects whether to superimpose the 
serial number (On) or not (Off).

Shot ID Select ID-1/ID-2/ID-3/ID-4/Off Selects whether or not to superimpose 
the shot ID set with the Shot ID item 
and which shot ID is superimposed.
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White Setting
Makes settings 
related to auto white 
balance adjustments.

White Switch<B> Memory/ATW Specifies the operating mode selected 
by the B position of the WHITE BAL 
switch.
Memory: Auto white balance
ATW: Auto tracing white balance

Shockless White Off/1/2/3 Specifies the reaction speed when the 
WHITE BAL switch setting is changed. 
Off is an instant reaction, and 1 is faster 
than 2 or 3.

ATW Speed 1/2/3/4/5 Specifies the reaction speed when the 
White Switch<B> setting is [ATW]. 1 is 
the fastest reaction.

AWB Fixed Area On/Off Specifies whether auto white balance is 
executed at the center of the screen.
On: Execute in an area corresponding 

to 25% of the height and width of 
the screen.

Off: Execute in an area corresponding 
to 70% of the height and width of 
the screen.

Filter White 
Memory

On/Off Specifies whether to allocate a white 
balance memory area for each FILTER 
knob position.
On: Allocation a white balance memory 

area for each FILTER knob 
position.

Off: Use A/B memory regardless of the 
filter position.
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Offset White
Makes settings 
related to white 
balance offset values.

Offset White <A> On/Off Specifies whether to add (On) or not to 
add (Off) an offset value to the white 
balance value in memory A.

Warm Cool <A> Approximate color 
temperature

When the setting of Offset White<A> is 
[On], specifies (as a color temperature) 
the offset to add to the white balance 
value in memory A. (Note that the error 
range becomes larger for higher offset 
color temperatures. Adjust while 
viewing the actual video.)

Warm Cool 
Balance<A>

–99 to ±0 to +99 Specifies a more precise color 
temperature, for use when satisfactory 
video cannot be obtained with the Warm 
Cool <A> setting.

Offset White <B> On/Off When this is set to [On], the offset 
adjusted set with this item is added to 
the white balance of channel B.

Warm Cool <B> Approximate color 
temperature

When the setting of Offset White<B> is 
[On], specifies (as a color temperature) 
the offset to add to the white balance 
value in memory B. (Note that the error 
range becomes larger for higher offset 
color temperatures. Adjust while 
viewing the actual video.)

Warm Cool 
Balance<B>

–99 to ±0 to +99 Specifies a more precise color 
temperature, for use when satisfactory 
video cannot be obtained with the Warm 
Cool <B> setting.

Shutter 
Makes settings 
related to the shutter 
setting.

Shutter Select Second/Degree Specifies the unit used to select shutter 
speeds.
Second: Select in units of seconds.
Degree: Select in units of degrees.

Slow Shutter On/Off Turns the SLS mode on or off.
SLS Frames 2Frames/3Frames/

4Frames/Frames/
6Frames/7Frames/
8Frames/16Frames

Selects the number of accumulated 
frames in SLS mode.

Time Zone
Specifies the time 
zone.

Zone –12:00 to +0:00 to +14:00 
(in steps of 30 minutes) 

Specifies a difference from UTC 
(Greenwich Mean Time) in units of 
30 minutes.
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Clip
Make settings for clip 
name or clip 
management.

Note

Do not assign clip 
names that begin with 
the “.” (period) 
symbol.
Clips with names in 
which the first 
character is “.” cannot 
be viewed on the 
application software 
for computers.

Auto Naming In Fat mode: Title/Plan
In UDF mode: C****/

Title/Plan

Selects the clip naming format.
C****: XDCAM standard name (In 

UDF mode only) 
Title: Name specified by Title Prefix
Plan: Name specified in planning 

metadata (if no name is specified in 
planning metadata, the name 
specified by Title Prefix is 
selected.)

OPERATION
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Clip
Make settings for clip 
name or clip 
management.

Note

Do not assign clip 
names that begin with 
the “.” (period) 
symbol.
Clips with names in 
which the first 
character is “.” cannot 
be viewed on the 
application software 
for computers.

Title Prefix Text input Specifies the title part (4 to 46 
alphanumeric characters) of clip titles.
When the currently specified title is 
eight characters or fewer in length, the 
entire title appears. When the title is 
longer than eight characters, the first 
seven characters appear and a “···” 
symbol appears in place of the eighth 
character.
Displays the Character Set screen.

Character Set screen configuration
• Character selection area (three lines)
Select the character to insert at the title 
prefix cursor position.
!#$%()+.-.;=@[]^_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
• Cursor operation area (one line)
Space: Changes the character at the 

cursor position to a space
INS: Inserts a space at the cursor 

position 
DEL: Deletes the character at the cursor 

position 
T: Moves the cursor to the left
t: Moves the cursor to the right
ESC: Cancels the change and return to 

the normal menu 
END: Executes the change and return to 

the normal menu
• Title prefix area (one line)
An area to enter the title

To set titles
1 Turn the MENU knob or press the 

arrow buttons to select a character, 
highlighting it, in the character 
selection area, and then press the 
MENU knob or the SET button to 
insert it at the cursor position in the 
title prefix area. (The cursor moves to 
the right.)

2 Repeat step 1 to add more characters 
to the title (using Space, INS, and 
DEL as required).

3 When you have finished entering the 
title, select END to close the 
Character Set screen.
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Clip
Make settings for clip 
name or clip 
management.

Note

Do not assign clip 
names that begin with 
the “.” (period) 
symbol.
Clips with names in 
which the first 
character is “.” cannot 
be viewed on the 
application software 
for computers.

Number Set 00001 to 99999 Specifies the initial value of the numeric 
part (five digits) of clip names (The 
numeric part of clip names is limited to 
four digits number if Auto Naming is 
set to other than [Plan] or if planning 
metadata is invalid though Auto 
Naming is set to [Plan].)

Name Display Off/Viewfinder/LCD 
Status/Both

Selects whether or not to display the 
name of the next clips to be recorded (in 
E-E mode), and where to display the 
name.
Off: Do not display
Viewfinder: Display on the viewfinder 

screen 
LCD Status: Display on the LCD 

monitor (with the display mode se 
to STATUS) 

Both: Display on both the viewfinder 
screen and the LCD monitor

Note

If  a clip with the same name as the next 
clip to be recorded already exists on the 
recording media, then immediately after 
recording begins the clip name is displayed 
with a different serial number (when the 
selection is other than Off).

Update Media<A>/Media<B> Updates the management files on the 
media in the selected slot (execute by 
selecting Execute).

OPERATION
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a) When the optional CBK-HD02 is installed
b) When the CBK-VF01 is used.
c) When an HDVF series viewfinder is used.
d) When the optional CBK-UPG01 is installed.

Plan.Metadata
Makes settings for 
operating planning 
metadata.

Load/Slot(A) Execute/Cancel Executes load of planning metadata 
from the SxS memory card in slot A. 
Select [Execute] to show the list of the 
planning metadata files stored in the slot A 
SxS memory card and select a file to 
execute the load. 

Load/Slot(B) Execute/Cancel Executes load of planning metadata 
from the SxS memory card in slot B. 
Select [Execute] to show the list of the 
planning metadata files stored in the slot 
B SxS memory card and select a file to 
execute the load. 

Load/USB
(in UDF mode 
only)

Execute/Cancel Executes load of planning metadata 
from the USB flash drive connected to 
the external device connector. 
Select [Execute] to show the list of the 
planning metadata files stored in the 
USB flash drive and select a file to 
execute the load. 

Properties Execute/Cancel Displays the detailed information in the 
planning metadata loaded on the 
camcorder (execute by selecting 
[Execute]).

Clear Execute/Cancel Clears the planning metadata loaded on 
the camcorder (execute by selecting 
[Execute]). 

Clip Name Disp Title1(ASCII)/
Title2(UTF-8)

Selects the display mode of the clip 
name specified in planning metadata 
(see page 89).

USB
Makes settings for 
operating a  USB 
flash drive (in UDF 
mode only) 

Memory Rec Enable/Disable Select whether to enable or disable the 
record of proxy data to a USB flash 
drive.

Copy Current Clip Execute/Cancel Executes the copy of the proxy data for 
the current clip to a USB flash drive 
(execute by selecting [Execute]). 

Copy All Clips Execute/Cancel Executes the copy of the proxy data for 
all clips stored in the selected SxS 
memory card to a USB flash drive 
(execute by selecting [Execute]). 

Del All Memory 
Clips

Execute/Cancel Executes the clear of the proxy data for 
all clips copied to a USB flash drive 
(execute by selecting [Execute]).

Format USB 
Memory

Execute/Cancel Executes the FAT32 format of a USB 
flash drive (execute by selecting 
[Execute]).
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PAINT Menu

PAINT
Menu items Sub-item Settings Description
Switch Status
Turns various signal 
correction functions 
and a test signal on or 
off.

Gamma On/Off Turns gamma correction on or off.

Black Gamma On/Off Turns black gamma correction on or 
off.

Matrix On/Off Turns linear matrix correction and 
user matrix correction on or off.

Knee On/Off Turns knee correction on or off.

White Clip On/Off Turns white clip correction on or 
off.

Detail On/Off Turns detail correction on or off.

Aperture On/Off Turns aperture correction on or off.

Flare On/Off Turns flare correction on or off.

Test Saw On/Off Turns the test saw signal on or off.

White
Sets the color 
temperature, and 
performs manual white 
balance adjustment.

Color Temp <A> 1500K to 3200K to 
50000K

Displays the white balance color 
temperature saved in memory A.

Color Temp BAL 
<A>

–99 to ±0 to +99 Specifies the white balance gain 
values saved in memory A (linked R 
gain and B gain).

R Gain <A> –99 to ±0 to +99 Specifies the white balance R gain 
value saved in memory A.

B Gain <A> –99 to ±0 to +99 Specifies the white balance B gain 
value saved in memory A.

Color Temp <B> 1500K to 3200K to 
50000K

Displays the white balance color 
temperature saved in memory B.

Color Temp BAL 
<B>

–99 to ±0 to +99 Specifies the white balance gain 
values saved in memory B (linked R 
gain and B gain).

R Gain <B> –99 to ±0 to +99 Specifies the white balance R gain 
value saved in memory B.

B Gain <B> –99 to ±0 to +99 Specifies the white balance B gain 
value saved in memory B.

Black
Specifies the black 
level (level of the 
unilluminated parts of 
the video).
You can achieve a 
desired look by 
adjusting the black 
level for deeper or 
shallower blacks.

Master Black –99 to ±0 to +99 Specifies the master black level.

R Black –99 to ±0 to +99 Specifies the R black level.

B Black –99 to ±0 to +99 Specifies the B black level.
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Flare
Makes settings related 
to flare.
Flare is light generated 
from a bright image 
region that spreads 
broadly across the 
image, adding light to 
dark regions and 
reducing contrast. It is 
caused by reflection 
inside the lens system.

Flare On/Off Turns flare correction on or off.

Master Flare –99 to ±0 to +99 Sets the master flare correction 
level.

R Flare –99 to ±0 to +99 Sets the R flare correction level.

G Flare –99 to ±0 to +99 Sets the G flare correction level.

B Flare –99 to ±0 to +99 Sets the B flare correction level.

Gamma
Makes settings related 
to gamma.
Gamma correction 
allows you to 
significantly alter the 
impression made by the 
video by adjusting the 
contrast.

Gamma On/Off Turns gamma correction on or off.

Step Gamma 0.35 to 0.45 to 0.90 (0.05 
step) 

Specifies a gamma correction value 
in steps of 0.05

Master Gamma –99 to ±0 to +99 Specifies the master gamma level.

R Gamma –99 to ±0 to +99 Specifies the R gamma level.

G Gamma –99 to ±0 to +99 Specifies the G gamma level.

B Gamma –99 to ±0 to +99 Specifies the B gamma level.

Gamma Select The available settings 
vary depending on the 
setting in Gamma 
Category (see 
“Description”).

Select the gamma table to use in 
gamma correction.
When Gamma Category is STD:
1 DVW: DVW camcorder 

equivalent
2 ×4.5: ×4.5 gain
3 ×3.5: ×3.5 gain
4 240M: SMPTE-240M equivalent
5 R709: ITU-R709 equivalent 

(default setting)
6 ×5.0: ×5.0 gain
When Gamma Category is HG:
1 3250: Condense 325% video input 

to 100% video output
2 4600: Condense 460% video input 

to 100% video output
3 3259: Condense 325% video input 

to 109% video output
4 4609: Condense 460% video input 

to 109% video output (default 
setting)

Gamma Category STD/HG Selects use of standard gamma 
(STD) or HyperGamma (HG).

Black Gamma
Makes settings related 
to black gamma 
correction.
Black gamma 
correction allows you 
to reproduce gradations 
and color nuances in 
black or near-black 
(dark) parts of the 
picture.

Black Gamma On/Off Turns black gamma correction on or 
off.

Gamma Level –99 to ±0 to +99 Specifies the master black gamma 
level.

Range Low/L Mid/H.Mid/High Selects the black gamma correction 
effective range.
LOW: 0 to 3.6%
L.MID: 0 to 7.2%
H MID: 0 to 14.4%
HIGH: 0 to 28.8%
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Knee
Makes settings related 
to knee correction.
Knee correction is 
processing that 
prevents washout by 
compressing the bright 
parts of the video 
according to an upper 
limit for the dynamic 
range of the recorded 
and output picture. The 
signal level where knee 
processing begins is 
called the “knee point”, 
and the slope of knee 
compression is called 
the “knee slope”.

Knee On/Off Turns knee correction on or off.

Knee Point 50.0% to 95.0% to 
109.0%

Specifies the knee point.

Knee Slope –99 to ±0 to +99 Specifies the knee slope.

Knee Saturation On/Off Turns the knee saturation function 
on or off.

Knee Saturation 
Level 

–99 to ±0 to +99 Specifies the knee saturation level.

White Clip
Makes settings related 
to white clipping 
adjustments.
White clipping is 
processing that limits 
the maximum level of 
video output signals. 
The maximum video 
signal output value is 
called the “white clip 
level”.

White Clip On/Off Turns white clipping adjustment on 
or off.

Level [NTSC Area] or [NTSC 
Area(J)] is selected for 
Country
90.0% to 108.0% to 
109.0%
[PAL Area] is selected for 
Country
90.0% to 105.0% to 
109.0% 

Specifies the white clip level.

PAINT
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Detail(HD Mode)/
Detail(SD Mode)
Makes settings related 
to details adjustments 
in HD mode and SD 
mode.
Detail adjustment is 
processing that 
improves the clarity of 
the video by adding 
detail signals to the 
edges of the subject.

Detail On/Off Turns detail adjustment on or off.

Level –99 to ±0 to +99 Specifies the detail level.

H/V Ratio –99 to ±0 to +99 Specifies the mix ratio between the 
H detail level and the V detail level.

Crispening –99 to ±0 to +99 Specifies the crispening level.

Level Depend On/Off Turns the level depend adjustment 
function on or off.

Level Depend Level –99 to ±0 to +99 Specifies the level depend level.

Frequency –99 to ±0 to +99 Specifies the central frequency for H 
detail signals. Larger values give 
finer details.

Knee Aperture On/Off Turns the knee aperture function on 
or off.

Knee Aperture Level –99 to ±0 to +99 Specifies the knee aperture level.

Limit –99 to ±0 to +99 Specifies the detail limiter values for 
both the white-side and black-side 
direction.

White Limit –99 to ±0 to +99 Specifies the white-side detail 
limiter value.

Black Limit –99 to ±0 to +99 Specifies the black-side detail 
limiter value.

V-BLK Limit –99 to ±0 to +99 Specifies the black-side V detail 
limiter value.

V Detail Creation NAM/G/R+G/Y Selects the source signal used to 
generate the V detail signal.
NAM: A V detail signal created 

from the R signal, or a V detail 
signal created from the G 
signal, or a V detail signal 
created from the B signal, 
whichever is the signal with the 
highest level

G: G signal
G+R: Composite signal comprising 

the G signal and R signal in a 
1:1 ratio

Y: Y signal

Cross Color
(in SD mode only)

–99 to ±0 to +99 Sets the cross color reduction level 
for details.

Note

When Detail is set to [Off] or 
OPERATION >Format >Country is set 
to [Pal Area], this setting is disabled.
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Aperture
Makes settings related 
to aperture correction.
Aperture correction is 
processing to improve 
resolution by adding 
high-frequency 
aperture signals to the 
video signal, which 
corrects degeneration 
due to high-frequency 
characteristics.

Aperture On/Off Turns aperture correction on or off.

Level –99 to ±0 to +99 Sets the aperture level.

Skin Detail
Makes settings related 
to skin detail 
correction.
Skin detail correction is 
processing that 
increases or decreases 
the detail level of a 
specified color range 
(skin tone range), for 
the purpose of 
obtaining attractive 
reproduction of skin 
tones.

Skin Detail On/Off Turns skin detail correction on or 
off.

Area Detection Color detection screen Detects the color to be targeted by 
skin detail correction.

Area Indication On/Off Turns on or off the function that 
displays a zebra pattern in the area 
targeted by skin detail correction.

Level –99 to ±0 to +99 Specifies the skin detail level.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by skin detail correction.

Hue 0 to 359 Specifies the hue of the color 
targeted by skin detail correction.

Width 0 to 40 to 90 Specifies a range for the hue of the 
color targeted by skin detail 
correction.

Matrix
Makes settings related 
to matrix correction.
Matrix correction 
allows you to adjust the 
color and vividness of 
the video. Depending 
on the effect you want, 
you can select one from 
among a number of 
preset matrixes, which 
define different 
parameter sets. Or you 
can select a user matrix 
with your own 
parameters.

Matrix On/Off Turns the matrix correction function 
on or off.

Preset Matrix On/Off Turns the preset matrix function on 
or off.

Preset Select 1/2/3/4/5/6 Selects a preset matrix.
1: SMPTE-240M equivalent
2: ITU-709 equivalent
3: SMPTE WIDE equivalent
4: NTSC equivalent
5: EBU equivalent
6: PAL equivalent

User Matrix On/Off Turns the user matrix function on or 
off.

User Matrix R-G –99 to ±0 to +99 Specifies a freely defined R-G user 
matrix.

User Matrix R-B –99 to ±0 to +99 Specifies a freely defined R-B user 
matrix.

User Matrix G-R –99 to ±0 to +99 Specifies a freely defined G-R user 
matrix.

User Matrix G-B –99 to ±0 to +99 Specifies a freely defined G-B user 
matrix.

User Matrix B-R –99 to ±0 to +99 Specifies a freely defined B-R user 
matrix.

User Matrix B-G –99 to ±0 to +99 Specifies a freely defined B-G user 
matrix.
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Multi Matrix
Makes settings related 
to multi matrix 
correction.
Multi-matrix correction 
allows specific colors 
to be selected for 
saturation correction in 
a 16-axis hue space.

Multi Matrix On/Off Turns the multi matrix correction 
function on or off.

Area Indication On/Off Turns on or off the function that 
displays a zebra pattern in the color 
area targeted by multi matrix 
correction.

Color Detection Color detection screen Detects colors targeted by multi 
matrix correction.

Axis B/B+/MG–/MG/MG+/
R/R+/YL–/YL/YL+/G–/
G/G+/CY/CY+/B–

Specifies a color targeted by multi 
matrix correction (16-axis mode) 

Hue –99 to ±0 to +99 Specifies the hue of the color 
targeted by multi matrix correction 
for each 16-axis mode.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by multi matrix correction 
for each 16-axis mode.

V Modulation
Makes settings related 
to V modulation 
shading.
V modulation shading 
corrects vertical 
imbalances in 
sensitivity arising from 
the relationship 
between a lens and 
prism.

V Modulation On/Off Turns V modulation shading on or 
off.

Master V 
Modulation

–99 to ±0 to +99 Specifies the master V modulation 
level.

R V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
R signals.

G V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
G signals.

B V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
B signals.

Low Key Sat.
Makes settings related 
to low key saturation 
correction.
You can correct the 
saturation of colors in 
dark parts of the video 
only.

Low Key Saturation On/Off Turns low key saturation correction 
on or off.

Level –99 to ±0 to +99 Specifies the saturation of colors in 
low luminance areas.

Range Low/L Mid/H.Mid/High Specifies the luminance level for 
which low key saturation is enabled.

Noise Suppress
Makes settings related 
to noise suppression 
(noise compression).
You can effectively 
suppress noise 
components while 
preserving fine edge 
components in the 
subject.

Noise Suppress On/Off Turns noise suppression on or off.
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MAINTENANCE Menu

MAINTENANCE
Menu items Sub-item Settings Description
White Shading
Makes settings related 
to white shading.
White shading is 
required for each 
different lens to correct 
irregularities arising 
from lens 
characteristics. It 
corrects luminance and 
color irregularities in 
bright areas.

Channel Select Red/Green/Blue Selects the target of white shading 
correction.

R/G/B White H Saw –99 to ±0 to +99 Specifies a SAW white shading 
correction value for the horizontal 
direction.

R/G/B White H Para –99 to ±0 to +99 Specifies a parabola white shading 
correction value for the horizontal 
direction.

R/G/B White V Saw –99 to ±0 to +99 Specifies a SAW white shading 
correction value for the vertical 
direction.

R/G/B White V Para –99 to ±0 to +99 Specifies a parabola white shading 
correction value for the vertical 
direction.

White Saw/Para On/Off Turns the white shading SAW and 
parabola correction functions on or 
off.

Black Shading
Makes settings related 
to black shading 
correction.

Channel Select Red/Green/Blue Selects the target of black shading 
correction.

R/G/B Black H Saw –99 to ±0 to +99 Specifies a SAW black shading 
correction value for the horizontal 
direction.

R/G/B Black H Para –99 to ±0 to +99 Specifies a parabola black shading 
correction value for the horizontal 
direction.

R/G/B Black V Saw –99 to ±0 to +99 Specifies a SAW black shading 
correction value for the vertical 
direction.

R/G/B Black V Para –99 to ±0 to +99 Specifies a parabola black shading 
correction value for the vertical 
direction.

Black Saw/Para On/Off Turns the black shading SAW and 
parabola correction functions on or 
off.

Master Black –99 to ±0 to +99 Specifies the master black level.

Master Gain (TMP) –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies a temporary master gain 
value. 

Battery
Makes settings related 
to batteries.

Info Before End 5%/10%/15%...95%/
100%

Specifies a threshold value that 
triggers a “Battery Near End” 
warning when a BP-GL65/GL95 
battery pack is used.

Info End 0%/1%/2%/3%/4%/5% Specifies a threshold value that 
triggers a “Battery End” warning 
when a BP-GL65/GL95 battery 
pack is used.
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Battery
Makes settings related 
to batteries.

Sony Before End 11.5V to 17V (0.1V step) Specifies a threshold value that 
triggers a “Battery Near End” 
warning when a BP-L60S/L80S 
battery pack is used.

Sony End 11.0V to 11.5V (0.1V 
step) 

Specifies a threshold value that 
triggers a “Battery End” warning 
when a BP-L60S/L80S battery pack 
is used.

Other Before End 11.5V to 11.8V to 17.0V 
(0.1V step) 

Specifies a threshold value that 
triggers a “Battery Near End” 
warning when a non-Sony battery 
pack is used.

Other End 11.0V to 14.0V (0.1V 
step) 

Specifies a threshold value that 
triggers a “Battery End” warning 
when a non-Sony battery pack is 
used.

DC In Before End 11.5V to 11.8V to 17.0V 
(0.1V step) 

Specifies a threshold value that 
triggers a “Battery Near End” 
warning when an external power 
source is connected to the DC IN 
connector.

DC In End 11.0V to 14.0V (0.1V 
step) 

Specifies a threshold value that 
triggers a “Battery End” warning 
when an external power source is 
connected to the DC IN connector.

Detected Battery Info/Sony/Other/DC IN Displays the results of automatic 
battery pack type detection.

Type Detection Auto/Other Auto: Detect the battery type 
automatically.

Other: Fix battery type detection as 
“Other”.

Segment No.10 11.0V to 17.0V (0.1V 
step) 

Specify voltage threshold values 
that cause remaining capacity 
segments to go off in the display of 
remaining battery capacity (see 
page 32). (The segments go off 
below the specified value.)
These values are used when the 
battery type has been found to be 
“Other”.

Segment No.9 11.0V to 16.0V to 17.0V 
(0.1V step) 

Segment No.8 11.0V to 15.0V to 17.0V 
(0.1V step) 

Segment No.7 11.0V to 14.0V to 17.0V 
(0.1V step) 

Segment No.6 11.0V to 13.5V to 17.0V 
(0.1V step) 

Segment No.5 11.0V to 13.0V to 17.0V 
(0.1V step) 

Segment No.4 11.0V to 12.5V to 17.0V 
(0.1V step) 

Segment No.3 11.0V to 12.0V to 17.0V 
(0.1V step) 

Segment No.2 11.0V to 11.5V to 17.0V 
(0.1V step) 

Segment No.1 11.0V to 17.0V (0.1V 
step) 
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Audio
Makes settings related 
to audio.

Front MIC Select Mono/Stereo Selects whether the front 
microphone is monaural (Mono) or 
stereo (Stereo).

Audio CH3/4 Mode Ch1/2 / Switch Selects the input signals for the 
AUDIO IN CH-3/CH-4 connectors.
Ch1/2: The same signals as the 

AUDIO IN CH-1/ CH-2 
connectors.

Switch: The signals selected with 
the AUDIO IN CH3/CH4 
switches.

Rear XLR Auto On/Off Turns on or off the XLR connection 
automatic detection (for the AUDIO 
IN CH-1/CH-2 connectors on the 
rear panel).

Front MIC CH1 Ref –70dB/–60dB/–50dB/
–40dB/–30dB/–20dB

Selects the reference level for 
channel 1 of the front microphone.

Front MIC CH2 Ref –70dB/–60dB/–50dB/
–40dB/–30dB/–20dB

Selects the reference level for 
channel 2 of the front microphone.

Rear MIC CH1 Ref –70dB/–60dB/–50dB/
–40dB/–30dB/–20dB

Selects the reference input level 
when the setting of the AUDIO IN 
CH1 switch is MIC.

Rear MIC CH2 Ref –70dB/–60dB/–50dB/
–40dB/–30dB/–20dB

Selects the reference input level 
when the setting of the AUDIO IN 
CH2 switch is MIC.

Line Input Ref +4dB/0dB/–3dB/EBUL Selects the reference input level 
when the AUDIO IN CH1 and 
AUDIO IN CH2 switches are set to 
LINE.

Min Alarm Volume Off/Set Selects the volume when the 
ALARM knob is turned all the way 
down.
Off: Almost inaudible
Set: Fairly audible

Speaker Attenuate Off/3dB/6dB/9dB/12dB Selects the volume from the monitor 
speakers (does not affect earphone 
volume).

Headphone Out Mono/Stereo Selects whether the earphones are 
monaural (Mono) or stereo (Stereo).

Reference Level –20dB/–18dB/–16dB/
–12dB/EBUL

Selects the output level of the 1 kHz 
test signal.

Reference Out 0dB/+4dB/–3dB/EBUL Specifies the output level with 
respect to the reference input level.

CH1&2 AGC Mode Mono/Stereo For automatic adjustment of the 
input level of analog audio signals 
recorded on channels 1 and 2, 
specifies whether to make the 
adjustments separately for each 
channel (Mono) or in stereo mode 
(Stereo).
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Audio
Makes settings related 
to audio.

CH3&4 AGC Mode Mono/Stereo For automatic adjustment of the 
input level of analog audio signals 
recorded on channels 3 and 4, 
specifies whether to make the 
adjustments separately for each 
channel (Mono) or in stereo mode 
(Stereo).

AGC Spec –6dB/–9dB/–12dB/
–15dB/–17dB

Selects the AGC saturation level.

Limiter Mode Off/–6dB/–9dB/–12dB/
–15dB/–17dB

For manual audio level adjustments, 
selects the saturation level for the 
limiter applied to loud input signals.
Select Off if you do not wish to use 
the limiter.

Output Limiter On/Off Turns the audio output limiter on or 
off.

CH1 Wind Filter On/Off Turns the channel 1 wind filter on or 
off.

CH2 Wind Filter On/Off Turns the channel 2 wind filter on or 
off.

CH3 Wind Filter On/Off Turns the channel 3 wind filter on or 
off.

CH4 Wind Filter On/Off Turns the channel 4 wind filter on or 
off.

Audio SG (1KHz) On/Off/Auto Selects whether to output (On) or 
not output (Off) a 1 kHz test signal 
in color bar mode.
Auto: Output a test signal only 

when the AUDIO SELECT 
CH1 switch is set to AUTO.

MIC CH1 Level Side1/Front/Front+Side1 For recording input audio from the 
front microphone on channel 1, 
selects the knob that adjusts the 
audio level. 
Side1: The LEVEL knob (left) on 

the side panel
Front: The MIC LEVEL control on 

the front panel
Front+Side1: Adjust with both the 

LEVEL knob (left) and the 
MIC LEVEL control.

MIC CH2 Level Side2/Front/Front+Side2 For recording input audio from the 
front microphone on channel 2, 
selects the knob that adjusts the 
audio level.
Side2: The LEVEL knob (right) on 

the side panel
Front: The MIC LEVEL control on 

the front panel
Front+Side2: Adjust with both the 

LEVEL knob (right) and the 
MIC LEVEL control.
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Audio
Makes settings related 
to audio.

Rear1/WRR Level Side1/Front/Front+Side1 Selects the knob that adjusts the 
audio levels of a wireless 
microphone and a device connected 
to the AUDIO IN CH-1 connector 
on the rear panel.
Side1: The LEVEL knob (left) on 

the side panel
Front: The MIC LEVEL control on 

the front panel 
Front+Side1: Adjust with both the 

LEVEL knob (left) and the 
MIC LEVEL control.

Rear2/WRR Level Side2/Front/Front+Side2 Selects the knob that adjusts the 
audio levels of a wireless 
microphone and a device connected 
to the AUDIO IN CH-2 connector 
on the rear panel.
Side2: The LEVEL knob (right) on 

the side panel
Front: The MIC LEVEL control on 

the front panel
Front+Side2: Adjust with both the 

LEVEL knob (right) and the 
MIC LEVEL control.

Audio CH3 Level Side3/Front/Front+Side3 Selects the knob that adjusts the 
level of audio recorded on channel 
3. 
Side3: The LEVEL knob on side 

panel
Front: The MIC LEVEL control on 

the front panel
Front+Side3: Adjust with both the 

LEVEL knob and the MIC 
LEVEL control.

Audio CH4 Level Side4/Front/Front+Side4 Selects the knob that adjusts the 
level of audio recorded on channel 
4.
Side4: The LEVEL knob on side 

panel
Front: The MIC LEVEL control on 

the front panel
Front+Side4: Adjust with both the 

LEVEL knob and the MIC 
LEVEL control.
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WRR Setting
Makes settings related 
to the wireless tuner.

WRR Valid CH Sel All/CH1 Selects whether to enable channels 1 
and 2 of the wireless receiver (All) 
or channel 1 only (CH1).

WRR CH Select TX1/TX2 Specifies the target channel for other 
sub-items.
TX1: Channel 1
TX2: Channel 2

WRR Delay Comp On/Off Enables (On) or disables (Off) delay 
compensation for wireless audio 
input. (When On is selected, the 
audio in all E-E output is delayed by 
about 8 ms.)

TX --- Displays the name of the transmitter 
whose signals are being received on 
the channel selected by WRR CH 
SELECT.

TX Audio Peak ---/Peak Displays whether the AF level of the 
transmitter whose signals are being 
received on the channel selected by 
WRR CH SELECT are over peak.

TX Input Level ---/Mic/Line Displays whether the input level of 
the transmitter whose signals are 
being received on the channel 
selected by WRR CH SELECT is 
set to microphone (Mic) or line 
(Line).

TX ATT Level --- Sets the ATT level of the transmitter 
whose signals are being received on 
the channel selected by WRR CH 
SELECT. (The setting range varies 
depending on the transmitter.)

TX LCF Frequency --- Sets the low cut filter frequency of 
the transmitter whose signals are 
being received on the channel 
selected by WRR CH SELECT. 
(The setting range varies depending 
on the transmitter.)

TX System Delay Auto/0.0ms to 8.0ms Specifies the amount of audio delay.
Auto: Automatically adjusts the 

amount of delay so that the 
delay in the audio received 
from the wireless transmitter is 
zero. 

0.0ms to 8.0ms: Sets the amount of 
anticipated wireless system 
delay, for cases in which 
several wireless systems are 
being used over a devices such 
as an audio mixer.
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Timecode
Makes settings related 
to timecode.

TC Out Auto/Generator Selects the source for timecode 
output.
Auto: During recording, output 

values generated by the 
timecode generator, and during 
playback output values 
obtained by the timecode 
reader.

Generator: Output values 
generated by the timecode 
generator during both recording 
and playback.

DF/NDF DF/NDF When the Country setting is other 
than [PAL Area], selects drop-frame 
mode (DF) or non-drop-frame mode 
(NDF).

LTC UBIT Fix/Time Specifies the data recorded in LTC 
user bits. 
Fix: Record user-specified data.
Time: Record the current time.

Counter Display Counter/Duration Select the method used to reset the 
counter value displayed on the 
viewfinder screen. 
Counter: Continue to increment 

until the RESET button is 
pressed.

Duration: Reset each time that 
recording is started.

Essence Mark
Makes settings related 
to shot marks and clip 
index picture 
thumbnails.

Ret Shot Mark 1 On/Off Specify whether to input Shot 
Mark1 marks using the RET button 
on the lens.

Ret Shot Mark 2 On/Off Specify whether to input Shot 
Mark2 marks using the RET button 
on the lens.

Index Pic Pos 0sec to 10sec (in 1 sec 
steps)

Specifies which frame to use as the 
clip thumbnail image 

Find Mode Clip/Rec Start Specify the frame to be cued up 
when the PREV or NEXT button is 
pressed.
Rec Start: The next frame or the 

previous frame where a Rec 
Start essence mark is set.

Clip: Pressing the NEXT button 
moves to the start frame of the 
next clip. Pressing the PREV 
button moves to the start frame 
of the current clip. (Pressing the 
PREV button at the start frame 
of the current clip moves to the 
start frame of the previous 
clip.)
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Camera Config
Makes settings related 
to various camcorder 
operations.

Rec Tally Blink On/Off Turns warning flashes by the 
TALLY indicator on or off. The 
warnings alert you an almost 
exhausted battery pack or low 
remaining media capacity.

Rec Review 3sec/10sec/Clip Selects the recording review time.
Clip: Review all of the most 

recently recorded clip.

HD SDI Remote I/F Off/Chara/G-Tally/
R-Tally

Selects whether to use the function 
that enables recording control from 
this camcorder of an external device 
connected to the HD/SD SDI OUT 
connector (HDSDI output). When 
the function is used, also selects the 
indication that shows whether the 
external device is recording.
Off: Do not use the remote 

recording control function. 
Chara: Indicate by the external 

device control indication on the 
viewfinder screen.

G-Tally: Indicate by the green tally 
indicator in the HDVF series 
viewfinder or green tally 
indicator on the screen of the 
CBK-VF01 viewfinder.

R-Tally: Indicate by the recording/
red tally indicators in the 
HDVF series viewfinder or the 
special recording mode/
operation status indication on 
the screen of the CBK-VF01 
viewfinder.

Color Bars Select ARIB/100%/75%/
SMPTE

Selects the color bar type.

User Menu Only On/Off Selects whether to display the 
USER menu only (On) or display 
the menu list (Off) when the 
camcorder enters the menu mode. 

RM Common 
Memory

On/Off Selects whether to share (On) or not 
share (Off) settings between times 
when a remote control unit is 
connected and times when the 
camcorder is used locally.

Note 

When a remote control unit is 
connected, this setting is disabled.
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Camera Config
Makes settings related 
to various camcorder 
operations.

RM Rec Start RM/CAM/PARA For times when a remote control 
unit is connected, selects whether 
recording start/stop buttons are 
enabled on the camcorder or the 
remote control unit. 
RM: Remote control unit
CAM: Camcorder 
PARA: Both

Preset White
Makes settings related 
to white balance preset 
values.

Color Temp<P> 1500K to 3200K to 
50000K

Specifies the white balance preset 
value.

Color Temp 
Balance<P>

–99 to ±0 to +99 Specifies finer color temperature 
settings, for use when satisfactory 
video cannot be obtained with Color 
Temp<P>.

R Gain <P> –99 to ±0 to +99 Specifies the R gain preset value.

B Gain <P> –99 to ±0 to +99 Specifies the B gain preset value.

AWB Enable <P> On/Off Turns on and off execution of the 
AWB (auto white balance) function 
when the WHITE BAL switch is set 
to PRST.

White Filter
Makes settings related 
to filters.

ND Filter 
C.Temp

On/Off Turns the function that assigns 
electrical CC filters to ND filters on 
or off.

ND FLT 
C.Temp<1>

3200K/4300K/5600K/
6300K

Selects the color temperature for 
when electrical CC filters are 
assigned to ND filters.

ND FLT 
C.Temp<2-4>

3200K/4300K/5600K/
6300K

Selects the color temperature for 
when electrical CC filters are 
assigned to ND filters.

Electrical 
CC<A> 

3200K/4300K/5600K/
6300K

Selects the color temperature for 
when the electrical CC filter 
switching function is assigned to an 
assignable switch.

Electrical 
CC<B>

3200K/4300K/5600K/
6300K

Selects the color temperature for 
when the electrical CC filter 
switching function is assigned to an 
assignable switch.

Electrical 
CC<C>

3200K/4300K/5600K/
6300K/-----

Selects the color temperature for 
when the electrical CC filter 
switching function is assigned to an 
assignable switch.
Select “----” if you do not want to 
use C.

Electrical 
CC<D>

3200K/4300K/5600K/
6300K/-----

Selects the color temperature for 
when the electrical CC filter 
switching function is assigned to an 
assignable switch.
Select “----” if you do not want to 
use D.
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DCC Adjust
Makes settings related 
to DCC (dynamic 
contrast control).

DCC Function Select DCC/Fix Enables or disables automatic knee 
point adjustment when the 
OUTPUT/DCC switch is set to 
CAM, DCC: ON.
DCC: Automatically adjust the 

knee point according to the 
luminance of the subject. 

Fix: Set the knee point to a fixed 
value.

DCC D Range 400%/450%/500%/
550%/600%

Specifies the dynamic range when 
the OUTPUT/DCC switch is set to 
CAM, DCC: ON.

DCC Point –99 to ±0 to +99 Adjusts the DCC minimum knee 
point.

DCC Gain –99 to ±0 to +99 Specifies gain with respect to the 
DCC detected value.

DCC Delay Time –99 to ±0 to +99 Specifies the DCC control speed 
(speed of reaction to changes in the 
video).

DCC Peak Filter –99 to ±0 to +99 Adjusts response sensitivity with 
respect to peaks in DCC detected 
values.
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Auto Iris2
Makes settings related 
to auto iris.

Iris Window 1/2/3/4/5/6/Var Selects the type of iris detection 
window. 
Var: Variable

Iris Window Ind On/Off Turns on or off the function that 
displays a frame marker for the auto 
iris detection window.

Iris Level –99 to ±0 to +99 Adjusts the level of the auto iris 
target value.

Iris APL Ratio –99 to ±0 to +99 Adjusts the mix ratio of auto iris 
detection peak value and average 
value (available when OPERATION 
>TLCS >Mode is set to [Standard]).

Iris Var Width 40 to 500 to 999 Adjusts the width of the detection 
window when the setting of Iris 
Window is VAR.

Iris Var Height 70 to 500 to 999 Adjusts the height of the detection 
window when the setting of Iris 
Window is VAR.

Iris Var H Position –479 to 0 to +479 Specifies the horizontal position of 
the detection window when the 
setting of Iris Window is VAR.

Iris Var V Position –464 to 0 to +464 Specifies the vertical position of the 
detection window when the setting 
of Iris Window is VAR.

Iris Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video). 
(Larger values specify quicker 
reaction times.)

Clip High Light On/Off Turns on or off the function that 
disregards highlights and forces a 
flatter reaction to high luminance.

Genlock
Makes settings related 
to genlock.

Genlock On/Off Turns the genlock function on or off.

H Phase(HD) –999 to ±0 to +999 Specifies the H phase of HD output 
when genlock is enabled.

H Phase(SD) –99 to ±0 to +99 Specifies the H phase of SD output 
when genlock is enabled.

Reference Internal/Genlock Displays the type of reference signal 
used by the camcorder.
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ND Comp
Makes settings related 
to ND filter color 
compensation. 
Although the 
differences are very 
slight, each of the built-
in ND filters has 
different color 
characteristics. When 
you switch between ND 
filters, the white 
balance may be 
disturbed. You can 
correct for these slight 
color differences 
automatically by 
registering 
compensation values 
for each filter.

ND Offset Adjust On/Off ND filter color compensation 
function.

Clear ND Offset Execute/Cancel Clears ND filter color compensation 
values (execute by selecting 
Execute).

Lens
Executes auto flange 
back adjustment.

Auto FB Adjust Execute/Cancel Executes auto flange back 
adjustment, only for supported 
lenses (execute by selecting 
Execute).

Auto Shading
Executes auto black 
shading compensation.

Auto Black Shading Execute/Cancel Executes auto shading 
compensation (execute by selecting 
Execute).

Reset Black Shading Execute/Cancel Clears black shading compensation 
values (execute by selecting 
Execute).

Master Gain (TMP) –6dB/–3dB/0dB/3dB/
6dB/9dB/12dB/18dB/
24dB/30dB/36dB/42dB

Specifies a temporary master gain 
value. (The value is the same as the 
value selected with the GAIN 
switch.)

APR APR(SLS) Execute/Cancel Suppresses white flecks in SLS 
mode by executing the automatic 
pixel noise reduction function 
(execute by selecting Execute).

APR Preset Execute/Cancel Deletes white flecks data that was 
added by execution of the APR and 
automatic black balance adjustment 
functions (execute by selecting 
Execute). 

Trigger Mode
Makes settings related 
to triggers for starting 
and stopping recording.

i.LINK Trigger 
Mode

Internal/Both/External Select Internal when recording start 
and stop operations target SxS 
memory cards only. Select External 
when they target only devices 
connected to the i.LINK (HDV/DV) 
or HD/SD SDI OUT connectors. 
Select Both when they target both 
memory cards and external devices.
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Network Setting b)

Makes settings for 
network connection.

Notes

• The CBK-WA01 
Wi-Fi Adapter is 
required.

• This item is 
disabled (displayed 
in grey) during 
recording and play. 

For details on 
network connection, 
refer to the 
Supplement supplied 
in the CD-ROM 
(labeled “Manuals for 
Solid-State Memory 
Camcorder”).

DHCP Enable/Disable Selects whether to acquire the IP 
address automatically from a DHCP 
server (Enable) or not (Disable).

IP Address 0.0.0.0 to 
255.255.255.255 
(192.168.1.10)

When DHCP is set to [Disable], sets 
the IP address. 

Subnet Mask 0.0.0.0 to 
255.255.255.255

When DHCP is set to [Disable], sets 
the subnet mask.

Default Gateway 0.0.0.0 to 
255.255.255.255

When DHCP is set to [Disable], sets 
the default gateway.

User Name admin Sets a desired user name in 1 to 31 
alphanumeric characters. 

Password pmw-500 (model name) Sets a password (model name) in 0 
to 31 alphanumeric characters. 

Set Execute/Cancel Confirms the settings in Network 
Settings (execute by selecting 
[Execute]). 

MAC Address Displays the MAC address.

Net Config Reset Execute/Cancel Resets the settings in Network 
Settings to the preset values 
(execute by selecting [Execute]). 

Wi-Fi Setting b)

Makes settings for 
Wi-Fi connection.

Notes

• The CBK-WA01 
Wi-Fi Adapter is 
required.

• This item is 
disabled (displayed 
in grey) during 
recording and play. 

For details on Wi-Fi 
connection, refer to 
the Supplement 
supplied in the CD-
ROM (labeled 
“Manuals for Solid-
State Memory 
Camcorder”).

Scan Networks Execute/Cancel When Wi-Fi is set to [Enable], scan 
the available network connection. 

SSID Network connection 
name

Sets the network connection name 
of up to 32 characters. 

Network Type Infra/Adhoc Selects the connection mode.
Infra: Infrastructure mode
Adhoc: Ad hoc mode

Ch 1 to 11 When Network Type is set to 
[Adhoc], set the wireless channel. 

Authentication Open/Shared/WPA/
WPA2

Selects the network authentication.
OPEN: Open system authentication
SHARED: Shared key 

authentication
WPA: WPA (Wi-Fi Protected 

Access) authentication
WPA2: WPA2 (Wi-Fi Protected 

Access 2) authentication
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Wi-Fi Setting b)

Makes settings for 
Wi-Fi connection.

Notes

• The CBK-WA01 
Wi-Fi Adapter is 
required.

• This item is 
disabled (displayed 
in grey) during 
recording and play. 

For details on Wi-Fi 
connection, refer to 
the Supplement 
supplied in the CD-
ROM (labeled 
“Manuals for Solid-
State Memory 
Camcorder”).

Encryption Disable/WEP/TKIP/AES Selects whether to apply data 
encryption and the type of data 
encryption.
Disable: Do not apply data 

encryption.
WEP: Apply WEP (Wired 

Equivalent Privacy) when 
Authentication is set to [Open] 
or [Shared]

TKIP: Apply TKIP (Temporal Key 
Integrity Protocol) when 
Authentication is set to [WPA] 
or [WPA2]

AES: Apply AES (Advanced 
Encryption Standard) when 
Authentication is set to [WPA] 
or [WPA2]

WEP Key Index 1/2/3/4 When Encryption is [WEP], selects 
the key index. 

Input Select When Encryption is set to 
[WEP]: ASCII5, 
ASCII13, HEX10, 
HEX26

When Encryption is set to 
[TKIP] or [AES]: 
ASCII8-63, HEX64

Selects the input format depending 
on the network key (or security key).
ASCII5: Five characters ASCII 

format
ASCII13: 13 characters ASCII 

format
HEX10: 10 hexadecimal digits
HEX26: 26 hexadecimal digits
ASCII8-63: 8 to 63 characters 

ASCII 8-bit format
HEX64: 64 hexadecimal digits 

(characters)

Key Sets the network key (or security 
key).

Set Enables settings for Wi-Fi Setting 
when Wi-Fi is set to [Enable] 
(execute by selecting [Execute]).

Wi-Fi Status xxxxx

Connecting
Displays “Connecting” while 
connection is being attempted. 
Displays black squares to show the 
connection status by the number of 
squares when the camcorder is 
connected to a computer or a LAN.

Wireless Mode 802.11b/802.11g/802.11n Displays an IEEE802.11 standard.

Wi-Fi Enable/Disable Selects whether to enable or disable 
Wi-Fi connection.

MAINTENANCE
Menu items Sub-item Settings Description
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a) When the optional CBK-HD02 is installed
b) When the optional CBK-UPG01 is installed

Clock Set
Sets the internal clock.

Date/Time Sets the current date and time.

12H/24H 12H/24H Selects the 12-hour format (12H) or 
the 24-hour format (24H) for 
display of times.

Date Mode YYMMDD/MMDDYY/
DDMMYY

Selects the display format for dates. 
YYMMDD: Year, Month, Day
MMDDYY: Month, Day, Year
DDMMYY: Day, Month Year

Language
Selects the language for 
messages.

Language English/Chinese Selects the language for messages 
from English or Chinese.

Hours Meter
Makes settings related 
to the digital hours 
meter.

Hours(Sys) Displays the cumulative hours of 
use (cannot be reset).

Hours(Reset) Displays the hours of use (can be 
reset).

Reset Execute/Cancel Resets Hours(Reset) to 0. 
(Execute by selecting Execute.)

Version
Displays the version of 
the camcorder, and 
updates the camcorder.

Version Displays the software version of the 
camcorder (Vx.xx).

CBK-HD02 a) Displays the software version of the 
CBK-HD02 (Vx.xx).

Version Up Execute/Cancel Updates the camcorder (execute by 
selecting Execute).

Note

This cannot be selected unless an SxS 
memory card is inserted.

MAINTENANCE
Menu items Sub-item Settings Description
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Settings in bold are the factory default values.

FILE Menu

FILE
Menu items Sub-item Settings Description
User
Makes settings for 
operating user files.

User Load SxS Execute/Cancel Loads a user file from an SxS 
memory card (execute by selecting 
[Execute]).
When Load Customize Data is set 

to [Off]: Replace the current 
USER menu settings with 
settings stored in the loaded use 
file (with the original menu 
configuration unchanged). 

When Load Customize Data is set 
to [On]: Replace the current 
USER menu configuration and 
settings with those stored in the 
loaded use file. 

When User Load White is set to 
[Off]: Load a user file 
excluding white balance data.

User Load White is set to [On]: 
Load a user file including white 
balance data. 

User Save SxS Execute/Cancel Stores the current USER menu 
configuration and settings including 
the white balance data to an SxS 
memory card as a user file (execute 
by selecting [Execute]). 

User Load USB (in UDF mode only) Loads a user file from a USB flash 
drive (execute by selecting 
[Execute]).

User Save USB (in UDF mode only) Stores the current USER menu 
configuration and settings including 
the white balance data to a USB 
flash drive as a user file (execute by 
selecting [Execute]).

File ID Assigns a name to a file. Names can 
be up to 16 characters in length.

Recall User Preset Execute/Cancel Returns the current USER menu 
settings to the preset values (execute 
by selecting [Execute]).

Store User Preset Execute/Cancel Stores the USER menu as a user file 
in which all menu settings are reset 
to the preset values (execute by 
selecting [Execute]).

Clear User Preset Execute/Cancel Returns the current USER menu 
settings to the factory default 
settings (execute by selecting 
[Execute]).
Menu List
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User
Makes settings for 
operating user files.

Load Customize 
Data

Off/On Selects whether to load both menu 
configuration and settings (On) or 
load only menu settings (Off) white 
balance data when loading a user 
file.

User
Makes settings for 
operating user files.

Load White Data Off/On Selects whether to load (On) or not 
load (Off) white balance data when 
loading a user file.

All
Makes settings related 
to ALL file operations.

Display Mode Date&Time/Model 
Name

Selects the items to be displayed in 
the list box that appears when a file 
is saved or loaded.

All Load(SxS) Execute/Cancel Loads an ALL file from an SxS 
memory card (execute by selecting 
Execute).

All Save(SxS) Execute/Cancel Stores an ALL file to an SxS 
memory card (execute by selecting 
Execute).

All Load(USB) 
(in UDF mode only) 

Execute/Cancel Loads an ALL file from a USB flash 
drive (execute by selecting 
[Execute]).

All Save(USB) 
(in UDF mode only) 

Execute/Cancel Stores an ALL file to a USB flash 
drive (execute by selecting 
[Execute]).

File ID Assigns a name to a file. Names can 
be up to 16 characters in length.

All Preset Execute/Cancel Returns all items to their preset 
values (execute by selecting 
Execute).

Store All Preset Execute/Cancel Stores the current settings of all 
items as the preset values (execute 
by selecting [Execute]).

Clear All Preset Execute/Cancel Clears the preset values of all items 
(execute by selecting [Execute]).

3Sec Clr Preset On/Off Turns on or off the function that 
clears each preset value when the 
MENU CANCEL/PRST/ESCAPE 
switch is pushed up and held for 
three seconds on the CANCEL/
PRST side.

Network Data Off/On Selects whether to load (On) or not 
load (Off) network settings when 
loading an ALL file.

FILE
Menu items Sub-item Settings Description
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Scene
Makes settings related 
to scene file operations.

s1 Standard File number and file ID

s2 Standard File number and file ID

s3 Standard File number and file ID

s4 Standard File number and file ID

s5 Standard File number and file ID

sStandard Standard settings

Display Mode Date&Time/Model 
Name

Selects the items to be displayed in 
the list box that appears when a file 
is saved or loaded.

Scene Recall Mem Execute/Cancel Loads a file from internal memory 
(execute by selecting [Execute]).

Scene Store Mem Execute/Cancel Stores a file in internal memory 
(execute by selecting [Execute]).

Scene Recall SxS Execute/Cancel Loads a file from an SxS memory 
card (execute by selecting 
[Execute]).

Scene Store SxS Execute/Cancel Stores a file to an SxS memory card 
(execute by selecting [Execute]).

Scene Recall USB
(in UDF mode only) 

Execute/Cancel Loads a file from a USB flash drive 
(execute by selecting [Execute]). 

Scene Store USB
(in UDF mode only) 

Execute/Cancel Stores a file to a USB flash drive 
(execute by selecting [Execute]).

File ID Assigns a name to a file. Names can 
be up to 16 characters in length.

Reference
Makes settings related 
to reference file 
operations.

Reference Store Execute/Cancel Stores the current settings of 
reference file items in the reference 
file that is maintained in internal 
memory (execute by selecting 
[Execute]).

Reference Clear Execute/Cancel Clear the reference file (execute by 
selecting [Execute]).

Refer Load(SxS) Execute/Cancel Load a reference file from an SxS 
memory card (execute by selecting 
[Execute]).

Refer Save(SxS) Execute/Cancel Store a reference file to an SxS 
memory card (execute by selecting 
[Execute]).

Refer Load(USB)
(in UDF mode only) 

Execute/Cancel Loads a file from a USB flash drive 
(execute by selecting [Execute]). 

Refer Store(USB)
(in UDF mode only) 

Execute/Cancel Stores a file to a USB flash drive 
(execute by selecting [Execute]).

File ID Assigns a name to a file. Names can 
be up to 16 characters in length.

Scene White Data On/Off Selects whether to load (On) or not 
load (Off) white balance data when 
Scene >Scene Recall or Scene 
>Standard is executed.

FILE
Menu items Sub-item Settings Description
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Lens
Makes settings related 
to lens file operations.

Display Mode Date&Time/Model 
Name

Selects the items to be displayed in 
the list box that appears when a file 
is saved or loaded.

Lens Recall Mem Execute/Cancel Loads a file from internal memory 
(execute by selecting [Execute]).

Lens Store Mem Execute/Cancel Stores a file in internal memory 
(execute by selecting [Execute]).

Lens Recall SxS Execute/Cancel Loads a file from an SxS memory 
card (execute by selecting 
[Execute]).

Lens Store SxS Execute/Cancel Stores a file to an SxS memory card 
(execute by selecting [Execute]).

Lens Recall USB
(in UDF mode only)

Execute/Cancel Loads a file from a USB flash drive 
(execute by selecting [Execute]). 

Lens Store USB
(in UDF mode only)

Execute/Cancel Stores a file to a USB flash drive 
(execute by selecting [Execute]).

File ID Assigns a name to the most recently 
loaded file. Names can be up to 16 
characters in length.

Source Displays the number of the selected 
file. 

Lens No Offset Execute/Cancel Clears a file (execute by selecting 
[Execute]).

Lens Auto Recall Off/On/Serial Number When the installed lens supports 
serial communication, specifies 
whether to automatically load that 
reference file. 
Off: Do not use this function.
On: Load the reference for the 

model name and reflect the 
contents of the file. 

Serial Number: For lenses that 
support serial number 
communication, load the lens 
file that corresponds to the 
serial number and model name, 
and reflect the contents of that 
file. For lenses that do not 
support serial number 
communication, load the 
reference for the model name 
(in the same way as when On is 
selected).

Serial Number Displays the serial number of the 
installed lens (only for lenses that 
support serial communication).

Lens ID Displays the model name of the 
installed lens (only for lenses that 
support serial communication).

FILE
Menu items Sub-item Settings Description
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Lens
Makes settings related 
to lens file operations.

L Manufacturer Displays the name of the 
manufacturer of the installed lens 
(only for lenses that support serial 
communication).

M V Modulation –99 to ±0 to +99 Sets a vertical SAW shading 
compensation value in the lens file.

Lens Center H –40 to 0 to 40 Sets a center marker horizontal 
position in the lens file. 

Lens Center V –40 to 0 to 40 Sets a center marker vertical 
position in the lens file.

Lens R Flare –99 to ±0 to +99 Sets a R flare level in the lens file.

Lens G Flare –99 to ±0 to +99 Sets a G flare level in the lens file.

Lens B Flare –99 to ±0 to +99 Sets a B flare level in the lens file.

Lens W-R Offset –99 to ±0 to +99 Sets a R white balance 
compensation value in the lens file.

Lens W-B Offset –99 to ±0 to +99 Sets a B white balance 
compensation value in the lens file.

Shading Ch Sel Red/Green/Blue Selects the white shading 
compensation target.

L R/G/B H Saw –99 to ±0 to +99 Sets a horizontal SAW white 
shading compensation value in the 
lens file.

L R/G/B H Para –99 to ±0 to +99 Sets a horizontal parabola white 
shading compensation value in the 
lens file.

L R/G/B V Saw –99 to ±0 to +99 Sets a vertical SAW white shading 
compensation value in the lens file.

L R/G/B V Para –99 to ±0 to +99 Sets a vertical parabola white 
shading compensation value in the 
lens file.

FILE
Menu items Sub-item Settings Description
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Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the 
ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, and the RET 
button on the lens. 
The following tables lists the functions that are assigned when the camcorder is shipped from the factory. 

Assigning Functions to Assignable Switches

Switch or button Function Assignable SW setting

ASSIGN. 0 switch No assignment Off

ASSIGN. 1 switch No assignment Off

ASSIGN. 2 switch No assignment Off

ASSIGN. 3 switch No assignment Off

ASSIGNABLE 4 switch No assignment Off

ASSIGNABLE 5 switch No assignment Off

RET button During recording or playback: Write a shot mark.
In the other states: Conduct a recording review 

(if playback is allowed).

Lens RET

COLOR TEMP. button Adjust the white balance with the preset white 
balance value of 5600K. 

Color Temp SW 5600K

Functions That Can Be Assigned to the ASSIGN. 0 Switch

Assignable switch setting Function State when camcorder 
is next powered on

Off No assignment —

Marker Turn the display of all markers on or off. Setting retained

ATW Hold Hold the white balance setting in the ATW (auto-tracking 
white balance) mode

—

Picture Cache Turn the picture cache function on or off. Setting retained

Freeze Mix Execute the freeze mix function. —

Focus Mag Turn the focus magnification function on or off. Setting not retained

Zebra Turn zebra display on or off. Setting not retained

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/clear an OK mark to/from the clip being recorded or 
played.

Setting not retained

Clip Flag NG Add/clear an NG mark to/from the clip being recorded or 
played.

Setting not retained

Clip Flag Keep Add/clear a KP mark to/from the clip being recorded or 
played.

Setting not retained
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Note

Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the 
switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2 
switch or power the camcorder off and on again.

Note

a) When Picture Cache is assigned, OPERATION >Rec 
Function in the setup menu is disabled (displayed in 
grey) to keep the setting unchanged.

Functions That Can Be Assigned to the ASSIGN. 2 Switch

Assignable switch setting Function

Off No assignment

Front Mic Switch between stereo and monaural when a stereo microphone is connected.

Marker Turn the display of all markers on or off.

Picture Cache a) Turn the picture cache function on or off.

Zebra Turn zebra display on or off.

Clip Continuous Rec Turn the Clip Continuous Rec mode on or off.

Digital Extender Turn the screen magnification function on or off when the optional CBK-HD02 
SDI/COMPOSITE Input and 50 Pin Interface is installed.

Rec Source Switch the signals to be recorded between the camera picture and external input 
when the optional CBK-HD02 SDI/COMPOSITE Input and 50 Pin Interface is 
installed. (if the unit is currently conducting recording or play, the switch takes 
effect after the recording or playback ends.)

Functions That Can Be Assigned to the ASSIGN. 1 and 3 Switches, the 
ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP. Button

Assignable switch setting Function State when camcorder 
is next powered on

Off No assignment —

Front Mic Switch between stereo (On) and monaural (Off) when a 
stereo microphone is connected.

Setting retained

Marker Turn the display of all markers on or off. Setting retained

Last Clip Delete Delete the most recently recorded clip. —

ATW Turn ATW (auto tracing white balance) mode on or off. Setting not retained

ATW Hold Hold the white balance setting in the ATW mode. —

EZ Mode Execute EZ mode according to the setting of 
OPERATION >TLCS.

Setting retained

Turbo Gain Execute Turbo Gain according to the setting of 
OPERATION >Gain Switch >Gain Turbo.

Setting not retained

Rec Review Conduct a recording review. —

Rec Start or stop recording. —

Picture Cache Turn the picture cache function on or off. Setting retained

Freeze Mix Execute the freeze mix function. Setting not retained

Spotlight Turn the spotlight function in auto iris mode on or off. Setting retained
Assigning Functions to Assignable Switches
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Backlight Turn the backlight function in auto iris mode on or off. Setting retained

EVF Mode Switch the viewfinder screen between B&W (On) and 
color (Off).

Setting retained

BRT Disp Turn the display of the brightness level on or off. Setting retained

Histogram Turn the histogram display on or off. Setting retained

Lens Info Switch the depth of field indication between off, 
displayed in meters, and displayed in feet.

Setting retained

Zoom Tele/Wide When a lens that supports serial communication is 
installed, assign the Zoom Tele function to 
ASSIGNABLE 4, and assign the Zoom Wide function to 
ASSIGNABLE 5 (displayed only when <4> and <5> are 
set).

—

Zoom Wide/Tele When a lens that supports serial communication is 
installed, assign the Zoom Wide function to 
ASSIGNABLE 4, and assign the Zoom Tele function to 
ASSIGNABLE 5 (displayed only when <4> and <5> are 
set).

—

Manual Focus Assist Turn the manual focus assist function on or off. Setting retained

Focus Mag Turn the focus magnification function on or off. Setting not retained

Zebra Turn zebra display on or off. Setting not retained

Lens RET Display return video signals when the optional CBK-
HD02 is installed and a camera extension unit is 
connected.
When a camera extension unit is not connected, function 
as follows.
During recording or playback: Write a shot mark.
In the other states: Conduct a recording review 

(if playback is allowed).

—

Return Video Display return video signals when the optional CBK-
HD02 is installed and a camera extension unit is 
connected.

—

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/Clear an OK mark to/from the clip being recorded 
or played.

Setting not retained

Clip Flag NG Add/Clear an NG mark to/from the clip being recorded 
or played.

Setting not retained

Clip Flag Keep Add/Clear a KP mark to/from the clip being recorded or 
played.

Setting not retained

Color Temp SW 3200K Adjust the white balance with a 3200K preset value. Setting retained

Color Temp SW 4300K Adjust the white balance with a 4300K preset value. Setting retained

Color Temp SW 5600K Adjust the white balance with a 5600K preset value. Setting retained

Color Temp SW 6300K Adjust the white balance with a 6300K preset value. Setting retained

Assignable switch setting Function State when camcorder 
is next powered on
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Electrical CC Function that switches the electrical CC filter (3200K/
4300K/5600K/6300K) applied to white balance 
adjustment values.
Each press of the switch or button switches in the order 
3200Kt4300Kt5600Kt6300K.
These can also be applied from a menu (apply with 
Electrical CC<A><B><C><D>).

Note
This function is not available when Maintenance >White 
Filter >ND Filter C.Temp in the setup menu is set to On.
If you set ND Filter C.Temp to On after assigning the 
function, the assignable switch ceases to function. 

Setting retained

CC5600K Apply a 5600K electrical CC filter to white balance 
adjustment values.

Setting retained

Clip Continuous Rec Turn the Clip Continuous Rec mode on or off. Setting not retained

Digital Extender Turn the screen magnification function on or off when 
the optional CBK-HD02 SDI/COMPOSITE Input and 50 
Pin Interface is installed.

Setting not retained

Assignable switch setting Function State when camcorder 
is next powered on
Assigning Functions to Assignable Switches
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Functions That Can Be Assigned to the RET Button on the Lens

Assignable switch setting Function State when camcorder 
is next powered on

Off No assignment —

Lens RET Display return video signals when the optional CBK-
HD02 is installed and a camera extension unit is 
connected.
When a camera extension unit is not connected, function 
as follows.
During recording or playback: Write a shot mark. 
In the other states: Conduct a recording review (if 

playback is allowed).

—

Return Video Display return video signals when the optional CBK-
HD02 is installed and a camera extension unit is 
connected.

—

Rec Review Execute recording review. —

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

Clip Flag OK Add/Clear an OK mark to/from the clip being recorded or 
played.

Setting not retained

Clip Flag NG Add/Clear an NG mark to/from the clip being recorded or 
played.

Setting not retained

Clip Flag Keep Add/Clear a KP mark to/from the clip being recorded or 
played.

Setting not retained

OK Mark Add or delete an OK mark. —

Focus Mag Turn the focus magnification function on or off. Setting not retained
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You can save setup menu settings in the 
camcorder’s internal memory and on SxS 
memory cards or USB flash drives (in UDF 
mode). This allows you to quickly recall an 
appropriate set of menu settings for the current 
situation.
Setting data is saved in the following categories.
User files: User files save customized USER 

menu setting items and setting data. You can 
save up to 64 user files on SxS memory cards 
and on USB flash drives (in UDF mode). 
You can set up the USER menu to a 
customized state by reading one of these files 
into the unit’s memory.

ALL files: ALL files save the setting data of all 
menus. You can save up to 64 ALL files on 
an SxS memory card or a USB flash drive (in 
UDF mode).

Note

Device specific data (shading, output levels, and 
other data that requires adjustment for the specific 
device) is not saved.

Scene files: Scene file save adjustments to 
PAINT menu items for the purpose of 
shooting a particular scene. You can save up 
to five scene files in the camcorder’s internal 
memory and up to 64 scene files on an SxS 
memory card or a USB flash drive (in UDF 
mode).

Reference files: Reference files save the 
reference values that are set when you 
execute FILE >Scene > Standard in the setup 
menu. You can save one reference file in the 
camcorder’s internal memory and one on an 
SxS memory card or a USB flash drive (in 
UDF mode).

Lens files: Lens files save the setting data used to 
compensate for lens characteristics, such as 
flare, white shading, white balance and 
center markers. You can save up to 32 lens 

files in the camcorder’s internal memory and 
up to 64 lens files on an SxS memory card or 
a USB flash drive (in UDF mode).

The first settings stored in a file are called 
“preset” values.
Even after loading files to set up the camcorder, 
and overwriting original files with new settings, 
you can still recover preset values and reset files 
to their initial states (see page 162).

This section explains how to save setting data in 
an ALL file.
Before starting, insert a writable SxS memory 
card into a memory card slot.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >All in the setup menu. 

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 161).

2 Select All Save(SxS) >Execute.
An ALL file list box appears.
File numbers where “No File” is displayed 
are empty file numbers. File numbers with a 
file name or a date and time are the number 
of files that already contain data.

3 Turn the MENU knob to select the 
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the save, select [Execute], 
and then press the MENU knob.
To cancel the save, select [Cancel], and 
then press the MENU knob.
If you choose to execute the save, the 
ACCESS lamp lights (in blue on the right-

Chapter7 Saving and Loading User Setting Data

Saving and Loading 
Settings

Saving Setting Data
Saving and Loading Settings
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side panel and in orange in the card slot 
section). A completion message appears and 
the ACCESS lamp goes out when the data 
has been saved.

If an error message appears
One of the following error messages may appear 
during execution of the save, or as soon as you 
select [Execute]. In this case, the file is not saved 
to the SxS memory card. 

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select All Save(USB) >Execute in step 2.

To assign names to files
Assigning a name before you save data in an ALL 
file can make it easier to distinguish your files.
The following characters can be used in file 
names.
Alphanumeric characters (a–z, A–Z, 0–9) and 
special characters ( ! # $ % & ' ( ) * + , - . / : ; < = 
> ? @ [ \ ] ~)

1 Select FILE >All >File ID in the setup 
menu.

2 Turn the MENU knob to select a 
character, and then press the MENU 
knob.

3 Repeat step 3.

4 When you have finished entering 
characters, press the MENU knob to 
move the cursor to “SET”, and then 
press the MENU knob.
The specified name is displayed.
When you save the file (see page 160), the 
data will be saved under this name.

Note

When you load a file from an SxS memory card or a USB 
flash drive (in UDF mode), the data saved in the 
camcorder’s internal memory is overwritten.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >All in the setup menu.

2 Select All Load(SxS) >Execute.
A list box of ALL files appears.
File numbers where “No File” is displayed 
are empty file numbers. File numbers with a 
file name or a date and time are the number 
of files that already contain data.

3 Turn the MENU knob to select the 
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute], 
and then press the MENU knob.
To cancel the load, select [Cancel], and 
then press the MENU knob.
If you choose to execute the load, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section). The ACCESS lamp goes out and a 
completion message appears when the data 
has been loaded.

If an error message appears
One of the following error messages may appear 
during execution of the load, or as soon as you 
select [Execute]. In this case, the file is not loaded 
from the SxS memory card.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select All Load(USB) >Execute in step 2.

Error message Problem What to do
NG:Cannot Save No recordable 

media is 
inserted.

Insert 
recordable 
media.

NG:Media Full The media is 
full.

Use media with 
free capacity 
remaining.

Loading Setting Data

Error message Problem What to do
NG:No Data • There is no 

readable media
• The specified 

file does not 
exist on the 
media

Insert the 
media that 
contains the 
file you want.
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See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >All in the setup menu.

2 Select [All Preset], and then press the 
MENU knob.

3 To execute the reset, select [Execute], 
and then press the MENU knob.
To cancel the reset, select [Cancel], and 
then press the MENU knob.
If you choose to execute the reset, all settings 
in the ALL file are reset to preset values.

Scene files allow you to save the following types 
of data.
• Values set in the PAINT menu
• Shutter speeds set in standard mode or ECS 

mode
• White balance data

The data that is saved and loaded depends on the 
setting of FILE >Reference >Scene White Data 
in the setup menu.

To save a scene file to an SxS memory card, insert 
the card into a memory card slot and then proceed 
as follows.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >Scene in the setup menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 161).

2 Select Scene Store Mem >Excute (if you 
want to save the data in the camcorder’s 
internal memory), or select Scene Store 
SxS >Execute (if you want to save the 
data on an SxS memory card).

3 Press the MENU knob.
A list box of scene files appears.
File numbers where “No File” is displayed 
are empty file numbers

4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

Resetting a File after Changing Its 
Contents Saving and Loading 

Scene Files

Saving Scene Files
Saving and Loading Scene Files
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5 To execute the save, select [Execute], 
and then press the MENU knob.
To cancel the save, select [Cancel], and 
then press the MENU knob.
If you selected Scene Store SxS >Execute in 
step 2, the ACCESS lamp lights (in blue on 
the right-side panel and in orange in the card 
slot section) when you execute the save.
When the data has been saved, a completion 
message appears and the ACCESS lamp goes 
out.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select Scene Store USB >Execute in step 2.

To load a scene file from an SxS memory card, 
insert the SxS memory card into a memory card 
slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >Scene in the setup menu.

2 Select Scene Recall Mem >Execute (if 
you want to load the file from the 
camcorder’s internal memory), and 
select Scene Recall SxS >Execute (if you 
want to load the file from an SxS 
memory card).

3 Press the MENU knob.
A list box of scene files appears. File 
numbers where “No File” is displayed are 
empty file numbers.

4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute], 
and then press the MENU knob.
To cancel the load, select [Cancel], and 
then press the MENU knob.
If you selected Scene Recall SxS >Execute in 
step 2, the ACCESS lamp lights (in blue on 
the right-side panel and in orange in the card 
slot section) when you execute the load.

When the data has been loaded, a completion 
message appears and the ACCESS lamp goes 
out.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select Scene Recall USB >Execute in step 2.

Loading Scene Files
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Use FILE >Lens (see page 153) in the setup menu 
to set the data in lens files.
You can set the following data and save it as a 
lens file.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

To save a lens file to an SxS memory card, insert 
the card into a memory card slot and then proceed 
as follows.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >Lens in the setup menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 161).

2 Select Lens Store Mem >Execute (if you 
want to save the data in the camcorder’s 
internal memory), and select Lens Store 

SxS >Execute (if you want to save the 
data on an SxS memory card).

3 Press the MENU knob.
If you select [Execute], a list box of lens file 
number appears. File numbers where “No 
File” is displayed are empty file numbers.

4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

5 To execute the save, select [Execute], 
and then press the MENU knob.
To cancel the save, select [Cancel], and 
then press the MENU knob.
If you selected Lens Store SxS >Execute in 
step 2, the ACCESS lamp lights (in blue on 
the right-side panel and in orange in the card 
slot section) when you execute the save.
When the data has been saved, a completion 
message appears and the ACCESS lamp goes 
out.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select Lens Store USB >Execute in step 2.

To load a lens file from an SxS memory card, 
insert the SxS memory card into a memory card 
slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >Lens in the setup menu.

2 Select Lens Recall Mem >Execute (if 
you want to load the file from the 
camcorder’s internal memory), and 
select Lens Recall SxS >Execute (if you 
want to load the file from an SxS 
memory card).

3 Press the MENU knob.
If you select [Execute], a list box of lens files 
appears. File numbers where “No File” is 
displayed are empty file numbers.

Saving and Loading 
Lens Files

Setting Lens File Data

Setting data Sub-items
V modulation shading 
compensation values

M V Modulation

Center marker position Lens Center H
Lens Center V

Flare level Lens R Flare
Lens G Flare
Lens B Flare

White balance 
compensation value

Lens W-R Offset
Lens W-B Offset

White shading 
compensation value

L R/G/B H Saw
L R/G/B H Para
L R/G/B V Saw
L R/G/B V Para

Saving Lens Files

Loading Lens Files
Saving and Loading Lens Files
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4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute], 
and then press the MENU knob.
To cancel the load, select [Cancel], and 
then press the MENU knob.
If you selected Lens Recall SxS >Execute in 
step 2, the ACCESS lamp lights (in blue on 
the right-side panel and in orange in the card 
slot section) when you execute the load.
When the specified lens file has been loaded, 
a completion message appears and the 
ACCESS lamp goes out.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select Lens Recall USB >Execute in step 2.

When you are using a lens that support serial 
communication, you can set up the camcorder by 
automatically loading the lens file that 
corresponds to the lens settings (Lens Auto Recall 
function).
To use the Lens Auto Recall function, set FILE 
>Lens >Lens Auto Recall in the setup menu to 
one of the following.
On: Load the lens file that corresponds to the 

model name.
Off: Do not use the Lens Auto Recall function.
Serial Number: Load the lens file that 

corresponds to the model name and serial 
number (when the lens supports 
communication of the serial number).

If the lens does not support communication of the 
serial number, both settings load the lens file that 
corresponds to the model name.

You can save the customized USER menu 
configuration and settings along with white 
balance data as user files.

To save a user file to an SxS memory card, insert 
the card into a memory card slot and then proceed 
as follows.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >User in the setup menu.

To assign a name to the data before saving 
it 
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 161).

2 Select User Save SxS >Execute.
A user file list box appears.
File numbers where “No File” is displayed 
are empty file numbers. File numbers with a 
file name or a date and time are the number 
of files that already contain data.

3 Turn the MENU knob to select the 
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the save, select [Execute], 
and then press the MENU knob. To 
cancel the save, select [Cancel], and 
then press the MENU knob.
If you choose to execute the save, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section). A completion message appears and 
the ACCESS lamp goes out when the data 
has been saved.

Loading Lens Files Automatically

Saving and Loading 
User Files

Saving User Files
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Saving the USER menu as a user file in 
which all menu settings are reset to the 
preset values
Select Store User Preset >Execute in step 2.

When using a USB flash drive (in UDF 
mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select User Save USB >Execute in step 2.
The ACCESS lamp does not light while the 
save is being executed in step 5.

Note

When you load a file from an SxS memory card or a USB 
flash drive (in UDF mode) , the data saved in the 
camcorder’s internal memory is overwritten.

Depending on the settings of Use Load 
Customize Data and User Load White under 
FILE >User in the setup menu
When Load Customize Data is set to [Off]: 

Only USER menu settings are loaded. 
When Load Customize Data is set to [On]: 

USER menu configuration and settings are 
loaded.

When User Load White is set to [Off]: White 
balance data is not loaded.

When User Load White is set to [On]: White 
balance data is loaded.

See “Basic Setup Menu Operations” (page 109) for 
information about menu operations.

1 Select FILE >User in the setup menu.

2 Select User Load SxS >Execute.
A list box of user files appears.
File numbers where “No File” is displayed 
are empty file numbers. File numbers with a 
file name or a date and time are the number 
of files that already contain data.

3 Turn the MENU knob to select the 
desired file number.

4 Press the MENU knob.
A confirmation message appears.

5 To execute the load, select [Execute], 
and then press the MENU knob. To 

cancel the load, select [Cancel], and 
then press the MENU knob.
If you choose to execute the load, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section). The ACCESS lamp goes out and a 
completion message appears when the data 
has been loaded.

When using a USB flash drive (in UDF mode)
Connect a formatted USB flash drive (see 
page 73) to the external device connector.
Select User Load USB >Execute in step 2.
The ACCESS lamp does not light while the save 
is being executed in step 5.Loading Setting Data
Saving and Loading User Files
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You can connect an RM-B150/B750 Remote Control Unit and operate this camcorder. For connection and 
operation of the RM-B150/B750, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for 
Solid-State Memory Camcorder”).

Select the output signal and use an appropriate cable for the monitor to be connected.

Regardless of whether the signal is HD or SD, the 
same status information and menus can be 
displayed on the external monitor as those on the 
viewfinder screen.

Note

SD signals down-converted for output have the 
following restrictions:
Images of 50P/50i/25P are output as PAL signals, those 
of 59.94P/59.94i/29.97P are output as NTSC signals, and 
those of 23.98P are output as 2-3 pulled-down NTSC 
signals.

Chapter8 Connecting External Devices

Connecting External Monitors

BNC cable (not supplied)

BNC cable (not supplied)
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HD/SD SDI OUT connector (BNC)
The HD/SD SDI OUT connector can be used to 
connect a device that supports SDI. The device 
type can be a monitor, switcher, or VTR or other 
recording device.
The output from this connector can be turned on 
and off with OPERATION >Input/Output >SDI 
Output in the setup menu (see page 114).
For connection, use a BNC cable (not supplied).

VIDEO OUT connector
The VIDEO OUT connector can be used to 
connect a device that supports analog composite 
signal. The device type can be a monitor or VTR 
or other recording device.
The output signal varies as shown in the 
following table depending on the setting of 
OPERATION >Output&i.LINK in the setup 
menu.

a) Use OPERATION >Format >Country (see page 113) 
in the setup menu to switch between NTSC and PAL.

To input the VIDEO OUT connector output 
signal to an external analog composite device, it 
may be necessary to change the input signal 
setting of that external device to be matched with 
the analog composite signal setting for the 
VIDEO OUT connector.
To input camcorder output audio to an external 
device such as a monitor or VTR or other 
recording device, connect the audio output of the 
AUDIO OUT connector to the audio input of that 
external device.

For connection, use a BNC cable (not supplied).

i.LINK (HDV/DV) connector
In FAT mode, i.LINK (HDV/DV) connector 
supports HDV and DV input/output. However, 
DV streams cannot be recorded on this 
camcorder.
This connector can be used to connect a device 
that supports i.LINK (HDV). The device type can 
be a monitor, read/write device such as VTR or 
HDD, or computer.

To input/output HDV signals
HDV input/output is supported when the video 
format is an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.98P), Input/
Output >Output&i.LINK in the OPERATION 
menu is set to [HD&HDV] or [SD&HDV], and 
Input/Output >i.LINK I/O is set to [Enable].
When the video format is SP 1440/23.98P, a 
59.94i HDV signal subjected to 2-3 pulldown 
processing is output.

To input/output DV signals
DV input/output is supported under either of the 
following conditions.
• Input/Output >i.LINK I/O in the OPERATION 

menu is set to [Enable] on SD mode.
• On HD mode, the video format is other than DV 

incompatible formats (HQ 1920/23.98P, HQ 
1440/23.98P, and HQ 1280/23.98P), Input/
Output >Output&i.LINK is set to [SD&DV], 
and Input/Output >i.LINK I/O is set to 
[Enable].

Setting Output signal
HD&HDV (in FAT 
mode)
HD (in UDF mode)

HD-Y analog signal which 
has the same video format 
with the signal output from 
the HD/SD SDI OUT 
connector.

SD&HDV or 
SD&DV (in FAT 
mode)
SD (in UDF mode)

Composite signal which has 
the same video format with 
the signal output from the 
HD/SD SDI OUT connector.
When OPERATION 
>Format >HD/SD in the 
setup menu is [SD], the 
output composite signal is 
the same as the NTSC or 
PAL encoded signal that is 
output from the HD/SD SDI 
OUT connector a).
Connecting External Monitors
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The clips recorded on SxS memory cards with 
this camcorder can be controlled on a computer or 
edited using the optional nonlinear editing 
software.
For these purposes, the clips on an SxS memory 
card can be operated by directly loading the card 
in a computer or by connecting the camcorder or 
the optional SBAC-US10 SxS Memory Card 
USB Reader/Writer to the computer, using an 
USB cable as shown below.

If the computer is equipped with an ExpressCard/
34 or ExpressCard/54 slot, you can directly insert 
the SxS memory card containing clips recorded 
with this camcorder and access to the files.

For the operating requirements for the computer, see 
“Using the CD-ROM” (page 14).

Note

The SxS Device Driver Software and SxS UDF driver 
software on the CD-ROM supplied with the camcorder 
must be installed on your computer. Before installation, 
be sure to read the enclosed SxS Device Driver Software 
End-User License Agreement.

For information on installation of the driver 
software, refer to the ReadMe on the supplied CD-
ROM.

For support information for the driver software, visit 
the following URL:
http://www.sony.net/SxS-Support/

With a Windows computer
Check that a Removable Disk appears in My 
Computer. This indicates normal status.

With a Macintosh computer
An icon is displayed on the menu bar.

Preparations
When you connect the camcorder to a computer 
using a USB cable (not supplied), the memory 
card in the slot is acknowledged as an extended 
drive by the computer.
When two memory cards are mounted in this 
camcorder, they are acknowledged as two 
independent extended drives by the computer.

Notes

• When connecting the USB cable to the computer, be 
careful to check the form and direction of the USB 
connector.

• The camcorder does not work on the bus power from 
the computer. 

To start USB connection

Note

When a computer is connected to the PC connector of the 
camcorder and at the same time an optional PHU-120R 
Professional Harddisk Unit (powered from a battery) is 
connected to the computer, battery exhaustion on the 
PHU-120R (indicated by a Battery End warning) 
disables the following.
• To guard the PHU-120R against access from the 

computer
• To disconnect the PHU-120R’s cable from the 

memory card slot or plug again the cable into the slot

Operating Clips with a 
Computer

Using the ExpressCard Slot of a 
Computer

SxS PRO   8
GB

To the ExpressCard slot

SxS memory card Computer with SxS 
Device Driver 
Software installed

USB Connection with a Computer

USB cable 
(not supplied)
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• To turn on the tally indicator on the viewfinder screen 
to warn the operator

When you connect a computer to the PC 
connector with a USB cable (not supplied), the 
message “Connect USB Now?” is displayed to 
prompt you to confirm that you wish to enable the 
USB connection.
If you select “Cancel” or push the MENU 
CANCEL/PRST/ESCAPE down to the ESCAPE 
side or if you disconnect the USB cable, the 
message “Connect USB Now?” disappears.

If you select “Execute” and press the MENU 
knob, the USB connection is enabled and this 
camcorder is recognized as an extension drive. 
You can carry out the same operations by using 
the arrow buttons (J, j, K, k) (see page 22).

If the USB connection is enabled during 
recording/playback operation, the operation is 
stopped and the message “USB Connecting” 
appears on the viewfinder screen.
At this time, the output signal from the VIDEO 
OUT connector, and HD/SD SDI OUT connector 
changes to a black signal.

Notes

• The camcorder cannot be operated for recording, 
playback, and so on while the message “USB 
Connecting” is displayed.

• When the computer accesses the media loaded in the 
camcorder, do not try to carry out the following 
operations.
- Operating the camcorder (turning the power on/off, 

switching the operation mode, etc.)
- Removing or loading a media from an active slot 

(being accessed from the computer)
- Removing or connecting the USB cable

Disabling the USB connection
To disable the USB connection, follow the same 
procedure as that for removing a device from the 
computer.
To enable the USB connection again, first 
disconnect the USB cable and then reconnect it. 

The message “Connect USB Now?” appears 
again.

Note

If you connect the camcorder to the computer using an 
i.LINK cable, you cannot use the computer to operate 
files stored in a recording media loaded in the memory 
card slot of this camcorder.

To remove an SxS memory card

Windows

1. Click on the icon of “Safely Remove 
Hardware” on the task bar of the computer.

2. Select “Safely remove SxS Memory Card - 
Drive(X:)” from the displayed menu.

3. Check that the Safe To Remove Hardware 
message appears then remove the card.

Macintosh
Drag the SxS memory card icon on the desktop to 
Trash.
If the SxS memory card icon is located on Finder, 
click on the eject icon on its side.

To use the application software
To copy clips to the local disk of a computer, the 
supplied application software must be used.
Install the application software on the supplied 
CD-ROM to your computer.
Although the data regarding recorded materials 
are stored over multiple files and folders, you can 
easily handle the clips without considering such 
data and directory structure by using the supplied 
application software.

Note

If you operate, e.g. copy the clips on the SxS memory 
card by using the Explorer (Windows) or Finder 
(Macintosh), the subsidiary data contained by the clips 
may not be maintained. To avoid such a problem, use the 
application software.

For installation and operations, refer to the User’s 
Guide contained in the CD-ROM. 

For support information on the application software, 
visit on the cover page of the supplied CD-ROM.

To use a nonlinear editing system
For a nonlinear editing system, optional editing 
software that corresponds to the recording 
formats used with this camcorder is required.
Operating Clips with a Computer
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Store the clips to be edited on the HDD of your 
computer in advance, using the supplied 
application software.
Some editing software may not operate properly. 
Be sure to confirm before use that it conforms to 
the recording formats used with this camcorder.

You can record the same images as those 
recorded on the memory card in this camcorder 
on an external device connected to the i.LINK 
(HDV/DV) connector, or record the playback 
picture of the external device on the memory card 
in the camcorder.
When you connect the camcorder to a non-linear 
editing system that supports HDV format, you 
can edit the images recorded on the memory card 
in the camcorder.

Notes

• i.LINK connection is available only in FAT mode.
• Use the i.LINK (HDV/DV) connector only for one-to-

one i.LINK connection.
• When you change a setting which affects output 

signals from the i.LINK (HDV/DV) connector, such as 
HD/SD, HD System Line, System Frequency, and Rec 
Format under OPERATION >Format in the setup 
menu or i.LINK I/O and Down Converter under 
OPERATION >Input/Output in the setup menu, 
disconnect the i.LINK cable and change the setting. 
Changing such a setting with the i.LINK cable 
connected may cause improper operation of the 
connected i.LINK device.

• The external signal input via the i.LINK connection 
that can be recorded on the camcorder is HDV streams 
only. You cannot record DV streams via the i.LINK 
connection.

The picture being shot with this camcorder is 
output as an HDV or DV stream via the i.LINK 
(HDV/DV) connector. It can be recorded on a 
connected HDV or DVCAM recorder in 
synchronization with a recording start/stop 
operation on this camcorder.

1 Perform the preparatory settings of the 
camcorder.

Connecting an External 
Device (i.LINK 
Connection)

FAT

Recording the Camera Picture on 
an External Device
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• Set OPERATION >Input/Output >Output 
& i.LINK in the setup menu (see 
page 114) to “HD & HDV” or “SD & 
HDV”.
HD & HDV or SD & HDV: To output an 

HDV stream in HD mode when the 
video format is set to an HDV 
compatible format (SP 1440/59.94i, 
SP 1440/50i, or SP 1440/23.94P)

SD & DV: To output a DV stream
• Set OPERATION >Input/Output >i.LINK 

I/O in the setup menu to [Enable].
• Set MAINTENANCE >Trigger Mode 

>i.LINK Trigger Mode in the setup menu 
(see page 146) to [Both] or [External].
Both: To perform recording both on the 

memory card in this camcorder and on 
the external device

External: To perform recording only on 
the external device

2 Set the external device to recording 
standby status.

For operations of the external device, refer to 
the operation manual of that device.

3 Start recording.
The external device starts recording in 
synchronization.

The status of the external device is displayed in 
the i.LINK status indication area (see page 33) on 
the viewfinder screen.

Notes

• Operation may be different depending on the type of 
external device.

• When you execute the operation to make a recording 
on the recording media loaded in the camcorder while 
HDV signals are output from the i.LINK (HDV/DV) 
connector, HDV signal output stops for about one 
second before the recording starts, and then it resumes.

• While you can record shot marks on the memory card 
during recording, they are not added to the pictures 
recorded on the external device.

You can transfer an HDV stream to a nonlinear 
editing system connected via the i.LINK (HDV/
DV) connector.

Notes

• The i.LINK (HDV/DV) connector of this camcorder is 
a 6-pin connector. Check the number of pins of the 
i.LINK connector on your computer and use an 
appropriate i.LINK cable.

• In searching pictures of this camcorder on the 
computer, it may take some time until the display is 
reflected on the computer.

• If the playback clip is short or the playback starting 
point is near the end of the clip, the i.LINK signal may 
be interrupted between the clip and the next clip. When 
you try to capture such a signal using the nonlinear 
editing system, a malfunction may occur, depending 
on the nonlinear editing software in use.

• If you specify a search speed other than 4, 15, or 24 
times normal with the nonlinear editing system, no 
i.LINK signal is fed out. In such a case, the picture on 
the LCD monitor may stay frozen.

• High-speed playback picture may not be displayed on 
the computer screen, depending on the nonlinear 
editing software in use.

Setting on this camcorder
Set OPERATION >Input/Output >i.LINK I/O in 
the setup menu to [Enable].

For operations of the nonlinear editing software, 
refer to the operation manual of the software.

The HDV stream input from a device connected 
via the i.LINK (HDV/DV) connector can be 
recorded on an SxS memory card in this 
camcorder.
The timecodes superimposed on the i.LINK input 
are recorded regardless of the settings of the 
camcorder.

Note

DV stream cannot be recorded.

1 Set the external signal to a format that 
can be recorded on the camcorder.
Select an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.94P) for 
the video format.

Indication Status of the external device

STBY In HDV recording standby

zREC In HDV recording

STBY In DV recording standby

zREC In DV recording

HDV

HDV

DV

DV

Nonlinear Editing

Recording External Input Signals
Connecting an External Device (i.LINK Connection)
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2 Make the following settings with 
OPERATION >Input/Output in the 
setup menu (see page 114).
• Set Output&i.LINK to [HD&HDV] or 

[SD&HDV].
• Set i.LINK I/O to [Enable].
• Set Source Select to [i.LINK].
The input video is displayed on the 
viewfinder screen or the monitor connected 
to the VIDEO OUT connector.
Audio signals are output through the built-in 
speakers, the headphones connected to the 
EARPHONE connector, and the speakers of 
the monitor connected to the VIDEO OUT 
connector.

3 Start the recording.

Notes

• An error is generated in the following cases. In such a 
case, cancel Recording mode.
- The video format of input signal does not match that 

specified on the camcorder.
- A copy-protected stream is being fed in.

• If the input to the camcorder becomes no signal during 
recording, the TALLY indicators, the tally indicator on 
the front of the viewfinder, and the REC indication 
(zREC) on the viewfinder screen flash, indicating that 
no signal is being recorded on the SxS memory card.
When an input signal is resumed, recording is 
restarted, incrementing the clip number on the memory 
card.

If you install the optional CBK-HD02 on this 
camcorder, you can attach the XDCA-55 HD 
Camera Adaptor and connect the XDCU-50 HD 
Camera Extension Unit.
This allows you to configure a shooting and 
recording system consisting of multiple 
camcorders with camera extension units 
connected to a remote control unit. 

For more information about the XDCA-55 and 
XDCU-50, refer to their respective operation 
manuals. 

Note

When using the camcorder in this system, do not connect 
a video light to the camcorder.

Configuring a Shooting 
and Recording System
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Check the functions of the camcorder before 
setting out for a shooting session, preferably by 
recording and playing back video and audio 
signals. Use a dust blower to clean the CRT screen and 

mirror inside the viewfinder barrel.
Clean the lens and protecting filter with a 
commercially available lens cleaner.

Caution

Never use organic solvents such as thinners.

Disassembling the eyepiece for cleaning 
(example: HDVF-20A)

1 Detach the eyepiece from the viewfinder 
barrel.

For the detaching procedure, see “Detaching 
the Eyepiece” on page 39.

2 Remove the eyecup from the eyecup 
holder.

Chapter9 Maintenance

Testing the Camcorder Maintenance

Cleaning the Viewfinder

1Viewfinder barrel
2Eyecup holder
3Protecting filter
4Packing ring
5Eyecup
Testing the Camcorder / Maintenance
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3 Remove the protecting filter, together 
with the packing ring, from inside the 
eyecup holder.

4 Detach the protecting filter from the 
packing ring.

Fog-proof filter
Depending on the temperature and humidity, the 
protecting filter may mist because of vapor or 
your breath. To ensure that the viewfinder is 
always clear, replace the protecting filter with a 
fog-proof filter (service part number: 1-547-341-
11).

Fitting the fog-proof filter
Replace the protecting filter on the packing ring 
with the fog-proof filter.
Be sure to correctly assemble the fog-proof filter, 
the packing ring, and the eyecup so that the 
reassembled eyepiece is waterproof.

Note

When cleaning the fog-proof filter, wipe it very gently 
with a soft cloth to avoid damaging the anti-fogging 
coating.

The battery terminal of this unit (the connector for 
battery packs and AC adaptors) is a consumable 
part.
Power may not be supplied to the unit properly if 
the pins of the battery terminal are bent or 
deformed by shock or vibrations, or if they 
become corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep 
the unit working properly and to prolong its 
usable lifetime.

Contact a Sony service or sales representative for 
more information about inspections.

Note about the Battery Terminal
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If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various 
visible and audible indicators. These visible and audible indicators are:
• Error/warning message (“A” in the “Layout of the table of warning messages” below)
• WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication 

(“D”), and battery remaining indicator (“E”).
A warning message, and the REC indication appear on the viewfinder screen.
The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the 
minimum position to suppress the sound.

Layout of the table of warning messages

• The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is 
represented by graphic symbols as follows.

: Continuous
: 1 flash/s
: 4 flashes/s

• The warning sounds are represented by graphic symbols as follows.
: Continuous beep

: 1 beep/s

Operation Warnings
A

WARNING indicator Warning sound Tally/REC Battery remaining

B C D E

Problem Operation in the recorder 
module

Action to take

Error Indication

E
**

**
*

WARNING indicator Warning sound Tally/REC Battery remaining

— —

Problem Operation in the recorder 
module

Action to take

Error (The camcorder 
is abnormal.)

Recording stops. Turn off the power and confirm whether an error 
occurs on the connected devices, the cables, and 
the media or not. (If power cannot be turned off 
by setting the POWER switch to OFF, remove the 
battery pack or the AC power source.)
If the problem continues after the camcorder is 
restarted, contact your Sony service 
representative.
Operation Warnings
Download from Www.Somanuals.com. All Manuals Search And Download.



C
hapter 9  M

aintenance
Warning Indication
M

ed
ia

 N
ea

r 
F

ul
l

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 
module

Action to take

Free space on the SxS 
memory card has 
become insufficient.

Recording continues. Replace it with another at the earliest opportunity.

M
ed

ia
 F

ul
l

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 
module

Action to take

No space is left on the 
SxS memory card. 
Recording, clip 
copying and clip 
division cannot be 
performed.

Recording stops. Replace it with another.

B
at

te
ry

 N
ea

r 
E

nd

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 
module

Action to take

The battery power will 
be exhausted soon.

Recording continues. Charge the battery pack at the earliest 
opportunity.

B
at

te
ry

 E
nd

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 
module

Action to take

The battery pack is 
exhausted. Recording 
cannot be performed.

Recording stops. Connect a power source via the DC IN connector 
or stop operation to charge the battery pack.

T
em

pe
ra

tu
re

 H
ig

h

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the recorder 
module

Action to take

The internal 
temperature has risen 
above a safe operation 
limit.

Recording continues. Suspend operation, turn off the power, and wait 
until the temperature falls.
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V
ol

ta
ge

 L
ow

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 
module

Action to take

The DC IN voltage has 
become low (stage 1).

Recording continues. Check the power supply.

In
su

ff
ic

ie
nt

 V
ol

ta
ge

WARNING indicator Warning sound Tally/REC Battery remaining

  

Problem Operation in the recorder 
module

Action to take

The DC IN voltage is 
too low (stage 2). 
Recording cannot be 
performed.

Recording stops. Connect other power source.

B
at

te
ry

 E
rr

or
P

le
as

e 
C

ha
ng

e 
B

at
te

ry
. WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

An error was detected 
with the battery pack.

Recording stops. Replace the battery pack with a normal one.

B
ac

ku
p 

B
at

te
ry

 E
nd

P
le

as
e 

C
ha

ng
e.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The remaining power 
of the backup battery 
is insufficient.

Recording continues. Refer to a Sony service representative to replace 
the battery with a new one.

U
nk

no
w

n 
M

ed
ia

(A
)1)

P
le

as
e 

C
ha

ng
e.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

A partitioned memory 
card or one that 
contains recorded clips 
exceeding the number 
permitted with this 
camcorder is loaded.

Recording continues. This card cannot be used with this camcorder. 
Remove it and load a compatible card.
Operation Warnings
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R
ea

ch
ed

 C
lip

 N
um

be
r 

L
im

it

C
an

no
t 

R
ec

or
d 

to
 M

ed
ia

(A
)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The maximum number 
of clips for a single 
memory card is 
reached. No more clip 
can be recorded on the 
card.

Recording stops. Replace it with another card.

M
ed

ia
 E

rr
or

M
ed

ia
(A

)1)
 N

ee
ds

 t
o 

be
 R

es
to

re
d WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

An error occurred with 
the memory card. The 
card requires 
restoration.

Recording stops. Remove the card, load it again, and restore it.

M
ed

ia
 E

rr
or

C
an

no
t 

R
ec

or
d 

to
 M

ed
ia

(A
)1) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

Recording cannot be 
done, as the memory 
card is defective.

Recording stops. As playback may be possible, it is recommended 
to replace it with another card after copying the 
clips, as required.

M
ed

ia
 E

rr
or

C
an

no
t 

U
se

 M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

Neither recording nor 
playback can be done, 
as the memory card is 
defective.

Recording stops. It cannot be operated with this camcorder. 
Replace it with another card.

C
an

no
t 

U
se

 M
ed

ia
(A

)1)

U
ns

up
po

rt
ed

 F
ile

 S
ys

te
m WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

A card of a different 
file system was 
inserted.

Recording stops. It cannot be used with this camcorder. Replace it 
with another card.
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V
id

eo
 F

or
m

at
 M

is
m

at
ch

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The external signal 
input via the i.LINK 
connection cannot be 
recorded, as the Video 
Format setting is 
different from the 
signal format of the 
external input signal.

Recording stops. Change settings of OPERATION >Format in the 
setup menu to match it to that of the external 
signal.

C
op

y 
P

ro
te

ct
ed

 I
np

ut
C

an
no

t 
R

ec
or

d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The external signal 
input via the i.LINK 
connection cannot be 
recorded, as the stream 
is copy-protected.

Recording stops. Check the input signal.

D
V

C
A

M
 I

np
ut

 S
ig

na
l!

 C
an

no
t 

R
ec

or
d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The external signal 
input via the i.LINK 
connection cannot be 
recorded, as it is a DV 
stream.

Recording stops. —

M
ed

ia
 E

rr
or

P
la

yb
ac

k 
H

al
te

d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

An error occurred in 
reading data from the 
memory card, and 
playback cannot be 
continued.

Recording stops. If this frequently occurs, change the memory card 
after copying the clips, as required.

M
ed

ia
(A

)1)
 E

rr
or

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

Recording cannot be 
done, as an error 
occurred with the 
memory card.

Recording stops. If this frequently occurs, change the memory 
card.
Operation Warnings
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H
D

D
 A

2)
 B

at
te

ry
 N

ea
r 

E
nd WARNING indicator Warning sound Tally/REC Battery remaining

—

Problem Operation in the recorder 
module

Action to take

The battery power of 
the connected HDD 
will be exhausted 
soon.

Recording continues. Change the battery at the earliest opportunity.

H
D

D
 A

2)
 B

at
te

ry
 E

nd

WARNING indicator Warning sound Tally/REC Battery remaining

—

Problem Operation in the recorder 
module

Action to take

The battery of the 
connected HDD is 
exhausted. Recording 
cannot be performed.

Recording stops. Stop operation to change the battery.

N
ot

 E
no

ug
h 

C
ap

ac
it

y

C
ha

ng
e 

M
ed

ia
(A

)1) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

There is not enough 
capacity for copying.

Recording continues 
(disallowing copy).

Replace the card in slot A with another one.

R
ea

ch
ed

 D
up

lic
at

io
n 

L
im

it

C
ha

ng
e 

M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The card has already 
ten clips having the 
same name as that you 
tried to duplicate.

Recording continues 
(disallowing copy).

Replace the card in slot A with another one.

N
ot

 E
no

ug
h 

C
ap

ac
it

y
C

an
no

t 
D

iv
id

e

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

There is not enough 
capacity for dividing a 
clip.

Recording continues 
(disallowing divide).

—

W
ill

 S
w

it
ch

 S
lo

ts
 S

oo
n WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

Will switch to other 
slot soon.

Recording continues. Make sure that a memory card is loaded in the 
other slot.
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N
o 

C
lip

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

There is no clip to be 
displayed.

Recording continues. —

N
o 

O
K

 C
lip

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

There is no clip with 
the OK mark.

Recording continues. —

Sa
m

e 
F

ile
 A

lr
ea

dy
 E

xi
st

s

C
ha

ng
e 

M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The card has already 
clips having the same 
name as that you tried 
to duplicate.

Recording continues 
(disallowing copy).

Replace the card in slot A with another one.

M
ed

ia
 R

ea
ch

ed
 R

ew
ri

ti
ng

 L
im

it

C
ha

ng
e 

M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The memory card 
comes to the end of its 
service life.

Recording stops. Make a backup copy and replace the card with 
another one as soon as possible. Recording/
playback may not be performed properly if you 
continue to use the card.
For details, refer to the Operating Instructions of 
the memory card.

U
ns

up
po

rt
ed

 C
lip

 I
nc

lu
de

d

C
an

no
t 

U
se

 M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The inserted memory 
card contains clips 
recorded in a format 
that is not supported 
by this camcorder.

— The card in slot A cannot be used with this 
camcorder.
Operation Warnings
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1) (B) for the card in slot B
2) B for a HDD connected to slot B

F
an

 S
to

pp
ed

1)
WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the recorder 
module

Action to take

The fan does not rotate 
when started.

— Avoid use under high temperature conditions. 
Power the camcorder off and contact a Sony 
service representative.

M
ed

ia
 w

as
 E

je
ct

ed
 J

us
t 

N
ow

It
 N

ee
ds

 t
o 

be
 R

es
to

re
d

WARNING indicator Warning sound Tally/REC Battery remaining

—   — — —

Problem Operation in the recorder 
module

Action to take

Restoration is required 
because the media was 
removed while the 
camcorder was in
recording standby 
mode of Clip 
Continuous Rec (see 
page 84).

Recording continues. Insert again the media which was removed and 
restore it (see page 72).

U
SB

(H
os

t)
O

ve
r 

C
ur

re
nt

R
em

ov
e 

U
SB

 D
ev

ic
e

WARNING indicator Warning sound Tally/REC Battery remaining

—   — — —

Problem Operation in the recorder 
module

Action to take

Power to the external 
device connector was 
removed because 
overcurrent was 
detected on the 
connector. (Other 
operations are not 
affected.) 

Recording continues. Power the camcorder off and remove the Wi-Fi 
adapter or USB flash drive that is connected to 
the external device connector.
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Use and storage

Do not subject the camcorder to severe shocks
• The internal mechanism may be damaged or the 

body warped.
• If an accessory mounted on the accessory shoe 

is subjected to severe shock, the accessory shoe 
may be damaged. In such a case, stop using it 
and contact your dealer or a Sony service 
representative.

Do not cover the camcorder while operating
Putting a cloth, for example, over the camcorder 
can cause excessive internal heat build-up.

After use
Always turn off the POWER switch.

Before storing the camcorder for a long period
Remove the battery pack.

Shipping
• Remove the media before transporting the 

camcorder.
• If sending the camcorder by truck, ship, air or 

other transportation service, pack it in the 
shipping carton of the camcorder.

Care of the camcorder
Remove dust and dirt from the surfaces of the 
lenses or optical filters using a blower.
If the body of the camcorder is dirty, clean it with 
a soft, dry cloth. In extreme cases, use a cloth 
steeped in a little neutral detergent, then wipe dry. 
Do not use organic solvents such as alcohol or 
thinners, as these may cause discoloration or 
other damage to the finish of the camcorder.

In the event of operating problems
If you should experience problems with the 
camcorder, contact a Sony service representative.

Use and storage locations
Store in a level, ventilated place. Avoid using or 
storing the camcorder in the following places.
• In excessive heat or cold (operating temperature 

range: –5°C to +40°C (23°F to 104°F))
• Remember that in summer in warm climates the 

temperature inside a car with the windows 
closed can easily exceed 50°C (122°F).

• In damp or dusty locations
• Locations where the camcorder may be exposed 

to rain
• Locations subject to violent vibration
• Near strong magnetic fields
• Close to radio or TV transmitters producing 

strong electromagnetic fields.
• In direct sunlight or close to heaters for 

extended periods

To prevent electromagnetic interference from 
portable communications devices
The use of portable telephones and other 
communications devices near this camcorder can 
result in malfunctions and interference with audio 
and video signals.
It is recommended that the portable 
communications devices near this camcorder be 
powered off.

Fitting the zoom lens
It is important to fit the lens correctly, as 
otherwise damage may result. Be sure to refer to 
the section “Mounting and Adjusting the Lens” 
(page 42).

Viewfinder
Do not leave the camcorder with the eyepiece 
pointing directly at the sun.
The eyepiece lens can concentrate the sun’s rays 
and melt the interior of the viewfinder.

About the LCD panels
The LCD panel fitted to this camcorder is 
manufactured with high precision technology, 
giving a functioning pixel ratio of at least 99.99%. 
Thus a very small proportion of pixels maybe 

Appendix

Important Notes on 
Operation
Important Notes on Operation
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“stuck”, either always off (black), always on (red, 
green, or blue), or flashing. In addition, over a 
long period of use, because of the physical 
characteristics of the liquid crystal display, such 
“stuck” pixels may appear spontaneously. These 
problems are not a malfunction. Note that any 
such problems have no effect on recorded data.

Phenomena specific to CCD image 
sensors
The following phenomena that may appear in 
images are specific to CCD (Charge Coupled 
Device) image sensors. They do not indicate 
malfunctions.

White flecks
Although the CCD image sensors are produced 
with high-precision technologies, fine white 
flecks may be generated on the screen in rare 
cases, caused by cosmic rays, etc.
This is related to the principle of CCD image 
sensors and is not a malfunction.

The white flecks especially tend to be seen in the 
following cases:
• When operating at a high environmental 

temperature
• When you have raised the master gain 

(sensitivity)

In SLS mode, white flecks are more prominent 
when you set the shutter speed (number of 
frames) to higher values.

The problem may be alleviated by executing the 
APR (automatic pixel noise reduction) function 
with MAINTENANCE >APR in the setup menu 
(see page 146). Pixel noise is reduced to some 
extent by automatic black balance adjustment 
(see page 54), but the detection capabilities of 
that function are limited. For the most effective 
correction, execute the APR function.

Vertical smear
When an extremely bright object, such as a strong 
spotlight or flashlight, is being shot, vertical tails 
may be produced on the screen, or the image may 
be distorted.

Aliasing
When fine patterns, stripes, or lines are shot, they 
may appear jagged or flicker.

Fragmentation
If pictures cannot be recorded/reproduced 
properly, try formatting the recording medium.
While repeating picture recording/playback with 
a certain recording medium for an extended 
period, files in the medium may be fragmented, 
disabling proper recording/storage. In such a 
case, make a backup of clips in the medium then 
perform formatting of the medium using 
OPERATION >Format Media (see page 113) in 
the setup menu.

1Monitor screen
2Vertical tails shown on the image
3Bright object (e.g. strong spotlight, 

strong reflected light, flashlight, the sun)
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The camcorder’s internal clock is powered by a 
lithium battery. If the message “BackUp Battery 
End” appears in the viewfinder, this battery must 
be exchanged. Contact a Sony service 
representative.

Exchanging the Battery 
of the Internal Clock

Specifications

General

Power requirements

12 V DC (11 V to 17.0 V)

Power consumption

Approx. 27 W (main unit only, during recording 

with the LCD monitor lit)

Notes

• Do not use a video light with power 
consumption of over 50 W.

• When connecting a device to the DC OUT 
connector, use one with current 
consumption of 0.5 A or more.

Operating temperature

–5ºC to +40ºC (23ºF to 104ºF)

Storage temperature

–20ºC to +60ºC (–4ºF to 140ºF)

Recording/playback formats

UDF mode

• HD422
Video codec: MPEG-2 422P@HL

Video rate: 50 Mbps/CBR 

Video samples: 1920 × 1080, 1280 × 720

Proxy video: MPEG-4

Audio: LPCM 4CH, 24 bits, 48 kHz

Proxy audio: A-law

• HD420
Video codec: MPEG-2 MP@HL(1440) 

Video rate: 35 Mbps/VBR 

Video samples: 1440 × 1080

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz

Proxy audio: A-law

Video codec: MPEG-2 MP@HL 

Video rate: 35 Mbps/VBR

Video samples: 1280 × 720

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz

Proxy audio: A-law
Exchanging the Battery of the Internal Clock / Specifications
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• IMX
Video codec: MPEG-2 422P@ML Intra 

Video rate: 50 Mbps

Video samples: 720 × 486 (NTSC)/576 (PAL)

Proxy video: MPEG-4

Audio: LPCM 4CH, 24/16 bits, 48 kHz

Proxy audio: A-law

• DVCAM
Video rate: 25 Mbps

Video samples: 720 × 480 (NTSC)/576 (PAL)

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bits, 48 kHz

Proxy audio: A-law

FAT mode

• HD420
Video codec: MPEG-2 MP@HL 

Video rate: 35 Mbps/VBR 

Video samples: 1920 × 1080, 1280 × 720

Audio: LPCM 4CH, 16 bits, 48 kHz

Video codec: MPEG-2 MP@HL(1440)

Video rate: 35 Mbps/VBR 

Video samples: 1440 × 1080

Audio: LPCM 4CH, 16 bits, 48 kHz

Video codec: MPEG-2 MP@H14 

Video rate: 25 Mbps/CBR 

Video samples: 1440 × 1080

Audio: LPCM 4CH, 16 bits, 48 kHz

• DVCAM
Video rate: 25 Mbps

Video samples: 720 × 480 (NTSC)/576 (PAL)

Audio: LPCM 2CH, 16 bits, 48 kHz

Recording/playback time

With one SBP-16

FAT mode HQ: About 50 minutes

SP: About 70 minutes

DVCAM: About 65 minutes

UDF mode HD422 50/IMX50: About 

30 minutes

HD420 HQ: About 45 minutes

DVCAM: About 55 minutes

With one SBP-32/SBS-32G1A

FAT mode HQ: About 100 minutes

SP: About 140 minutes

DVCAM: About 130 minutes

UDF mode HD422 50/IMX50: About 

60 minutes

HD420 HQ: About 90 minutes

DVCAM: About 110 minutes

With one SBS-64G1A

FAT mode HQ: About 200 minutes

SP: About 280 minutes

DVCAM: About 260 minutes

UDF mode HD422 50/IMX50: About 

120 minutes

HD420 HQ: About 

180 minutes

DVCAM: About 220 minutes

Note

The actual recording/playback time may differ 

slightly from the values shown here, depending 

on usage conditions, memory characteristics, 

etc.

Continuous operation time

With the BP-GL95

Approx. 180 min.

Mass

Main body only: 3.4 kg (7 lb 7.9 oz)

Dimensions

See page 190.

Supplied accessories

See page 189.

Camera Block

Pickup device
2/3-type, CCD image sensor

Effective picture elements: 

1920 (H) × 1080 (V)

Format

3-chip RGB
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LCD monitor

Input/Output connectors

Optical system

F1.4 prism system

ND filters

1: Clear

2: 1/4ND

3: 1/16ND

4: 1/64ND

Sensitivity

F11 (System frequency: 59.94i)

F12 (System frequency: 50i) 

(2000lx, 89.9% reflection, 3200K)

Minimum illumination

0.016 lx (F1.4, +42 dB, 16-frame accumulation)

Video S/N

54 dB (Noise Suppress Off)

59 dB (Noise Suppress On)

Horizontal resolution 

1000TV lines or more 

Modulation

45% or more (27.5 MHz, at screen center)

Black level

3±1% (when Black in the setup menu is set to 

[±0])

Gain

–6, –3, 0, 3, 6, 9, 12, 18, 24, 30, 36, 42 dB, AGC

Shutter speed

59.94i/P, 50i/P: 1/60 to 1/2000 sec.

29.97P: 1/40 to 1/2000 sec.

25P: 1/33 to 1/2000 sec.

23.94P: 1/32 to 1/2000 sec.

Slow shutter

2 to 8, 16 frames

Dynamic range

600%

460% (1080/29.97P, 1080/25P, 1080/23.98P)

Smear

–135 dB

Audio Block

Sampling frequency

48 kHz

Quantization

16 bits/24 bits

Headroom

20 dB (the factory default setting) 

(20, 18, 16, 12 dB), EBU

Frequency response

20 Hz to 20 kHz (within ±3 dB)

Dynamic range

90 dB (typical)

Distortion

0.08% max. (with input level 40 dBu)

Built-in speaker

Monaural

Output: 300 mW

Display

Screen size

8.8 cm diagonal (3.5-inch)

Aspect ratio

16:9

Picture elements

640 (H) × 3 × 480 (V) Sequence delta

Transmission system

Hybrid (semi-transmissive) type

Media Block

Card slots

Type: Express Card34

Number of slots: 2

Connector: Conforms to PCMCIA Express Card 

Standard

Writing rate

50 Mbps or more

Reading rate

50 Mbps or more

Inputs/Outputs

Signal inputs

GENLOCK IN: BNC type

1.0 Vp-p, 75 Ω, unbalanced

TC IN: BNC type

0.5 V to 18 Vp-p, 10 kΩ

AUDIO IN CH-1/CH-2: XLR type, 3-pin, 

female

(With automatic detection and switching 

function)

MIC: –70 to –20 dBu
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Option key

Power supply and related equipment

Lens, Viewfinder and Related Equipment

Equipment for remote control

LINE: +4, 0, –3 dBu

MIC IN: XLR type, 5-pin, female

–70 to –20 dBu

WRR CH1/CH2

D-sub 15-pin

WRR analog: –40 dBu

WRR digital: –40 dbFS

HD/SD SDI

When an option is installed

4-channel audio

Signal outputs

VIDEO OUT: BNC type, switching between SD 

analog composite and HD-Y

HD/SD SDI OUT 1/2: BNC type

0.8 Vp-p, unbalanced (switching between 

HD and SD)

Complied to SMPTE292M/259M

4-channel audio (CH1 to CH4)

AUDIO OUT: XLR type, 5-pin, male

+4, 0, –3 dBu (balanced)

TC OUT: BNC type

1.0 Vp-p, 75 Ω

EARPHONE (stereo minijack)

8 Ω, 5 mW

Others

DC IN: XLR type, 4-pin, male

11 to 17 V DC

DC OUT: 4-pin

11 to 17 V DC, maximum rated current: 

0.5 A

LENS: 12-pin

Supplying power to the lens

11 to 17 V DC, maximum rated current: 

1.0 A

REMOTE: 8-pin

LIGHT: 2-pin

USB: 4-pin (type A), 4-pin  (type B)

i.LINK (HDV/DV): 6-pin, complies with 

IEEE1394

VF: 26-pin, rectangular, 20-pin round

For wireless receiver: D-sub 15-pin

Supplied Accessories

Shoulder strap (1)

Cold shoe kit (1 set)

Lens mount cap (1)

Flange back adjustment chart

OPERATION MANUAL

Japanese version (1)

English version (1)

CD-ROM

- Utility Software for XDCAM (application 

software, device driver software) (1)

- Manuals for Solid-State Memory Camcorder 

(PDF OPERATION MANUAL and 

SUPPLEMENT) (1)

Recommended Additional 
Equipment

SD Record and Playback Key

CBK-MD01

Hardware Upgrade Key

CBK-UPG01

AC Adaptor

AC-DN10/DN2B

Battery Pack

BP-L80S/L60S

Battery Charger

BC-M150/L500/L70

Lens
2/3-type bayonet mount lenses only

Viewfinder

HDVF series viewfinder: HDVF-200/20A/

C35W/C950W/C730W

CBK-VF01

Viewfinder Rotation Bracket

BKW-401

Remote Control Unit

RM-B150/B750

RCP-1000/1500/1530

SDI/COMPOSITE Input and 50 Pin Interface

CBK-HD02

HD Camera Adaptor

XDCA-55 (when an optional CBK-HD02 is 
installed)

HD Camera Extension Unit

XDCU-50
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Media

Audio equipment

Other peripheral devices

Equipment for maintenance and easier handling

Dimensions 

Design and specifications are subject to change 
without notice.

MPEG TS Adaptor

HDCA-702 (when an optional CBK-HD02 is 
installed)

Wi-Fi Adapter

CBK-WA01 (when an optional CBK-UPG01 
is installed)

SxS Memory Card

SxS PRO SBP-16 (16 GB)

SxS PRO SBP-32 (32 GB)

SxS-1 SBS-32G1A (32 GB)

SxS-1 SBS-64G1A (64 GB)

Professional Harddisk Unit

PHU-120R (in FAT mode)

Media Adaptor

MEAD-MS01 (for “Memory Stick PRO-HG 

Duo HX” series)

MEAD-SD01 (for SDHC card)

Mobile Storage Unit

PXU-MS240

Microphone

ECM-678/674/673/680S

Microphone Holder

CAC-12

Wireless Microphone

DWR-S01D

WRR-855S/860C/861/862

Tripod adaptor

VCT-14/U14

Video Light

UC-D200A (PROTECH)

Ultralight (Anton Bauer)

Pad

CBK-SP01 Soft Type Shoulder Pad

Hard Carrying Case

LC-H300

Soft Carrying Case

LC-DS300SFT

Maintenance Manual

Notes

• Always make a test recording, and verify that it was 

recorded successfully.

SONY WILL NOT BE LIABLE FOR DAMAGES 

OF ANY KIND INCLUDING, BUT NOT 

LIMITED TO, COMPENSATION OR 

REIMBURSEMENT ON ACCOUNT OF 

FAILURE OF THIS UNIT OR ITS RECORDING 

MEDIA, EXTERNAL STORAGE SYSTEMS OR 

ANY OTHER MEDIA OR STORAGE SYSTEMS 

TO RECORD CONTENT OF ANY TYPE.

• Always verify that the unit is operating properly 

before use. SONY WILL NOT BE LIABLE FOR 

DAMAGES OF ANY KIND INCLUDING, BUT 

NOT LIMITED TO, COMPENSATION OR 

REIMBURSEMENT ON ACCOUNT OF THE 

LOSS OF PRESENT OR PROSPECTIVE 

PROFITS DUE TO FAILURE OF THIS UNIT, 

EITHER DURING THE WARRANTY PERIOD 

OR AFTER EXPIRATION OF THE 

WARRANTY, OR FOR ANY OTHER REASON 

WHATSOEVER.

(in mm (inches))
Specifications
Download from Www.Somanuals.com. All Manuals Search And Download.



A
ppendix
Chart of Optional Components and Accessories

a) The carrying case is large enough to hold the camcorder with lens and microphone mounted. However, 
remove them if they protrude more than 25 cm (9 7/8 inches) from the front of the main unit.

ECM-680S/678/
674/673 
Microphone

CAC-12 
Microphone Holder

HD monitor/SD monitor

XDCAM HD series recorder
PDW-F1600/HD1500, PDW-F75

HDCAM series recorder
HDW-2000 series recorder, HDW-S280

WRR-855S UHF Synthesized Tuner Unit
DWR-S01D Digital Wireless Receiver

PMW-500

RM-B150/B750
RCP-730/750/751/
920/921
MSU-900/950/700
Remote Control Unit

VCT-14/U14 

Tripod Adaptor

Tripod

LC-DS300SFT a) 
Soft Carrying 
Case

AC-DN10/DN2B 
AC Adaptor

BC-L500 Battery 
Charger

BC-M150 Battery 
Charger

BC-L70 Battery 
Charger

BP-GL95/GL65/L80S/
L60S 
Battery Pack

SBP-16/32
SBS-32G1A/64G1A
SxS Memory Card

PHU-120R 
Professional Harddisk Unit

LC-H300 
Hard Carrying Case

HDVF-200/20A/
C35W/C950W/
C730W Viewfinder

CBK-MD01 SD Record and Playback Key

MEAD-MS01, MEAD-SD01 Media Adaptor

PXU-MS240 Mobile Storage Unit

CBK-HD02 SDI/COMPOSITE Input and 
50 Pin Interface + XDCA-55 HD Camera 
Adaptor

XDCU-50 HD Camera Extension Unit

CBK-VF01 
Viewfinder

CBK-UPG01 Hardware Upgrade Key + CBK-WA01 
Wi-Fi Adapter

CBK-HD02 SDI/COMPOSITE Input and 50 Pin Interface

CBK-HD02 SDI/COMPOSITE Input and 
50 Pin Interface + HDCA-702 MPEG TS 
Adapter
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This section explains the specifications and 
features of i.LINK.

What is i.LINK?
i.LINK is a digital serial interface designed to 
integrate devices equipped with i.LINK 
connectors. i.LINK allows your device to:
• Perform two-way transmission and reception of 

data such as digital audio and digital video 
signals.

•  Control other i.LINK devices.
•  Easily connect multiple devices with a single 

i.LINK cable.
Your i.LINK device is capable of connecting to a 
wide range of digital AV devices for data transfer 
and other operations.
Other advantages include the following feature. 
When connected to multiple i.LINK devices, 
your i.LINK device can perform data transfer and 
other operations not only
with the directly connected devices but also with 
any of the devices that are connected to those 
devices. Therefore, you do not need to be 
concerned with device connection order.
However, depending on the features and 
specifications of the connected devices, you may 
need to use certain functions differently, and you 
may not be able to transfer data or perform certain 
operations.

i.LINK, a nickname for IEEE 1394 proposed by 
Sony, is a trademark supported by many 
companies worldwide.
IEEE 1394 is an international standard defined by 
IEEE, the Institute of Electrical and Electronics 
Engineers, Inc.

Note

The camcorder can be connected to one device with the 
i.LINK cable (DV cable). When you connect with an 
HDV or DV device that has two or more i.LINK 
connectors, refer to the
Operating Instructions supplied with the connected 
device.

About data transfer speed of i.LINK
i.LINK defines a maximum data transfer speed of 
approximately 100, 200 and 400 Mbps 1) that are 
described as S100, S200 and S400 respectively.
For i.LINK devices, a maximum data transfer 
speed that the device supports is identified on 
“Specifications” page of the Operating 
Instructions supplied with the device or near its 
i.LINK connector.
1) When connecting with the device that support 

different data transfer speed, the actual data transfer 
speed may be different from those described on the 
i.LINK connectors.

What is Mbps?
Mega bits per second. A measure of the rate at 
which data is transmitted per second. In case of 
100 Mbps, 100 Mega bits of data can be 
transmitted per second.

i.LINK operation with your camcorder
For details on operation when other equipment 
with i.LINK (HDV or DV) connector is 
connected, see page 171.

For details on connection with i.LINK cable and 
necessary software, refer to the Operating 
Instructions supplied with the connected device.

About the required i.LINK cable
Use the Sony 6-pin-to-4-pin or 6-pin-to-6-pin 
i.LINK cable to connect the i.LINK devices.

i.LINK and  are trademarks.

About i.LINK
About i.LINK
Download from Www.Somanuals.com. All Manuals Search And Download.



A
ppendix
THIS PRODUCT IS LICENSED UNDER THE 
MPEG-4 VISUAL PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL AND NON-
COMMERCIAL USE OF A CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE 
WITH THE MPEG-4 VISUAL STANDARD 
(“MPEG-4 VIDEO”)
AND/OR
(ii) DECODING MPEG-4 VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN 
A PERSONAL AND NON-COMMERCIAL 
ACTIVITY AND/OR WAS OBTAINED FROM 
A VIDEO PROVIDER LICENSED BY MPEG 
LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE 
IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING 
THAT RELATING TO PROMOTIONAL, 
INTERNAL AND COMMERCIAL USES AND 
LICENSING MAY BE OBTAINED FROM 
MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) 
manufacturing/sales of any storage media storing 
MPEG-4 Visual video information (ii) 
distribution/broadcasting of MPEG-4 Visual 
video information in any manner (such as online 
video distribution service, internet broadcasting, 
TV broadcasting). Other usage of this product 
may be required to obtain license from MPEGLA. 
Please contact MPEG LA for any further 
information. MPEG LA, L.L.C., 250 STEELE 
STREET, SUITE 300, DENVER, COLORADO 
80206, http://www.mpegla.com

ANY USE OF THIS PRODUCT OTHER THAN 
CONSUMER PERSONAL USE IN ANY 
MANNER THAT COMPLIES WITH THE 
MPEG-2 STANDARD FOR ENCODING 
VIDEO INFORMATION FOR PACKAGED 
MEDIA IS EXPRESSLY PROHIBITED 
WITHOUT A LICENSE UNDER 
APPLICABLE PATENTS IN THE MPEG-2 
PATENT PORTFOLIO, WHICH LICENSE IS 
AVAILABLE FROM MPEG LA, L.L.C., 250 
STEELE STREET, SUITE 300, DENVER, 
COLORADO 80206.

“PACKAGED MEDIA” means any storage 
media storing MPEG-2 video information such as 
DVD movie which are sold/distributed to general 
consumers. Disc replicators or sellers of the 
PACKAGED MEDIA need to obtain licenses for 
their own business from MPEG LA. Please 
contact MPEG LA for any further information. 
MPEG LA. L.L.C., 250 STEELE STREET, 
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

This product uses RICOH Bitmap Fonts 
produced and sold by Ricoh Company, Ltd. 

MPEG-4 Visual Patent 
Portfolio License

MPEG-2 Video Patent 
Portfolio License

About Bitmap Fonts
MPEG-4 Visual Patent Portfolio License / MPEG-2 Video Patent Portfolio License / About Bitmap Fonts 193Download from Www.Somanuals.com. All Manuals Search And Download.
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Because it uses the OpenSSL Toolkit, this product uses software developed by the OpenSSL Project 
(http://www.openssl.org/).

OpenSSL License
  ---------------

/* ====================================================================
 * Copyright (c) 1998-2008 The OpenSSL Project.  All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer. 
 *
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 *
 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

About OpenSSL
About OpenSSL
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 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
 * OF THE POSSIBILITY OF SUCH DAMAGE.
 * ====================================================================
 *
 * This product includes cryptographic software written by Eric Young
 * (eay@cryptsoft.com).  This product includes software written by Tim
 * Hudson (tjh@cryptsoft.com).
 *
 */

 Original SSLeay License
 -----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
 * All rights reserved.
 *
 * This package is an SSL implementation written
 * by Eric Young (eay@cryptsoft.com).
 * The implementation was written so as to conform with Netscapes SSL.
 * 
 * This library is free for commercial and non-commercial use as long as
 * the following conditions are aheared to.  The following conditions
 * apply to all code found in this distribution, be it the RC4, RSA,
 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation
 * included with this distribution is covered by the same copyright terms
 * except that the holder is Tim Hudson (tjh@cryptsoft.com).
 * 
 * Copyright remains Eric Young's, and as such any Copyright notices in
 * the code are not to be removed.
 * If this package is used in a product, Eric Young should be given attribution
 * as the author of the parts of the library used.
 * This can be in the form of a textual message at program startup or
 * in documentation (online or textual) provided with the package.
 * 
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in the
 *    documentation and/or other materials provided with the distribution.
 * 3. All advertising materials mentioning features or use of this software
 *    must display the following acknowledgement:
 *    "This product includes cryptographic software written by
 *     Eric Young (eay@cryptsoft.com)"
 *    The word 'cryptographic' can be left out if the rouines from the library
About OpenSSL 195Download from Www.Somanuals.com. All Manuals Search And Download.
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 *    being used are not cryptographic related :-).
 * 4. If you include any Windows specific code (or a derivative thereof) from 
 *    the apps directory (application code) you must include an acknowledgement:
 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
 * 
 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
 * 
 * The licence and distribution terms for any publically available version or
 * derivative of this code cannot be changed.  i.e. this code cannot simply be
 * copied and put under another distribution licence
 * [including the GNU Public Licence.]
 */
About OpenSSL
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Symbols

! (warning) indicator    30

A

AC power    36
ACCESS lamps    21, 24
Accessories (optional)    191
Accessory fitting shoe    16
Adaptor connector    15
ALARM knob    18
Area setting    40
Arrow buttons (K, k, J, j)    22
ASSIGN. 0 switch    19
ASSIGN. 1/2/3 switches    18
ASSIGNABLE 4/5 switches    24
Assignable switches, assigning functions    155
ATW (Auto Tracing White Balance)    19
Audio control section    22
AUDIO IN CH-1/CH-2 connectors    26
AUDIO IN CH1/CH2/CH3/CH4 

switches    23
AUDIO IN selectors    26
Audio input system    43
Audio level

adjusting    60
adjusting playback level    18
meters    34

AUDIO OUT connector    26
AUDIO SELECT CH1/CH2 switches    23
AUTO W/B BAL switch    17

B

BACKLIGHT button    22
BATT indicator    30
Battery

attachment shoe    15
of the internal clock, exchanging    186
pack    35
remaining    32

BKW-401    38

Black balance, adjusting    54
BRIGHT control    28, 29
Brightness level    33

C

Camera adaptor    15
Camera operator tally indicator    28
Clip Continuous Rec    83
Clip(s)

batch copy    103
copying    102
cue up    94
defining names    88
deleting    77, 103
displaying properties    100
dividing    106
operating with a computer    169
operations    91
playing    76, 94
protecting    102
proxy data    85
selecting    94

Clock setting    41
COLOR TEMP. button    18
Color temperature    32
Connection    167

monitors    167
using i.LINK    171

CONTRAST control    28, 29
Cover    20

D

Date, setting    41
DC IN connector    15
DC OUT 12V connector    15
DCC (Dynamic Contrast Control)    19
Depth of field indication    32
Digital extender    31
Diopter adjustment ring    28, 29
DISP SEL/EXPAND button    21
DISPLAY switches    22, 29
DISPLAY/ASPECT switch    28

E

EARPHONE jack    26
EJECT buttons    24
Electric color temperature filter    33

Index
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Index
ESSENCE MARK button    23
Essence mark thumbnail screen    105
Expand thumbnail screen

displaying    104
to increase the number of divisions    105

Extender    31
External device connector    24
External devices    167

control    33
External input    33
External power source    32
Eyecup    28, 29

F

F FWD button/indicator    21
F REV button/indicator    21
Filter position    33
FILTER selector    17
Fitting for optional microphone holder    16
Flange focal length, adjusting    42
Focus

adjustment mode    33
position    31

Formatting    70, 73
Frame Rec    81
Framing    76, 84
Framing shots    84
Freeze Mix    84
F-RUN/SET/R-RUN switch    23

G

GAIN selector    19
Gain value    34
GENLOCK IN connector    25
Green tally    31
Green tally indicator    30

H

HD/SD SDI OUT connector    26
Histogram    34
HOLD button    22

I

i.LINK    192
cable    192
connection    171

i.LINK (HDV/DV) connector    26
Index picture    93

changing    106
Indicators and status display    28
Initial value    110
Input source    33
Internal clock    41
Interval Rec    79
Iris

position    34

L

LCD monitor    20, 26
LCD panel    20
Lens

cable clamp    16
locking lever    17
mount    17
mount cap    17
mount securing rubber    16
mounting    42

LENS connector    16
Lens file(s)

loading    164
loading automatically    165
saving    164
setting data    164

LEVEL CH1/CH2/CH3/CH4 knobs    23
LIGHT connector    16
LIGHT switch    15
Line input audio equipment, connecting    47
Live & Play    76

M

Maintenance    174
Media

remaining capacity    27, 34
status    31

MENU button    22
MENU CANCEL/PRST/ESCAPE switch    19
MENU knob    17
MENU ON/OFF switch    19
MIC IN (+48 V) connector    16
MIC LEVEL control    18
Microphone holder    29, 30

fitting    16
Microphone, connecting    43
MIRROR switch    29
Index
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MONITOR knob    18
MONITOR switches    18
Monitor, connecting    167
MPEG TS adapter    15

N

ND filter    17
NEXT button    21
Nonlinear editing    170, 172
Number of system lines    32

O

OK/NG/KP mark(s)    92, 101
adding    101
deleting    101
setting    78

Operation status    31
of i.LINK device    33

Optional components    191
OUTPUT/DCC switch    19

P

PC connector    24
PEAKING control    28, 29
Picture Cache    78
Planning metadata    87
PLAY/PAUSE button/indicator    21
Plug    28, 29
Power source voltage/battery remaining 

capacity    32
Power supply    35
POWER switch    15
Preset values, resetting    162
PRESET/REGEN/CLOCK switch    23
PREV button    21
Proxy data    85

R

REC START button    17
Recording    85

external input signals    172
from pre-stored video    78
indicators    30
on an external device    171
proxy data    85
remaining time    71

review    75
shot marks    77
time-lapse video    79

Recording mode    53
special settings indication    31, 32

Red tally indicators    30
REMOTE connector    26
Reset    110, 162
RESET/RETURN button    22

S

Scene file(s)
loading    163
saving    162

SDI IN connector    25
Search

with the essence mark thumbnail screen    
95

with the expand thumbnail screen    95
SET button    22
Setup menu    107

basic operations    109
FILE menu    150
MAINTENANCE menu    135
menu list    111
OPERATION menu    112
PAINT menu    129
USER menu    111

SHIFT button    23
Shooting    68

basic operations    74
stop motion animations    81
with Slow & Quick motion    82

Shot data    65
Shot ID    65
Shot mark(s)

adding    106
adding during playback    95
defining names    90
deleting    106
recording    77

Shoulder pad    16
adjusting the position    50

Shoulder strap fitting    16
Shoulder strap, using    49
Shutter

setting    57
speed    57

SHUTTER selector    17
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Slot cover    24
SLOT SELECT button    25
Speaker    20
Specifications    186
Status information    66
Status screens    66

ASSIGN SWITCH    66
AUDIO    66
BATTERY/MEDIA    67
CAMERA    66
VIDEO    66

STOP button    21
Stopper    28, 29
SxS memory card slots    24
SxS memory cards    68

ejecting    70
formatting    70
loading    69
restoring    72
selecting    70

System configuration    173

T

Tally indicator    28, 29
TALLY indicators    26
TALLY switch    26, 28, 29
TC IN connector    25
TC OUT connector    25
Testing    174
THUMBNAIL button    22
THUMBNAIL indicator    22
THUMBNAIL menu    96

operations    98
Thumbnail screen    91

displaying OK clip thumbnails only    98
displaying the all clips thumbnail    99

Thumbnail(s)
changing the screen type    98
operations    96

Time, setting    41
Timecode    33

setting    62
synchronizing    63

TLCS automatic adjustment    59
TLCS control mode    33
Tripod mount    16
Tripod, mounting    48

U

UHF portable tuner, attaching    45
USB flash drive    73

formatting    73
User bits setting    63
User file(s)    160, 165
User setting data

loading    161
saving    160

V

Video format    101
setting    51

Video level indication    33
Video light, connecting    49
VIDEO OUT connector    25
Viewfinder    29

adjusting focus    39
adjusting position    37
adjusting screen    39
attaching    37
cable    30
cleaning    174
connectors    16
detaching eyepiece    39
fitting shoe    16
HDVF-20A (optional)    28
positioning knob    16
positioning lever    16
positioning ring    16
screen    30
screen display    30
status display    30

Viewfinder cable    29
Voltage capacity    32
VTR SAVE indicator    30

W

WARNING indicator    21
Warnings    176
WHITE BAL switch    19
White balance memory    33
White balance, adjusting    55
Wi-Fi adapter    24
Wireless microphone reception level    32
Write protect    69
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ZEBRA switch    28, 29
Zoom

position    31
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